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The Web Site 
Listed versions: Not Applicable 

Demos and Documentation 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L13 Why can't I get the Online Demos to work? 

The overwhelming response to our Online Demos is the cause of most of the problems 
occurred whilst trying to view our Online Demos. Do try again at another time. You could also 
try using a different browser. Macromedia Shockwave Player version 8 or higher must be 
downloaded and installed for the demos to work. 
If you think your problem is associated with Macromedia Shockwave then visit the 
Shockwave Player Support Center [http://www.macromedia.com/support/shockwave/ ] to 
view their technical help. 
The demos are quite large; they may not work on computers with only 32MB RAM or less. 
The demos are also quite processor intensive and will appear slow on any machine running 
at less than 300MHz. 

L28 Whenever I try to run one of the Online Demos I get the message "Your 
screen size is set to 800 x 600. To view the demos properly you should 
have a screen resolution of at least 1024 x 768" 

If you have your screen resolution of 800 x 600 pixels or less then the Online Demos will not 
have the space to be viewed and thus will not open up onto your display. Use the following 
steps to increase your screen resolution; you will also need to ensure that your color palette 
is set to High Color (16-bit) or greater: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 1024 x 768 or greater. 
6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
7. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 



Downloading Files 

A35 Error "This setup does not contain the Windows Installer engine 
(instmsia.exe) to run this installation". 

In order to reduce the size of the download, we do not include the Windows Installer engine 
in the updates. This is normally placed on the system when the original VIP program is 
installed. In some circumstances, the enigine is not installed. Download 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#win
dows] and run the Install Shield engine and then re-install. 

L05 Is there a way to copy large files downloaded from the site onto floppy 
disks? 

Most Zip programs (such as PkZip and WinZip [http://www.winzip.com/]) will zip a large file to 
several disks. So if you wish to store a large downloaded file onto floppy, then open this file 
into one of these programs. Get several blank floppy disks ready. Choose to create a ZIP file 
onto your A: drive and insert the first disk. The program will automatically split up your large 
file onto these individual disks. Now you can store them as a backup, or unzip this file onto 
another computer. 

L16 I have downloaded a ZIP file. What do I do with it? 

ZIP files contain files that have been compressed in size for faster download. ZIP files 
require a program such as WinZip [http://www.winzip.com/] to extract the file(s) onto your 
computer. If you have WinZip installed then take the following steps: (otherwise consult the 
guide for your unzipping program) 
1. Download and save the ZIP file into a temporary location on your hard drive. 
2. Either open WinZip, click "Open" and find the file you downloaded; or double-click on the 

file in Windows® Explorer. 
3. The contents of the file are displayed. Click "Extract". 
4. Select the folder you wish the files to unzip to in the "Extract to" box, such as 

"C:\VipEmbroidery\MyDesigns". 
5. Click "Extract" and the files will be placed in your folder. 
6. Close WinZip. 

Miscellaneous 

L15 When I try to print a page on your web site I get the error message "There 
are no pages to print" 

There is a bug in Netscape Navigator versions 4.5 and previous which prevents some pages 
with complex programming from printing. 

Dongle and Hardware 
Listed versions: Miscellaneous; VIP USB Dongle; VIP Parallel Dongle; System 5 and Previous Dongle; d-
Card Reader/Writer Unit; Reader/Writer Unit 



Dongle 

A36 Error “No dongle attached. Cannot open program" after my computer goes 
into “hibernate” mode 

At present, this is only a known issue with the Dell 8100. 
This happens because the power to the USB dongle is dropped when the computer 
hibernates, causing the dongle to stop functioning correctly until the computer fully reboots. 
On computers which have a parallel port, this can be solved as follows: 
1. Restart the computer. 
2. When the computer restarts, enter the BIOS. 
3. Find the settings for the parallel port (LPT1) and change it to Bi Directional. 
4. Save the BIOS settings and exit. 
This should prevent the loss of power to the dongle during hibernation, even though the 
dongle is on a USB port rather than the parallel port. 

A37 My computer crashed on startup with a “blue screen” when the dongle is 
attached 

This is caused by a conflict between the dongle driver supplied with your VIP software and 
any game port drivers you may have on your computer. This can be resolved by obtaining 
the latest dongle driver Dongle Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle] AND the latest game port driver. You will need to consult the game port manufacturer’s 
web site for the latest game port driver. For instance, if the game port is integrated in the 
motherboard, go to the web site relating to the motherboard and check for driver updates. 
Alternatively, you can temporarily disable the game port to allow the dongle to function 
correctly. 

F66 After attempting to start VIP Digitizing with no dongle attached I have lost 
some of my Preferences 

If you attempt to start VIP Digitizing with no dongle attached then you will get the error “No 
dongle attached. Cannot open program". When this happens, the VIPDigitizing.ini file in your 
windows folder (usually C:\Windows) is re-created with settings that are not the same as the 
installation defaults. Download VIPDigitizing.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_vipdig.ht
m] from the Husqvarna Viking Software web site and save it in the Windows folder. 

Drivers 

S19 Why does my USB Reader/Writer or dCard Reader/Writer require the 
drivers reinstalling every time I restart my computer? 

This is only known to occur on some computers that use the SIS7001 USB Host Controller. 
This does not occur with all computers using the SIS7001 USB Host Controller. This can 
affect other USB devices in a computer where this is happening. 
This happens because the drivers for the device are ‘lost’ when the computer is restarted. 
The affected USB devices will start working again if you reinstall the drivers in the Device 
Manager, accessed via the System icon in the Control Panel. This step would be necessary 
each time the drivers are 'lost', so it is possible that this would be required each time the 
computer is restarted. 



Alternatively, obtain and install a PCI USB add-in card that does not use the SIS7001 USB 
Host Controller chip set. 

Error Messages 

D01 Error message "Reader/Writer not found" 

For all Reader/Writers, check the following: 
• The Reader/Writer Unit is connected correctly to the computer. Ensure the connection is 

not loose. 
• You are using the power supply that was provided with your Reader/Writer Unit. 
• The power supply is switched on and connected to the Reader/Writer Unit. 
If you have a parallel Reader/Writer, also check the following: 
• The switch on the Reader/Writer Unit is set to 'Card', not 'Dongle' or 'Printer'. 
• If you are using an external Zip Drive, see FAQ #A13 for special instructions. 
• If you have a dongle in your LPT and your Reader/Writer Unit plugged into that, then 

remove it and place into the Dongle port of the Reader/Writer Unit. 
• If you have other items plugged into your LPT port then remove them and try again. If 

this works then your other hardware can be at fault, or it may be your cable is passing a 
weak signal. 

• Try running your computer in Safe Mode. If this works then it is likely to be another 
device's driver is accessing your printer port and preventing the Reader/Writer from 
working. See FAQ #A10 for more information. 

Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 

D02 Error message "No card inserted"? 

You have no card inserted in the Reader/Writer, or it is not inserted correctly. 

D03 Error message "Cannot write to card" 

This message appears if a read-only design card (from the Embroidery Library) is inserted in 
the Reader/ Writer; replace with a programmable card. It may also appear if the 
programmable card is defective or if a card is pulled out of the Reader/Writer during the 
writing process. 

D04 Error message "Cannot erase the card" 

The card is not erasable. Can appear if a card is pulled out of the Reader/Writer during the 
erasing process. 

D05 Error message "No LPT port available" 

The software may be corrupt; try uninstalling and reinstalling your Husqvarna Embroidery 
Customizing System. This message may also appear if another device driver is accessing 
the printer port. See FAQ #A10 on general difficulties with hardware and software for more 
information. 



Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 
This error message is only applicable to the parallel Reader/Writer. 

F66 After attempting to start VIP Digitizing with no dongle attached I have lost 
some of my Preferences 

If you attempt to start VIP Digitizing with no dongle attached then you will get the error “No 
dongle attached. Cannot open program". When this happens, the VIPDigitizing.ini file in your 
windows folder (usually C:\Windows) is re-created with settings that are not the same as the 
installation defaults. Download VIPDigitizing.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_vipdig.ht
m] from the Husqvarna Viking Software web site and save it in the Windows folder. 

General 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A11 How do I set up my parallel Reader/Writer Unit and parallel Dongle? 

To set up a parallel Reader/Writer Unit and a parallel Dongle, do the following: 
1. Place one end of the cable into the connection marked 'COMPUTER' of the 

Reader/Writer. 
2. Plug the opposite end of the cable into the printer port of the computer, marked 'LPT1', 

'LPT2' or 'Printer'. 
3. Plug the AC Power Supply into the socket on the side of the Reader/Writer and into the 

power source. Note: only use the power supply that comes with your Reader/Writer kit. 
4. Plug the Dongle (with the Code Key securely in place if it is not a VIP System dongle) 

into the connection marked 'DONGLE' on the Reader/Writer. 
5. To read or write an embroidery card, flip the silver switch on the front of the 

Reader/Writer to the right (towards the card slot). For all other functions, flip the silver 
switch to the left. 

A13 Are there special instructions for installing my external Zip drive? 



This only applies if you have a parallel Reader/Writer and want to use an external Zip drive 
that connects to a parallel printer port (LPT). 
A parallel Zip drive should always be connected directly to the computer's printer port and 
the switch box connected to the zip drive's out connector. The Zip drive's cable must be kept 
as short as possible or you will get data corruption. Also the length of the cable from the Zip 
drive to the switch box and from the switch box to the Reader/Writer must be as short as 
possible. Ideally the total length of the cable from the back of the computer to the 
Reader/Writer should not exceed 2 meters. 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A15 I now have two dongles and two code keys, how do I set these up? 

Remove the code key from your oldest dongle and place it in the opposite side of your new 
dongle. If the black spacer is in the space then remove it with a screwdriver or coin. Use this 
new dongle as you had used your old one. 

A16 I am not using a Reader/Writer, where do I place my Dongle? 

Place the Dongle directly into the printer port of the computer, marked 'LPT1', 'LPT2' or 
'Printer'. You can plug the printer directly into this. 

A21 How do I know which code key is required for which program? 



Code keys are distinguished by the number, or maker, on it. This will either be a red dot or a 
number from 0 to 3. Determine the software that requires this code key using the following 
table: 
Code key No. 0 or red dot 
• Husqvarna Viking Digitizing (95 and System 5) 
Code key No. 1 
• Husqvarna Viking Professional Embroidery (v.2.1 and System 5) 
Code key No. 2 
• Husqvarna Viking Digitizing Pro (v.2.1) 
Code key No. 3 
• Husqvarna Viking Customizing System 5 
If the marker is missing then use the Diagnostics program to determine the code key type: 
1. Insert your System 5 Installation CD. 
2. Immediately hold down the shift key to prevent the automatic install window appearing. If 

it appear, press Cancel. 
3. Use Explorer to find the Technical folder on the root of the CD. 
4. Open the Dongle folder. 
5. Double click on the Dongle_Diag.exe program to run it. 
6. Click on the Test button and your code key version will be displayed. 
7. For more information click the Help button. 

A24 General USB Problems 

Some USB ports do not have enough power to drive the dongle. By using a USB hub, which 
uses a power supply, this can be overcome. 
Some later Windows 95 computers have USB ports fitted to the Motherboard but are not 
available for use. You will need to upgrade to a later version of Windows. 

A25 The dongle is not recognised on the Dell Dimension 1.4ghz computer 
The default printer setting for this computer (ECP 378h DMA channel OFF) is not compatible 
with the dongle. This setting has to be changed in the BIOS. Upon booting up the computer 
enter the BIOS by pressing F2 on your keyboard, locate the settings and change it to either: 
• Mode AT I/O 378h 
• PS/2 I/O 378h 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

A29 What could cause the "No d-Card Reader/Writer unit is connected" error 
message? 

Check that the d-Card Reader/Writer is securely plugged into the USB port of the computer 
or hub. Check the cable is plugged in as shown in the Getting Started User’s Guide. 



If you still have a problem then plug the d-Card Reader/Writer directly into into your 
computer's USB port. If it is now OK, then the problem may be a damaged or poor quality 
device or cable 
If you have a problem installing a USB d-Card Reader/Writer ensure that your BIOS is 
configured to allow support of Legacy USB devices. 

A30 What could cause the "No dongle attached" error message? 

 
• Make sure that the dongle is connected to the computer, disconnect any devices such as 

printers that may be attached. 
• Check that the dongle is plugged into the parallel port marked LPT1, LPT2 or PRINTER 

of the computer, or the output port marked DONGLE or PRINTER on the Reader/Writer. 
• If you are using a switch box check that the switch is in the correct position. 
• Ensure the dip switches on the Reader/Writer are in the correct position. 
• If you are using a zip drive check the set-up is as described in FAQ #A13. 
If you still have a problem then place the dongle directly on the Printer port. If you suspect a 
damaged or poor quality printer cable lead - replace it with a Husqvarna Viking approved 
cable. 

A33 An error message "The software you are installing for this hardware: 
Universal Serial Bus controllers, has not passed Windows Logo testing" 
appears when installing the software. 

Because this software was released before Windows XP, it was not possible to have the 
driver passed by Microsoft for the Windows XP operating system. The driver, however, is 
compatible; select "Continue Anyway". 

A34 The Dongle is not recognized under Windows XP 

If you are running Windows XP with Customizing version 6.1, you will need to download the 
latest version of the Dongle Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 
Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 



Reading from a Card 

D16 My Reader/Writer is not working and I have Nero CD creation software 

Certain versions of the Ahead Nero CD creation software conflict with the Reader/Writer and 
prevent it from working. This can be resolved with a free upgrade to the latest version of 
Nero, which you can obtain from the Ahead Software Download 
[http://www.ahead.de/en/download.htm] page. 

Setting up the Reader/Writer Unit 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A11 How do I set up my parallel Reader/Writer Unit and parallel Dongle? 

To set up a parallel Reader/Writer Unit and a parallel Dongle, do the following: 
1. Place one end of the cable into the connection marked 'COMPUTER' of the 

Reader/Writer. 
2. Plug the opposite end of the cable into the printer port of the computer, marked 'LPT1', 

'LPT2' or 'Printer'. 
3. Plug the AC Power Supply into the socket on the side of the Reader/Writer and into the 

power source. Note: only use the power supply that comes with your Reader/Writer kit. 
4. Plug the Dongle (with the Code Key securely in place if it is not a VIP System dongle) 

into the connection marked 'DONGLE' on the Reader/Writer. 
5. To read or write an embroidery card, flip the silver switch on the front of the 

Reader/Writer to the right (towards the card slot). For all other functions, flip the silver 
switch to the left. 

A12 How do I connect my printer to the parallel Reader/Writer? 

Do not plug a printer into the parallel Reader/Writer, even if is says 'Printer' on it. It does not 
act as a switch-box and printer signals, which aren't blocked, may travel through and 
compromise your embroidery cards. Instead you must use one of the following options: 
• Disconnect the Reader/Writer cable when printing. 
• Connect a switch-box to the computer, and attach both the printer and Reader/Writer to 

this. Ensure that this switch-box is manual, for parallel connections, is bi-directional and 
has a cable no more than 6 feet long. 



• Install an extra Parallel (LPT) Port into your computer, and use the Reader/Writer on this. 
We highly recommend installation of a second printer port if the following printer drivers are 
installed on your system: Hewlett Packard 660 or above and the Lexmark WinWriter series. 

A13 Are there special instructions for installing my external Zip drive? 

This only applies if you have a parallel Reader/Writer and want to use an external Zip drive 
that connects to a parallel printer port (LPT). 
A parallel Zip drive should always be connected directly to the computer's printer port and 
the switch box connected to the zip drive's out connector. The Zip drive's cable must be kept 
as short as possible or you will get data corruption. Also the length of the cable from the Zip 
drive to the switch box and from the switch box to the Reader/Writer must be as short as 
possible. Ideally the total length of the cable from the back of the computer to the 
Reader/Writer should not exceed 2 meters. 

D16 My Reader/Writer is not working and I have Nero CD creation software 

Certain versions of the Ahead Nero CD creation software conflict with the Reader/Writer and 
prevent it from working. This can be resolved with a free upgrade to the latest version of 
Nero, which you can obtain from the Ahead Software Download 
[http://www.ahead.de/en/download.htm] page. 

Writing to a Card 

D16 My Reader/Writer is not working and I have Nero CD creation software 

Certain versions of the Ahead Nero CD creation software conflict with the Reader/Writer and 
prevent it from working. This can be resolved with a free upgrade to the latest version of 
Nero, which you can obtain from the Ahead Software Download 
[http://www.ahead.de/en/download.htm] page. 

Customizing 
Listed versions: Windows 95, version 1.2; Windows 95, version 1.3; Pro, system 2.1; System 5, version 5.0; 
System 5, version 5.1; VIP, version 6.0; VIP, version 6.1; Pro System 5, version 5.0; VIP, version 6.2 

ColorSorting 

B23 ColorSort does not work for the two-color monogram that I created 

When creating Two-color lettering, ensure that the Jump Stitch Connection is selected. If 
Running Stitch Connection is selected, you will not be able to ColorSort the lettering. 

B30 When I ColorSort a Customized embroidery the number of color blocks 
produced varies 

The ColorSort process does not just put the same color blocks together. It checks for overlap 
between areas, therefore depending on the overlaps created during Customizing the final 
number of color blocks may vary, even if you are Combining a similar number of Shapes or 
monograms. 



Combining and Saving Designs 

B04 What causes the message "Design is too large, or will not fit in hoop"? 

If a design has been Scaled too large or is positioned partly outside the Stitch Area, this 
message will appear when you try to combine or save it. Reduce the scaling or move the 
design so that all designs are within the hoop boundaries. 

B26 My lettering turns black when merged with a design 

There is a limit of 99 color changes in any Customized file (60 color blocks can be displayed 
in the Color Worksheet). If the number of color changes goes over 99 when you Combine 
designs, shapes or monograms, the remainder of the colors will appear black. 
This may occur in a two-color monogram, as each letter contains two color changes. When 
creating monograms using a two-color font, do not exceed 49 letters. 
If you find your design is using too many colors we recommend using the colorsort function 
to reduce them automatically. 

B38 How to use 2 Color Fonts with Multi-part Hoops 

When using a 2 Color Font in the Multi-part Plus Hoop or the Multi-part Mega Hoop, some of 
the characters in the P2/P3 or M2/M3 positions change to black when the design is 
combined. 
This can be resolved as follows: 
1. Open VIP Customizing. 
2. Change the Hoop settings so that you are using the Multi-part hoop of your choice. 
3. Click the Letters tab on the Control Panel. 
4. Choose the desired 2 Color Font and size settings. 
5. Enter the lettering into the Letter textbox and click Apply. 
6. Position the lettering as required. 
7. Combine the design. Some of the colors will be lost in position P2/M2 and P3/M3 

depending on your design. (One letter will be black and the colors in the letters following 
it will be incorrect). 

8. Delete the lettering with the incorrect colors in P2/M3 and P3/M3. 
9. Retype the lettering you have deleted. 
10. Make sure Multiple is checked and click Apply. 
11. Position the two sections of lettering as they were in the original. 
12. Combine the design. The lettering should now be correct, if not repeat steps 8 to 11 until 

all the lettering is correct. 
13. Save the design. The sections of lettering will be saved in the hoop positions where you 

placed them. 

B48 Why do I get the message "Combining designs. Continue?" 

This message appears when you select Combine asking if you wish to continue. You cannot 
use the Undo Command to reverse the Combine action, so after Combining you will not be 
able to move the designs you have Customized individually. If you are sure you are ready to 
Combine, select Yes. 

B49 Error: "Design is too large or will not fit in hoop" 



This message appears if a Stitch File you are trying to Combine or Save is outside the 
selected hoop or larger than will fit in it. For example, with the 100mm x 100mm hoop 
selected, a design smaller than 100mm x 100mm might be placed partially outside the Stitch 
Area when you click Combine. This message would then appear. Move the design 
completely within the four blue corners of the Stitch Area and try again. 

B50 Error: "Design too large for export format" 

Certain formats are limited to the number of stitches they can save or the size of hoop used 
on their specific embroidery machine, for example .sew. If you attempt to save a file in this 
format that is bigger than the largest available hoop size or has more stitches than are 
allowed, this message would appear. 

B51 Error: "No stitch data to save" 

This message appears if you try to use the Save function when there are no Stitch Files 
loaded on the VIP Customizing screen. 

B52 Error: "No designs available to print. Only designs that have been 
Combined and are inside the hoop can be printed" 

This message appears if the Stitch File(s) on screen have not been Combined. To print more 
than one design, they must be Combined and fit in the selected hoop. If Stitch File(s) have 
not been Combined, and the design that was loaded first has not been moved from the 
center of the Stitch Area, it will be printed. 

B55 I've made a Mega Hoop (or Plus Hoop) design and the lettering did not split 
automatically when I selected Combine 

The automatic splitting up of lettering does not work after it has been converted to a 'design'. 
This occurs if it is Rotated, or Pasted from another program, as well as if it has been 
previously Combined or Saved. 

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

Connecting to Machines 

B34 VIP Customizing is not communicating with my Toyota AD800 series 
embroidery machine and I have Windows ME or Windows XP 

You need to download and install the Toyota AD800 series driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_toyota.ht
m]. 



Creating and Editing Designs 

B04 What causes the message "Design is too large, or will not fit in hoop"? 

If a design has been Scaled too large or is positioned partly outside the Stitch Area, this 
message will appear when you try to combine or save it. Reduce the scaling or move the 
design so that all designs are within the hoop boundaries. 

B05 How do I change the selection of designs if I've selected the wrong design 
to move or manipulate? 

You can switch to another item on your display by clicking on the design you wish to select. 
If, however, the design you require is covered by another then hold down the Shift key while 
clicking on the required design. 

B12 I do not have the controls to change colors or add lettering 

The Control Panel holds all the controls for editing colors, lettering and shapes. By default it 
is on the right-hand side, but this can be moved or hidden from view. If you cannot see it 
then go to the 'View' menu and select 'Control Panel'. If this has not returned your controls 
then you will have to restore your program settings: 
1. Close Customizing. 
2. Open Windows® Explorer and open the 'Windows' folder on your C: drive. 
3. Find the file 'customiz.ini', or 'custompro.ini' for users of the Professional System 5. 
4. Delete this file by right-clicking on it and selecting 'Delete'. 
5. Now find the file of the same name in the root directory of your program CD. (If your VIP 

software was installed from a multi-language CD, you will find the .ini file in the relevant 
language folder. For instance, if you installed the English version of the software, you will 
find the .ini file in the "English" folder.) 

6. Right-click on it and select 'Copy'. 
7. Right-click on the 'Windows' folder of your C: drive and select 'Paste'. 
8. Now you can run Customizing and the settings should be set to default 

B13 How can I combine the plus hoop designs for the Designer I? 

As a plus hoop design will not open in the correct positions when you have Large Hoop 
selected, you can take the following steps to position them correctly: 
1. If the design is on a card, use Reader/Writer Pro to read it and save the design parts as 

a series of files. 
2. Open Customizing System 5 (or Customizing Pro System 5). 
3. Go to the Size icon and select Large Hoop; on the same screen change the grid size to 

35mm. 
4. Open the three (or two) Plus Hoop design files in the order that they will be stitched out 

(e.g. P1 - stitch first, P3 - stitch second, P2 - stitch third). 
5. Place the P2 design so that the first stitch, marked by the small cross, is on the center of 

the gridlines in the center of the hoop. You may wish to zoom in to help positioning. 
6. Place the P1 design so that the first stitch is on the first gridline above the center line. 
7. Place the P3 design so that the first stitch is on the first gridline below the center line. 
8. Click combine to merge them into one design file for the Designer I, and save as a new 

filename. There will be many color changes. 

B15 When I open a file into Customizing I am unable to move or resize it 



Some files are corrupt in such a way that the height and width are negative values (see on 
the control panel). This can be easily cured by clearing the display (using New), reopening 
the faulty file, and using Save As to resave it. 

B27 Certain functions don't seem to work all the time 

When creating Lettering, when you click on the circular rotation handle, the letters are 
automatically turned into a design. The lettering can then no longer be resized with 
proportional changes in stitch density. 

B53 I tried to open some previously made Plus Hoop designs, but they are not 
in their correct positions 

Check the Plus Hoop setting has been chosen. Click Preferences and alter the Hoop Size 
setting to 170mm x 100mm (Plus Hoop). To load designs in specific positions for the Plus 
Hoop, click File, Open Plus/Mega Designs Command, P1 and so on. 

B54 I tried to open some previously made Mega Hoop designs, but they are not 
in their correct positions 

Check the Mega Hoop multi-part setting has been chosen. Click Preferences and alter the 
Hoop Size setting to 360mm x 150mm (Mega Multi-Part). To load designs in specific 
positions for the Mega Hoop, click File, Open Plus/Mega Designs Command, P1 and so on. 

B58 How can I combine the Plus Hoop designs for the Designer I, Designer II or 
Platinum Plus? 

As a Plus Hoop design will not open in the correct positions when you have a Medium, Large 
or Mega Hoop selected, you can take the following steps to position them correctly: 
1. If the design is on a card, use VIP Reader/Writer to read it and save the design parts as 

a series of files. 
2. Open VIP Customizing (Customizing Plus). 
3. Click the Preferences icon and select the desired Hoop Size. It should be the Medium 

Hoop (100mm x 170mm) or larger. Make sure the Orientation is set to Vertical. 
4. Click the Screen tab and change the grid size to 35mm, then click OK. 
5. Open the three (or two) Plus Hoop design files in the order that they will be stitched out 

(e.g. P1 - stitch first, P3 - stitch second, P2 - stitch third). 
6. Place the P2 design so that the first stitch, marked by the small cross, is on the center of 

the gridlines in the center of the hoop. You may wish to zoom in to help positioning. 
7. Place the P1 design so that the first stitch is on the first gridline above the center line. 
8. Place the P3 design so that the first stitch is on the first gridline below the center line. 
9. Click Combine to merge them into one embroidery file for your embroidery machine, and 

save as a new filename. There will be many color changes. 

C02 How can I avoid the message "Design is too big to save"? 

If a design has been Scaled too large or is positioned partly outside the Stitch Area, this 
message will appear when you try to save it. Reduce the scaling or move the design, then 
saving will be possible. 

C03 What causes the message "Combined design is too big; redo"? 



If designs on the screen are not completely inside the Stitch Area, when you try to Combine 
them this message will appear. Move the designs so they all fit into the Stitch Area, then 
Combine again. 

C04 Can I add a file to the screen without getting the message "Design in 
display area will be deleted. Ok?"? 

When you select Open, if design(s) have previously been loaded this warning message 
appears. Click OK if you wish to replace the design(s) on the screen. To add the new design 
to the existing one(s), select Insert or View. 

C06 I am trying to load a file and the message "Too many designs, only 9 
designs allowed" appears 

This message appears if you try to Load, Insert or drag and drop files so that there are more 
than 9 in the Husqvarna Customizing Software Window. 

C10 How do I change the selection of designs if I've selected the wrong design 
to move or manipulate? 

To deselect a design, click the mouse anywhere outside the outline box. To select the 
desired design, click on it and an outline box will appear. 

C12 When I mirror some designs they change position on the screen 

Designs are mirrored around their start point. If the start point is not in the centre of the 
design, the design may change position on the screen when it is mirrored. This is often seen 
in lettering, where the start point is at the left of the letters. 

Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 



have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A15 I now have two dongles and two code keys, how do I set these up? 

Remove the code key from your oldest dongle and place it in the opposite side of your new 
dongle. If the black spacer is in the space then remove it with a screwdriver or coin. Use this 
new dongle as you had used your old one. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 



Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Error Messages 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 



A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 



For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B03 I get an error message when I open my HUS file from Windows Explorer 
When you double-click on a HUS file from explorer it should open that file into the 
Customizing Software. This relies on the computer knowing which programs are associated 
with which files. It seems that somehow this association may have been confused and would 
have to be restored. To restore this association, do the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Stitch Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 
6. Run Customizing by finding it in the Start menu (go to Start, Programs, Husqvarna Viking 

Embroidery System 5, Customizing). 
7. Close the Customizing program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your HUS files should now be associated correctly. 

B04 What causes the message "Design is too large, or will not fit in hoop"? 

If a design has been Scaled too large or is positioned partly outside the Stitch Area, this 
message will appear when you try to combine or save it. Reduce the scaling or move the 
design so that all designs are within the hoop boundaries. 

B08 When I open Customizing I get the error message 'file is linked to missing 
export OLEAUT32.DLL' 

Your system is using an old version of this file. Download 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ole] and run the installation program to fix this. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

B29 When installing VIP Customizing I get a message saying 'Fatal Error 
extracting ISScript.Msi from the binary table' 

This is caused when there is not enough room on the C drive to create the temporary folder 
used for the install. There needs to be approximately 10mb free. 



B40 Error: "Plus or Multi-part Hoop is not selected" 

This message appears if the Open Plus/Mega Designs is selected under the File menu, but 
the Plus Hoop or Mega Hoop multi-part settings have not been chosen in the Hoop Size 
Preferences. Click Size and alter the setting to a Plus Hoop or Mega Hoop multi-part setting, 
then try again. 

B41 Error: "You have created letters that are outside the recommended size for 
this font" 

Each font is designed for the size range specified in its name. If the Size setting for the 
selected font is outside the recommended range, this message will appear. You can create 
Lettering outside the recommended size, however it may not produce optimum results. Click 
OK to create the Lettering or Cancel, then select a more appropriate font. If you do wish to 
create Lettering larger than the recommended size it may be effective to use a Fill Pattern; 
however the Underlay in the font should also be appropriate. 

B42 Error: "Please enter an integer between 3 and 80" 

This message appears if the size entered in the Size Box on the Letters Page is below 3mm 
or above 80mm. The Size setting refers to the height in millimeters of a capital "A" in the 
selected Font. If you wish to increase lettering slightly above this you could click and drag 
one of the corner boxes or alter the Height or Width Proportions. 

B43 Error: "Cannot open Font" 

This message appears if the font file that you have selected from the Font Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that font file from the C:\VipEmbroidery\System folder. Close VIP 
Customizing, make sure the file is in the folder, then try again. Alternatively, you may need to 
Uninstall and Reinstall the program. 

B44 Error: "Cannot open Shapes" 

This message appears if the shapes file that you have selected from the Shapes Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that shapes file or the .bmp file of the same name from the 
C:\VipEmbroidery\System folder. Close VIP Customizing, make sure the file is in the folder, 
then try again. Alternatively, you may need to Uninstall and Reinstall the program. 

B45 Error: "Font file is corrupted; use backup" 

This message appears when trying to select a lettering style if the file has corrupted. 
Reinstall the file or Uninstall and Reinstall the program. 

B46 Error: "Old font. No longer supported" 

This message appears if you attempt to create lettering using a font file that was created in 
an earlier version of the Customizing program. To continue creating lettering, select an 
alternative font. When you close VIP Customizing, remove any old .fnt files from the 
C:\VipEmbroidery\System folder using Windows® Explorer. 



B47 Error: "No designs available for 3D view. Only designs that have been 
combined and are inside the hoop can be shown" 

If you attempt to combine designs unsuccessfully when the Plus Hoop or Mega Multi-Part 
settings are chosen, that is they are not all inside one of the Stitch Areas, when you select 
Quick 3DStitch™ View this message may appear. Move the designs until you can combine 
them, then try Quick 3DStitch View™ again. 

B48 Why do I get the message "Combining designs. Continue?" 

This message appears when you select Combine asking if you wish to continue. You cannot 
use the Undo Command to reverse the Combine action, so after Combining you will not be 
able to move the designs you have Customized individually. If you are sure you are ready to 
Combine, select Yes. 

B49 Error: "Design is too large or will not fit in hoop" 

This message appears if a Stitch File you are trying to Combine or Save is outside the 
selected hoop or larger than will fit in it. For example, with the 100mm x 100mm hoop 
selected, a design smaller than 100mm x 100mm might be placed partially outside the Stitch 
Area when you click Combine. This message would then appear. Move the design 
completely within the four blue corners of the Stitch Area and try again. 

B50 Error: "Design too large for export format" 

Certain formats are limited to the number of stitches they can save or the size of hoop used 
on their specific embroidery machine, for example .sew. If you attempt to save a file in this 
format that is bigger than the largest available hoop size or has more stitches than are 
allowed, this message would appear. 

B51 Error: "No stitch data to save" 

This message appears if you try to use the Save function when there are no Stitch Files 
loaded on the VIP Customizing screen. 

B52 Error: "No designs available to print. Only designs that have been 
Combined and are inside the hoop can be printed" 

This message appears if the Stitch File(s) on screen have not been Combined. To print more 
than one design, they must be Combined and fit in the selected hoop. If Stitch File(s) have 
not been Combined, and the design that was loaded first has not been moved from the 
center of the Stitch Area, it will be printed. 

C01 What causes the error message "No room to create letters; only one design 
allowed"? 

When trying to create Lettering or Shapes, this message appears if more than one design is 
loaded without them being combined. Press Combine to put the loaded designs together, 
then reselect Lettering/Shapes and the dialog box will appear. 

C02 How can I avoid the message "Design is too big to save"? 



If a design has been Scaled too large or is positioned partly outside the Stitch Area, this 
message will appear when you try to save it. Reduce the scaling or move the design, then 
saving will be possible. 

C03 What causes the message "Combined design is too big; redo"? 

If designs on the screen are not completely inside the Stitch Area, when you try to Combine 
them this message will appear. Move the designs so they all fit into the Stitch Area, then 
Combine again. 

C04 Can I add a file to the screen without getting the message "Design in 
display area will be deleted. Ok?"? 

When you select Open, if design(s) have previously been loaded this warning message 
appears. Click OK if you wish to replace the design(s) on the screen. To add the new design 
to the existing one(s), select Insert or View. 

C05 I am trying to load a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

C06 I am trying to load a file and the message "Too many designs, only 9 
designs allowed" appears 

This message appears if you try to Load, Insert or drag and drop files so that there are more 
than 9 in the Husqvarna Customizing Software Window. 

C07 What causes the error message "Font file is corrupt" when I try to select a 
lettering style? 

This is due to the font file being moved or copied without using the correct installation 
procedure. Reinstall the fonts from the floppy disk on which they were supplied. 

C19 I get the error message 'This application uses CTL3D32.DLL which is not 
the correct version' 

Another program has installed a file of the same name over the one provided by 
Customizing, which is not compatible. Reinstalling Customizing does not help, as the 
installation does not allow newer versions of this file to be replaced by older versions. 
Instead find the original file from your installation disk number 1, using Windows® Explorer, 
and copy it into your C:\Husq95 folder (or wherever you installed it into). 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 



This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 



check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

Fonts 

B38 How to use 2 Color Fonts with Multi-part Hoops 

When using a 2 Color Font in the Multi-part Plus Hoop or the Multi-part Mega Hoop, some of 
the characters in the P2/P3 or M2/M3 positions change to black when the design is 
combined. 
This can be resolved as follows: 
1. Open VIP Customizing. 
2. Change the Hoop settings so that you are using the Multi-part hoop of your choice. 
3. Click the Letters tab on the Control Panel. 
4. Choose the desired 2 Color Font and size settings. 
5. Enter the lettering into the Letter textbox and click Apply. 
6. Position the lettering as required. 
7. Combine the design. Some of the colors will be lost in position P2/M2 and P3/M3 

depending on your design. (One letter will be black and the colors in the letters following 
it will be incorrect). 

8. Delete the lettering with the incorrect colors in P2/M3 and P3/M3. 
9. Retype the lettering you have deleted. 
10. Make sure Multiple is checked and click Apply. 
11. Position the two sections of lettering as they were in the original. 
12. Combine the design. The lettering should now be correct, if not repeat steps 8 to 11 until 

all the lettering is correct. 
13. Save the design. The sections of lettering will be saved in the hoop positions where you 

placed them. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 



B12 I do not have the controls to change colors or add lettering 

The Control Panel holds all the controls for editing colors, lettering and shapes. By default it 
is on the right-hand side, but this can be moved or hidden from view. If you cannot see it 
then go to the 'View' menu and select 'Control Panel'. If this has not returned your controls 
then you will have to restore your program settings: 
1. Close Customizing. 
2. Open Windows® Explorer and open the 'Windows' folder on your C: drive. 
3. Find the file 'customiz.ini', or 'custompro.ini' for users of the Professional System 5. 
4. Delete this file by right-clicking on it and selecting 'Delete'. 
5. Now find the file of the same name in the root directory of your program CD. (If your VIP 

software was installed from a multi-language CD, you will find the .ini file in the relevant 
language folder. For instance, if you installed the English version of the software, you will 
find the .ini file in the "English" folder.) 

6. Right-click on it and select 'Copy'. 
7. Right-click on the 'Windows' folder of your C: drive and select 'Paste'. 
8. Now you can run Customizing and the settings should be set to default 

B21 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Customizing Program 

Certain icons (for example Combine, Save As and Print on the Main Toolbar and all Edit 
Toolbar icons apart from Preferences) are only highlighted once a stitch file is shown on the 
VIP Customizing screen. 

B27 Certain functions don't seem to work all the time 

When creating Lettering, when you click on the circular rotation handle, the letters are 
automatically turned into a design. The lettering can then no longer be resized with 
proportional changes in stitch density. 

B56 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons: 
1. Close the program. 
2. Copy the customiz.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted customiz.ini file and select the Properties option from the popup 

menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 



This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Installation and CD 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 
You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

A06 After installing the Customizing 95 System (up to version 1.32), my old 
programs don't work any more 

If you already have the Husqvarna Embroidery Digitizing System (up to version 4.21), DOS 
Conversion System and/or View & Print Program, you must click on the Configure Icon after 
installing the Husqvarna Embroidery Customizing System for Windows®95. This will 
configure your system correctly to run all Husqvarna programs. 

A07 When I try to install Customizing the installation stops on disk 3. 
There was a batch of Customizing programs that were distributed with faulty disks. Take all 
your disks back to your supplier and they will be able to replace them. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 



Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A15 I now have two dongles and two code keys, how do I set these up? 

Remove the code key from your oldest dongle and place it in the opposite side of your new 
dongle. If the black spacer is in the space then remove it with a screwdriver or coin. Use this 
new dongle as you had used your old one. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B08 When I open Customizing I get the error message 'file is linked to missing 
export OLEAUT32.DLL' 

Your system is using an old version of this file. Download 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ole] and run the installation program to fix this. 



B29 When installing VIP Customizing I get a message saying 'Fatal Error 
extracting ISScript.Msi from the binary table' 

This is caused when there is not enough room on the C drive to create the temporary folder 
used for the install. There needs to be approximately 10mb free. 

B36 I have installed VIP Customizing but I have no Application Bar 
The Application Bar is part of Professional Plus. It is only available when Professional Plus is 
installed. 

B57 I only have 17 fonts and 4 shapes styles. How do I add the extra fonts and 
shapes shown on this website to my VIP Customizing program? 

You need to download the upgrade 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm] files that will give you the most up-to-date versions of the 29 fonts and 7 shapes 
styles available for your VIP Customizing program. To see the characters available, a key for 
the Greek and Hebrew fonts and sample monograms, download the updated Font Guide 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm#guides] and Shape Guide 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm#guides] pdf files. If you received the Professional Plus system, you already have all 
available fonts and shapes. This update applies only to Customizing Plus version 6.0. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 



• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 
checked 

Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 
Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 



Lettering 

B09 All my lettering appears far too thin when stitched 

Make sure you are using the Stitch Advisor included with Customizing to its full potential. 
This is found on the Lettering tab of the Control Panel. By default this is set to Woven, which 
is designed for thin materials. If this is set higher the letters become bolder. Try creating 
some letters, and changing between each of these settings and you will see immediately the 
difference it makes. This is particularly useful for small lettering. It may also help to increase 
the number in the density setting (decreasing the number of stitches). 

B12 I do not have the controls to change colors or add lettering 

The Control Panel holds all the controls for editing colors, lettering and shapes. By default it 
is on the right-hand side, but this can be moved or hidden from view. If you cannot see it 
then go to the 'View' menu and select 'Control Panel'. If this has not returned your controls 
then you will have to restore your program settings: 
1. Close Customizing. 
2. Open Windows® Explorer and open the 'Windows' folder on your C: drive. 
3. Find the file 'customiz.ini', or 'custompro.ini' for users of the Professional System 5. 
4. Delete this file by right-clicking on it and selecting 'Delete'. 
5. Now find the file of the same name in the root directory of your program CD. (If your VIP 

software was installed from a multi-language CD, you will find the .ini file in the relevant 
language folder. For instance, if you installed the English version of the software, you will 
find the .ini file in the "English" folder.) 

6. Right-click on it and select 'Copy'. 
7. Right-click on the 'Windows' folder of your C: drive and select 'Paste'. 
8. Now you can run Customizing and the settings should be set to default 

B25 I've typed in some Lettering, but not all of it has appeared 

If you are using an upper case only Font (with UC at the end of its name, such as 
BASEBALL UC), only capital letters are available. Check the Font and try again. 

B26 My lettering turns black when merged with a design 

There is a limit of 99 color changes in any Customized file (60 color blocks can be displayed 
in the Color Worksheet). If the number of color changes goes over 99 when you Combine 
designs, shapes or monograms, the remainder of the colors will appear black. 
This may occur in a two-color monogram, as each letter contains two color changes. When 
creating monograms using a two-color font, do not exceed 49 letters. 
If you find your design is using too many colors we recommend using the colorsort function 
to reduce them automatically. 

B32 Customizing crashes when I try to use Fonts on the Letters tab. 
This is probably caused by a software conflict. A known conflict is with Piccolo, a universal 
reader for data cards from digital cameras. Piccolo starts up with an icon in the system tray. 
Removing or disabling Piccolo will allow you to use Fonts in Customizing. 

B38 How to use 2 Color Fonts with Multi-part Hoops 



When using a 2 Color Font in the Multi-part Plus Hoop or the Multi-part Mega Hoop, some of 
the characters in the P2/P3 or M2/M3 positions change to black when the design is 
combined. 
This can be resolved as follows: 
1. Open VIP Customizing. 
2. Change the Hoop settings so that you are using the Multi-part hoop of your choice. 
3. Click the Letters tab on the Control Panel. 
4. Choose the desired 2 Color Font and size settings. 
5. Enter the lettering into the Letter textbox and click Apply. 
6. Position the lettering as required. 
7. Combine the design. Some of the colors will be lost in position P2/M2 and P3/M3 

depending on your design. (One letter will be black and the colors in the letters following 
it will be incorrect). 

8. Delete the lettering with the incorrect colors in P2/M3 and P3/M3. 
9. Retype the lettering you have deleted. 
10. Make sure Multiple is checked and click Apply. 
11. Position the two sections of lettering as they were in the original. 
12. Combine the design. The lettering should now be correct, if not repeat steps 8 to 11 until 

all the lettering is correct. 
13. Save the design. The sections of lettering will be saved in the hoop positions where you 

placed them. 

B41 Error: "You have created letters that are outside the recommended size for 
this font" 

Each font is designed for the size range specified in its name. If the Size setting for the 
selected font is outside the recommended range, this message will appear. You can create 
Lettering outside the recommended size, however it may not produce optimum results. Click 
OK to create the Lettering or Cancel, then select a more appropriate font. If you do wish to 
create Lettering larger than the recommended size it may be effective to use a Fill Pattern; 
however the Underlay in the font should also be appropriate. 

B42 Error: "Please enter an integer between 3 and 80" 

This message appears if the size entered in the Size Box on the Letters Page is below 3mm 
or above 80mm. The Size setting refers to the height in millimeters of a capital "A" in the 
selected Font. If you wish to increase lettering slightly above this you could click and drag 
one of the corner boxes or alter the Height or Width Proportions. 

B43 Error: "Cannot open Font" 

This message appears if the font file that you have selected from the Font Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that font file from the C:\VipEmbroidery\System folder. Close VIP 
Customizing, make sure the file is in the folder, then try again. Alternatively, you may need to 
Uninstall and Reinstall the program. 

B44 Error: "Cannot open Shapes" 

This message appears if the shapes file that you have selected from the Shapes Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that shapes file or the .bmp file of the same name from the 



C:\VipEmbroidery\System folder. Close VIP Customizing, make sure the file is in the folder, 
then try again. Alternatively, you may need to Uninstall and Reinstall the program. 

B45 Error: "Font file is corrupted; use backup" 

This message appears when trying to select a lettering style if the file has corrupted. 
Reinstall the file or Uninstall and Reinstall the program. 

B46 Error: "Old font. No longer supported" 

This message appears if you attempt to create lettering using a font file that was created in 
an earlier version of the Customizing program. To continue creating lettering, select an 
alternative font. When you close VIP Customizing, remove any old .fnt files from the 
C:\VipEmbroidery\System folder using Windows® Explorer. 

B55 I've made a Mega Hoop (or Plus Hoop) design and the lettering did not split 
automatically when I selected Combine 

The automatic splitting up of lettering does not work after it has been converted to a 'design'. 
This occurs if it is Rotated, or Pasted from another program, as well as if it has been 
previously Combined or Saved. 

B57 I only have 17 fonts and 4 shapes styles. How do I add the extra fonts and 
shapes shown on this website to my VIP Customizing program? 

You need to download the upgrade 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm] files that will give you the most up-to-date versions of the 29 fonts and 7 shapes 
styles available for your VIP Customizing program. To see the characters available, a key for 
the Greek and Hebrew fonts and sample monograms, download the updated Font Guide 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm#guides] and Shape Guide 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_fontshap
es.htm#guides] pdf files. If you received the Professional Plus system, you already have all 
available fonts and shapes. This update applies only to Customizing Plus version 6.0. 

C01 What causes the error message "No room to create letters; only one design 
allowed"? 

When trying to create Lettering or Shapes, this message appears if more than one design is 
loaded without them being combined. Press Combine to put the loaded designs together, 
then reselect Lettering/Shapes and the dialog box will appear. 

C07 What causes the error message "Font file is corrupt" when I try to select a 
lettering style? 

This is due to the font file being moved or copied without using the correct installation 
procedure. Reinstall the fonts from the floppy disk on which they were supplied. 

C17 I have just installed Customizing and in the program some fonts are listed 
with '.fnt' after them and I am unable to use them. 



Some computer setups do create this unusual error with the fonts in Customizing. By using 
Windows Explorer, change the name of the font files in the c:\Husq95\System so that the 
name is in Capitals, and the extension is in lower case. 
For example: 
• BLOCK.fnt 
• BLOCK_NP.fnt 
• BASEBALL_UC.fnt 
• SCRIPT.fnt 
Though it may seem to be correctly typed already, you may have to rename the files 
regardless, and possibly have to rename them to another name completely and back again. 
If the correct names, without the .FNT extension appear in the Customizing Letters (ABC) 
window, then the font will work correctly. 

C18 All the lettering created in Customizing appears far too thin when stitched 

Make sure you are using the Stitch Advisor included with Customizing to its full potential. 
This is found on the last tab 'Advisor' on the lettering window. By default this is set to Woven, 
which is designed for thin materials. If this is set higher the letters become bolder. Try 
creating some letters, and changing between each of these settings and you will see 
immediately the difference it makes. This is particularly useful for small lettering. It may also 
help to increase the number in the density setting (decreasing the number of stitches). 

Miscellaneous 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 
You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 



2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 



5. The display should look similar to the picture to the right, with the Rainbow USB 
SuperPro device listed. 

If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B03 I get an error message when I open my HUS file from Windows Explorer 
When you double-click on a HUS file from explorer it should open that file into the 
Customizing Software. This relies on the computer knowing which programs are associated 
with which files. It seems that somehow this association may have been confused and would 
have to be restored. To restore this association, do the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Stitch Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 
6. Run Customizing by finding it in the Start menu (go to Start, Programs, Husqvarna Viking 

Embroidery System 5, Customizing). 
7. Close the Customizing program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your HUS files should now be associated correctly. 

B07 How can I drive two Poems or two Toyota 800 Series machines from one 
computer? 

Your computer will need both COM ports 1 & 2 free. If you have a mouse or modem, for 
example, connected to either of these, then you will have to either turn them off or reset them 
on a higher com port number. 
1. Connect the two embroidery machines to the COM ports of the computer. 
2. Download "2Machines.exe 

[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_gen
eral.htm#2mc]" and copy it into "C:\Husqpro" or whichever folder the Husqvarna 
Professional Embroidery System was installed into. 



3. Double click on this self-extracting exe and the files will be unzipped, including 
"2Machines.doc", a copy of these instructions. 

4. To run two Poems on your computer, run the file '2POEMs'; to run two Toyotas on your 
computer, run the file '2Toyotas'. 

5. Now when you run Customizing Pro, the two buttons marked 1 and 2 will send the 
current design to the respective machines in Com ports 1 and 2. Note that once either of 
these buttons has been selected and the driver window has appeared, another design 
can be loaded in and sent to the other machine without affecting the first. Thus both 
machines can run independently of each other. 

B12 I do not have the controls to change colors or add lettering 

The Control Panel holds all the controls for editing colors, lettering and shapes. By default it 
is on the right-hand side, but this can be moved or hidden from view. If you cannot see it 
then go to the 'View' menu and select 'Control Panel'. If this has not returned your controls 
then you will have to restore your program settings: 
1. Close Customizing. 
2. Open Windows® Explorer and open the 'Windows' folder on your C: drive. 
3. Find the file 'customiz.ini', or 'custompro.ini' for users of the Professional System 5. 
4. Delete this file by right-clicking on it and selecting 'Delete'. 
5. Now find the file of the same name in the root directory of your program CD. (If your VIP 

software was installed from a multi-language CD, you will find the .ini file in the relevant 
language folder. For instance, if you installed the English version of the software, you will 
find the .ini file in the "English" folder.) 

6. Right-click on it and select 'Copy'. 
7. Right-click on the 'Windows' folder of your C: drive and select 'Paste'. 
8. Now you can run Customizing and the settings should be set to default 

B13 How can I combine the plus hoop designs for the Designer I? 

As a plus hoop design will not open in the correct positions when you have Large Hoop 
selected, you can take the following steps to position them correctly: 
1. If the design is on a card, use Reader/Writer Pro to read it and save the design parts as 

a series of files. 
2. Open Customizing System 5 (or Customizing Pro System 5). 
3. Go to the Size icon and select Large Hoop; on the same screen change the grid size to 

35mm. 
4. Open the three (or two) Plus Hoop design files in the order that they will be stitched out 

(e.g. P1 - stitch first, P3 - stitch second, P2 - stitch third). 
5. Place the P2 design so that the first stitch, marked by the small cross, is on the center of 

the gridlines in the center of the hoop. You may wish to zoom in to help positioning. 
6. Place the P1 design so that the first stitch is on the first gridline above the center line. 
7. Place the P3 design so that the first stitch is on the first gridline below the center line. 
8. Click combine to merge them into one design file for the Designer I, and save as a new 

filename. There will be many color changes. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 



B34 VIP Customizing is not communicating with my Toyota AD800 series 
embroidery machine and I have Windows ME or Windows XP 

You need to download and install the Toyota AD800 series driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_toyota.ht
m]. 

B43 Error: "Cannot open Font" 

This message appears if the font file that you have selected from the Font Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that font file from the C:\VipEmbroidery\System folder. Close VIP 
Customizing, make sure the file is in the folder, then try again. Alternatively, you may need to 
Uninstall and Reinstall the program. 

B44 Error: "Cannot open Shapes" 

This message appears if the shapes file that you have selected from the Shapes Box is not 
available. This could happen if you opened the VIP Customizing program, then accidentally 
moved or deleted that shapes file or the .bmp file of the same name from the 
C:\VipEmbroidery\System folder. Close VIP Customizing, make sure the file is in the folder, 
then try again. Alternatively, you may need to Uninstall and Reinstall the program. 

B45 Error: "Font file is corrupted; use backup" 

This message appears when trying to select a lettering style if the file has corrupted. 
Reinstall the file or Uninstall and Reinstall the program. 

B46 Error: "Old font. No longer supported" 

This message appears if you attempt to create lettering using a font file that was created in 
an earlier version of the Customizing program. To continue creating lettering, select an 
alternative font. When you close VIP Customizing, remove any old .fnt files from the 
C:\VipEmbroidery\System folder using Windows® Explorer. 

C08 Problem with Shapes and Microsoft Power Toys 

If the mouse driver from Microsoft Power Toys called Xmouse is installed, the user will not be 
able to select shapes from the Shape Selection Screen in Customizing 95 or Customizing 
Pro. Remove this mouse driver to fix. 

C09 Why would certain functions not work all the time? 

When the Create Shapes and Lettering Dialog Box is open, other designs may be moved 
around the screen, but they cannot be rotated, mirrored or scaled. The lettering or shape that 
has been created can be scaled with proportional changes in density, but it cannot be rotated 
or mirrored. Similarly, designs and pieces of lettering or shapes cannot be combined until the 
dialog box is closed. 

C11 Designs don't always appear fully on the screen 

Some graphics cards cannot redraw the screen fast enough compared with the program 
speed. This may result in the design not appearing in full. Select the design and move it 



slightly, or reload the design and it should be drawn correctly. To diagnose whether it is your 
graphics card or driver causing the problem, first close all programs. Then go to My 
Computer, Properties, Performance, Graphics and turn Hardware Acceleration down to zero; 
you will then have to reboot the computer. If this solves the problem, contact your computer 
dealer for more information. You may find that a later version of your video card driver (often 
available on the manufacturer's web site) provides an improvement. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 

C15 When I print out designs I don't get all the details 

Ensure that you are printing in portrait, not landscape mode. Designs will be printed with their 
Name, Notes, Width, Height, Stitch Count, and list of colors if you choose portrait mode. 

C16 Driving two Poems or two Toyota 800 Series machines from one computer 
Your computer will need both com ports 1 & 2 free. If you have a mouse or modem, for 
example, connected to either of these, then you will have to either turn them off or reset them 
on a higher com port number. 
1. Connect the two embroidery machines to the com ports of the computer. 
2. Download "2Machines.exe 

[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_gen
eral.htm#2mc]" and copy it into "C:\Husqpro" or whichever folder the Husqvarna 
Professional Embroidery System was installed into. 

3. Double click on the self-extracting exe and the files will be unzipped, including 
"2Machines.doc" another copy of these instructions. 

4. To run two Poems on your computer, run the file '2POEMs'; to run two Toyotas on your 
computer, run the file '2Toyotas'. 

Now when you run Customizing Pro, the two buttons marked 1 and 2 will send the current 
design to the respective machines in Com ports 1 and 2. Note that once either of these 
buttons has been selected and the driver window has appeared, another design can be 
loaded in and sent to the other machine without affecting the first. Thus both machines can 
run independently of each other. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 



Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 



1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 
appears. 

2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 
Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 



B03 I get an error message when I open my HUS file from Windows Explorer 
When you double-click on a HUS file from explorer it should open that file into the 
Customizing Software. This relies on the computer knowing which programs are associated 
with which files. It seems that somehow this association may have been confused and would 
have to be restored. To restore this association, do the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Stitch Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 
6. Run Customizing by finding it in the Start menu (go to Start, Programs, Husqvarna Viking 

Embroidery System 5, Customizing). 
7. Close the Customizing program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your HUS files should now be associated correctly. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

B15 When I open a file into Customizing I am unable to move or resize it 
Some files are corrupt in such a way that the height and width are negative values (see on 
the control panel). This can be easily cured by clearing the display (using New), reopening 
the faulty file, and using Save As to resave it. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

B40 Error: "Plus or Multi-part Hoop is not selected" 

This message appears if the Open Plus/Mega Designs is selected under the File menu, but 
the Plus Hoop or Mega Hoop multi-part settings have not been chosen in the Hoop Size 
Preferences. Click Size and alter the setting to a Plus Hoop or Mega Hoop multi-part setting, 
then try again. 

B53 I tried to open some previously made Plus Hoop designs, but they are not 
in their correct positions 

Check the Plus Hoop setting has been chosen. Click Preferences and alter the Hoop Size 
setting to 170mm x 100mm (Plus Hoop). To load designs in specific positions for the Plus 
Hoop, click File, Open Plus/Mega Designs Command, P1 and so on. 



B54 I tried to open some previously made Mega Hoop designs, but they are not 
in their correct positions 

Check the Mega Hoop multi-part setting has been chosen. Click Preferences and alter the 
Hoop Size setting to 360mm x 150mm (Mega Multi-Part). To load designs in specific 
positions for the Mega Hoop, click File, Open Plus/Mega Designs Command, P1 and so on. 

C04 Can I add a file to the screen without getting the message "Design in 
display area will be deleted. Ok?"? 

When you select Open, if design(s) have previously been loaded this warning message 
appears. Click OK if you wish to replace the design(s) on the screen. To add the new design 
to the existing one(s), select Insert or View. 

C05 I am trying to load a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

C06 I am trying to load a file and the message "Too many designs, only 9 
designs allowed" appears 

This message appears if you try to Load, Insert or drag and drop files so that there are more 
than 9 in the Husqvarna Customizing Software Window. 

C13 I'm trying to view, open or insert a design and the program just beeps 

Check that no dialog boxes are open. For instance, the Create Lettering and Shapes Screen 
must be closed before another Design can be loaded. 

C14 I can't drag and drop designs from the open or insert dialog boxes 

To drag and drop up to 9 designs onto the Display Area, click the Explorer Icon to access 
Windows Explorer. 

C20 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. To find 
the corrupt file use File > Open to individually open each file in this directory. When a file is 
reported to be corrupt use Windows® Explorer to delete it. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 



This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

Printing 

B06 When I print out designs I don't get all the details 

Ensure that you are printing in portrait, not landscape mode. Designs will be printed with their 
Name, Notes, Width, Height, Stitch Count, and list of colors if you choose portrait mode. 

B10 I have an Epson Stylus Color 600 printer and my colors are incorrect 
The Epson Stylus Color 600 (or 600Q) printer driver changes the color values which affect 
the printout, causing white and gray to appear as black, pink to appear as red, etc. To 
remove these color changes do the following: 
1. Open the design you wish to print. 
2. Select Print. 
3. Click on the Properties button. 
4. Where it says 'Mode' at the top of the window select 'Advanced'. 
5. The 'More Settings' button is now available, click it. 
6. On the top right, under 'Color' ensure 'Color Adjustment' is selected. 
7. Change 'Mode' to 'Vivid'. 
8. Click 'OK'. 
9. Click on the 'Save Settings' button. 
10. Under 'Name' type in 'Husq Customizing' and click 'Save'. 
11. Click 'OK' to close the window, and 'OK' again to print. 
You have now set up a printer setting for future use when printing in Customizing. Whenever 
you wish to print, go to properties, select 'Advanced' and choose 'Husq Customizing' from 
the drop-down list. When you print from any other software, it is recommended that you 
change your properties back to the 'Automatic' setting beforehand. 

B11 Whenever I print, the colors are lighter than old printouts from the 
Customizing 95 

The Husqvarna Viking Customizing System 5 printouts have been optimized for a much finer 
print to show the stitching detail of the designs more clearly. This higher quality does lead to 
the printouts becoming fainter. 



 
Printouts from Customizing 95 and System 

 
If your images do not appear as bold as you would like, or you have lines missing then it is 
recommended that you change your printer driver settings when printing in Customizing. 
With the program open, click File, Print Setup and choose Properties to change these. Many 
printer drivers have different color schemes or quality settings, so try to find the one which 
suits the printouts best. Usually there is a tab called Graphics which has settings related to 
color printing; try adjusting the intensity to a darker color. If your driver has a way for 
memorizing these settings as a profile, do this so that you can instantly recall them whenever 
you print from Customizing. 
Alternatively you could make a new 'copy' of your printer with these settings: 
1. Go to Start button, Settings, Printers, and select Add Printer. 
2. Select the options as if you were setting up your standard printer, but give it a different 

name. 
3. Enter the color settings you have found are preferable for your printouts and close the 

properties box. 
4. Now simply select this printer whenever you print from Customizing. 
For more information on how to configure your print settings consult your printer's 
documentation. 

B39 I tried to print a number of files, but only one appeared on the printout 
Only the first Stitch File loaded on the VIP Customizing screen is printed, unless all Stitch 
Files have been Combined or Saved. 

B52 Error: "No designs available to print. Only designs that have been 
Combined and are inside the hoop can be printed" 

This message appears if the Stitch File(s) on screen have not been Combined. To print more 
than one design, they must be Combined and fit in the selected hoop. If Stitch File(s) have 



not been Combined, and the design that was loaded first has not been moved from the 
center of the Stitch Area, it will be printed. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 



• Floppy disk operations were not possible within the software or within Windows Explorer, 
so it was not possible to read or write disks in VIP Disk Manager. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 
Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 

Quick 3DStitch View 

B47 Error: "No designs available for 3D view. Only designs that have been 
combined and are inside the hoop can be shown" 

If you attempt to combine designs unsuccessfully when the Plus Hoop or Mega Multi-Part 
settings are chosen, that is they are not all inside one of the Stitch Areas, when you select 
Quick 3DStitch™ View this message may appear. Move the designs until you can combine 
them, then try Quick 3DStitch View™ again. 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 



6. Click Apply. The screen will be adjusted, then another message will appear asking if you 
wish to keep these settings. Click OK to continue (let the computer restart if required). 

If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 



6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 
'Full'. 

7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 



M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Screen Appearance 

B21 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Customizing Program 

Certain icons (for example Combine, Save As and Print on the Main Toolbar and all Edit 
Toolbar icons apart from Preferences) are only highlighted once a stitch file is shown on the 
VIP Customizing screen. 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

B56 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons: 
1. Close the program. 
2. Copy the customiz.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 



4. Right-click the pasted customiz.ini file and select the Properties option from the popup 
menu. 

5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

Stitch Files 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 
You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

Stitching Out 

B07 How can I drive two Poems or two Toyota 800 Series machines from one 
computer? 

Your computer will need both COM ports 1 & 2 free. If you have a mouse or modem, for 
example, connected to either of these, then you will have to either turn them off or reset them 
on a higher com port number. 
1. Connect the two embroidery machines to the COM ports of the computer. 
2. Download "2Machines.exe 

[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_gen
eral.htm#2mc]" and copy it into "C:\Husqpro" or whichever folder the Husqvarna 
Professional Embroidery System was installed into. 

3. Double click on this self-extracting exe and the files will be unzipped, including 
"2Machines.doc", a copy of these instructions. 

4. To run two Poems on your computer, run the file '2POEMs'; to run two Toyotas on your 
computer, run the file '2Toyotas'. 

5. Now when you run Customizing Pro, the two buttons marked 1 and 2 will send the 
current design to the respective machines in Com ports 1 and 2. Note that once either of 
these buttons has been selected and the driver window has appeared, another design 



can be loaded in and sent to the other machine without affecting the first. Thus both 
machines can run independently of each other. 

B09 All my lettering appears far too thin when stitched 

Make sure you are using the Stitch Advisor included with Customizing to its full potential. 
This is found on the Lettering tab of the Control Panel. By default this is set to Woven, which 
is designed for thin materials. If this is set higher the letters become bolder. Try creating 
some letters, and changing between each of these settings and you will see immediately the 
difference it makes. This is particularly useful for small lettering. It may also help to increase 
the number in the density setting (decreasing the number of stitches). 

Writing to a Card 

B24 I cannot send a file to an embroidery machine 

Open the VIP Configure setup utility. This will allow you to set the COM port for Pfaff 7500 
series or Pfaff 2140, Toyota and Huskygram/POEM machines. To send design(s) to the Pfaff 
2140 machine, use VIP File Assistant. 
Husqvarva Viking machines do not require a direct connection to the computer. See FAQ 
#M08 for details on what is required for your machine. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 
Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 

Disk Manager 
Listed versions: System 5, version 5.0; VIP, version 6.0; VIP, version 6.3 

Designer I Disks 

E01 Does the Designer I use standard floppy disks? 

The Designer I uses standard 1.44 MB floppy disks. They are used in the same way the 
cards are used on the #1+/Orchidea and Rose. You must use the Disk Manager software to 
send the designs to the disk, and then this disk is placed in the machine. 

E02 Can I store other files on a Designer I disk? 



Though it is possible to store other files on the same disk, we do not recommend it. If you 
keep one or two blank disks just for sending designs to the Designer I, then they can be used 
just like the cards for the #1+/Orchidea and Rose. 

E03 Disk Manager created SHV files on my floppy disk. What are they? 

SHV files, along with MHV, DHV and PHV, are all system files which Disk Manager creates 
for the Designer I to read. They cannot be opened into any other software, and have no other 
function. 

E04 Designs that should work on the Designer I are rejected or appear corrupt 
Can also give the error message 'Wrong hoop for embroidery, change hoop and restart' on 
the Designer I display. 
Some conversion programs, such as Buzztools version 3.00 and below (Buzztools have 
fixed this bug for version 3.01 upwards) produce corrupt HUS files when converting files from 
other formats. The nature of these corrupt files is that the information stored that specifies 
the height, and the width of the design is incorrectly encoded in the HUS file by these third-
party conversion programs. 
A standard way to get around the problem is to load the corrupt design into Customizing, 
click Center Design and then resave the design; this fixes the corrupt file. 
An alternative method, particularly if you have many designs causing this error, is to load the 
corrupt designs into Disk Manager in the standard way. Then 'Multi-Save' the files (choose 
File, then Multi-Save) into a new folder. (You can automatically create a new folder by typing 
it into the dialog-box that appears after choosing Multi-Save). Then reload the fixed files and 
proceed as normal. 

E14 Error: "Data on disk is corrupt; redo" 

This message may appear if a disk has been pulled out of the computer during the writing 
process. Try writing to the disk again. 

E17 I am having problems writing stitch files to a floppy disk 

First try another disk. If the problems are limited to one disk, try formatting it fully. If you still 
experience problems, dispose of it. 

E19 I have put a disk of designs in my Designer I but they do not appear on the 
machine LCD 

You cannot simply copy stitch files (eg *.hus files) onto a floppy disk. You must use the Disk 
Manager software to transfer the designs onto floppy disk for your Designer I. 

E20 Error: “No 1.44MB floppy disk drive found. Aborting program.” 

This is caused by one of the following: 
• The floppy disk drive is faulty or missing. You should replace the floppy disk drive. 
• The computer has an external USB floppy disk drive, usually on a laptop computer. You 

should download and install Disk Manager 6.3 from the Husqvarna Viking Software 
Download 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_disk
man.htm] page. 



Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Error Messages 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  



 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 



1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

E06 "The design can only be saved and stitched out if it is rotated 90 degrees. 
Is that OK?" 

This message will appear if the Stitch File you are attempting to load is more than 150mm 
wide, but would fit in a Designer I Hoop if it was rotated; that is it is between 150mm and 
360mm wide, and less than 150mm high. Click Yes to continue. 

E07 Error: "Stitch file too big for hoop" 

This message appears if the Stitch File you are trying to load onto the VIP Disk Manager 
screen is larger than the dimensions that will fit in the optional Mega Hoop (150x360mm). 



E08 Error: "Menu is full. % Stitch Files left out" 

If there are 36 stitch files on the Design Menu into which you are trying to load designs, this 
message appears. Select another Design Menu and try again. 

E09 Error: "Not enough room on disk" 

This message appears when you try to load more designs if there is already as much stitch 
data on the Design Menu(s) as will fit on a floppy disk. Delete one or more Stitch Files and 
try again. 

E10 Error: "No disk in drive" 

This message appears if there is no disk inserted in the floppy disk drive of your computer 
when you select the Write Disk function. 

E11 Error: "Disk access denied" 

This message appears if the disk inserted in the floppy disk drive of your computer when you 
select the Write Disk function is write-protected. 

E12 Error: "Wrong disk size. Use 1.44MB only" 

This message appears if a 720K floppy disk is inserted in the floppy disk drive of your 
computer when you select the Write Disk function. Replace it with a 1.44MB disk. 

E13 Error: "No disk in drive" 

This message appears if there is no disk inserted in the floppy disk drive of your computer 
when you select the Read Disk function. 

E14 Error: "Data on disk is corrupt; redo" 

This message may appear if a disk has been pulled out of the computer during the writing 
process. Try writing to the disk again. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 



L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 
check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 



Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

E15 Some of the icons in the Toolbar are 'grayed out' when I open the VIP Disk 
Manager Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons are only highlighted once a stitch file is shown on the VIP Disk Manager 
screen. This is also true for the corresponding menu options. 

E16 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPDiskManager.ini file from the root folder of your CD. (If your VIP software 

was installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDiskManager.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 



This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 



1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 
quality printer cable lead - replace it with Husqvarna approved cable. 

2. Check the version number of your software. Digitizing version 4.11 (or above) has 
improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 



Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 



Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 



 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 



Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

E02 Can I store other files on a Designer I disk? 

Though it is possible to store other files on the same disk, we do not recommend it. If you 
keep one or two blank disks just for sending designs to the Designer I, then they can be used 
just like the cards for the #1+/Orchidea and Rose. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 



• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 



This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

E06 "The design can only be saved and stitched out if it is rotated 90 degrees. 
Is that OK?" 

This message will appear if the Stitch File you are attempting to load is more than 150mm 
wide, but would fit in a Designer I Hoop if it was rotated; that is it is between 150mm and 
360mm wide, and less than 150mm high. Click Yes to continue. 

E07 Error: "Stitch file too big for hoop" 

This message appears if the Stitch File you are trying to load onto the VIP Disk Manager 
screen is larger than the dimensions that will fit in the optional Mega Hoop (150x360mm). 

E08 Error: "Menu is full. % Stitch Files left out" 

If there are 36 stitch files on the Design Menu into which you are trying to load designs, this 
message appears. Select another Design Menu and try again. 



E09 Error: "Not enough room on disk" 

This message appears when you try to load more designs if there is already as much stitch 
data on the Design Menu(s) as will fit on a floppy disk. Delete one or more Stitch Files and 
try again. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

Printing 

E18 I tried to use the Print Preview but I cannot see the current Design Menu 

The Print Preview function always starts at Menu 1. Click Next Page or the Page Down key 
to see subsequent menus. Set the print range to the desired page numbers that correspond 
to the menus you wish to print; otherwise four pages will always be printed. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 



ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 



Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 



Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 



M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Reading from a Disk 

E13 Error: "No disk in drive" 

This message appears if there is no disk inserted in the floppy disk drive of your computer 
when you select the Read Disk function. 

E14 Error: "Data on disk is corrupt; redo" 

This message may appear if a disk has been pulled out of the computer during the writing 
process. Try writing to the disk again. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 



L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Screen Appearance 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

E15 Some of the icons in the Toolbar are 'grayed out' when I open the VIP Disk 
Manager Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons are only highlighted once a stitch file is shown on the VIP Disk Manager 
screen. This is also true for the corresponding menu options. 

E16 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPDiskManager.ini file from the root folder of your CD. (If your VIP software 

was installed from a multi-language CD, you will find the .ini file in the relevant language 



folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDiskManager.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Using Designs on the Machine 

E04 Designs that should work on the Designer I are rejected or appear corrupt 
Can also give the error message 'Wrong hoop for embroidery, change hoop and restart' on 
the Designer I display. 
Some conversion programs, such as Buzztools version 3.00 and below (Buzztools have 
fixed this bug for version 3.01 upwards) produce corrupt HUS files when converting files from 
other formats. The nature of these corrupt files is that the information stored that specifies 
the height, and the width of the design is incorrectly encoded in the HUS file by these third-
party conversion programs. 
A standard way to get around the problem is to load the corrupt design into Customizing, 
click Center Design and then resave the design; this fixes the corrupt file. 
An alternative method, particularly if you have many designs causing this error, is to load the 
corrupt designs into Disk Manager in the standard way. Then 'Multi-Save' the files (choose 
File, then Multi-Save) into a new folder. (You can automatically create a new folder by typing 
it into the dialog-box that appears after choosing Multi-Save). Then reload the fixed files and 
proceed as normal. 

E05 My Designer I keeps telling me my design is too big for the hoop regardless 
of what hoop I use or where the design is placed 

Some corrupt files cause this error, but appear okay on the screen. Open the file in 
Customizing, click Center Design and then use Save As to save over the corrupt file. Then 
try using Disk Manager again to transfer the file to floppy disk for your Designer I. 

E19 I have put a disk of designs in my Designer I but they do not appear on the 
machine LCD 

You cannot simply copy stitch files (eg *.hus files) onto a floppy disk. You must use the Disk 
Manager software to transfer the designs onto floppy disk for your Designer I. 



Writing to a Disk 

E01 Does the Designer I use standard floppy disks? 

The Designer I uses standard 1.44 MB floppy disks. They are used in the same way the 
cards are used on the #1+/Orchidea and Rose. You must use the Disk Manager software to 
send the designs to the disk, and then this disk is placed in the machine. 

E03 Disk Manager created SHV files on my floppy disk. What are they? 

SHV files, along with MHV, DHV and PHV, are all system files which Disk Manager creates 
for the Designer I to read. They cannot be opened into any other software, and have no other 
function. 

E04 Designs that should work on the Designer I are rejected or appear corrupt 
Can also give the error message 'Wrong hoop for embroidery, change hoop and restart' on 
the Designer I display. 
Some conversion programs, such as Buzztools version 3.00 and below (Buzztools have 
fixed this bug for version 3.01 upwards) produce corrupt HUS files when converting files from 
other formats. The nature of these corrupt files is that the information stored that specifies 
the height, and the width of the design is incorrectly encoded in the HUS file by these third-
party conversion programs. 
A standard way to get around the problem is to load the corrupt design into Customizing, 
click Center Design and then resave the design; this fixes the corrupt file. 
An alternative method, particularly if you have many designs causing this error, is to load the 
corrupt designs into Disk Manager in the standard way. Then 'Multi-Save' the files (choose 
File, then Multi-Save) into a new folder. (You can automatically create a new folder by typing 
it into the dialog-box that appears after choosing Multi-Save). Then reload the fixed files and 
proceed as normal. 

E05 My Designer I keeps telling me my design is too big for the hoop regardless 
of what hoop I use or where the design is placed 

Some corrupt files cause this error, but appear okay on the screen. Open the file in 
Customizing, click Center Design and then use Save As to save over the corrupt file. Then 
try using Disk Manager again to transfer the file to floppy disk for your Designer I. 

E10 Error: "No disk in drive" 

This message appears if there is no disk inserted in the floppy disk drive of your computer 
when you select the Write Disk function. 

E11 Error: "Disk access denied" 

This message appears if the disk inserted in the floppy disk drive of your computer when you 
select the Write Disk function is write-protected. 

E12 Error: "Wrong disk size. Use 1.44MB only" 

This message appears if a 720K floppy disk is inserted in the floppy disk drive of your 
computer when you select the Write Disk function. Replace it with a 1.44MB disk. 



E14 Error: "Data on disk is corrupt; redo" 

This message may appear if a disk has been pulled out of the computer during the writing 
process. Try writing to the disk again. 

E17 I am having problems writing stitch files to a floppy disk 

First try another disk. If the problems are limited to one disk, try formatting it fully. If you still 
experience problems, dispose of it. 

E19 I have put a disk of designs in my Designer I but they do not appear on the 
machine LCD 

You cannot simply copy stitch files (eg *.hus files) onto a floppy disk. You must use the Disk 
Manager software to transfer the designs onto floppy disk for your Designer I. 

E20 Error: “No 1.44MB floppy disk drive found. Aborting program.” 

This is caused by one of the following: 
• The floppy disk drive is faulty or missing. You should replace the floppy disk drive. 
• The computer has an external USB floppy disk drive, usually on a laptop computer. You 

should download and install Disk Manager 6.3 from the Husqvarna Viking Software 
Download 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_disk
man.htm] page. 

d-Card Reader/Writer 
Listed versions: VIP, version 6.0; Version 5.0; VIP, version 6.2 

Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 



If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

A29 What could cause the "No d-Card Reader/Writer unit is connected" error 
message? 



Check that the d-Card Reader/Writer is securely plugged into the USB port of the computer 
or hub. Check the cable is plugged in as shown in the Getting Started User’s Guide. 
If you still have a problem then plug the d-Card Reader/Writer directly into into your 
computer's USB port. If it is now OK, then the problem may be a damaged or poor quality 
device or cable 
If you have a problem installing a USB d-Card Reader/Writer ensure that your BIOS is 
configured to allow support of Legacy USB devices. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L26 Error "Cannot save file." 



The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

S02 "The design can only be saved and stitched out if it is rotated 90 degrees. 
Is that OK?" 

This message will appear if the Stitch File you are attempting to load is more than 150mm 
wide, but would fit in a Designer II hoop if it was rotated; that is it is between 150mm and 
360mm wide, and less than 150mm high. Click Yes to continue. 

S03 Error: "Stitch file too big for hoop" 

This message appears if the Stitch File you are trying to load onto the VIP d-Card 
Reader/Writer screen is larger than the dimensions that will fit in the optional Mega Hoop 
(150x360mm). 

S04 Error: "Menu full" 

If there would be more than 35 stitch files on the screen after loading the desired designs, 
this message appears. Delete those you do not need and load again. 

S05 Error: "No d-Card is inserted" 

This message appears if there is no d-Card inserted in the d-Card Reader/Writer when you 
select the Write d-Card function. 

S06 Error: "Cannot write to d-Card" 

This message appears if the d-Card is defective or if a d-card is pulled out of the d-Card 
Reader/Writer during the writing process. 

S07 Error: "d-Card is not programmable" 

This message appears if a Husqvarna Viking read-only Embroidery d-Card is inserted in the 
d-Card Reader/Writer when you select Write d-Card; replace with a Personal d-Card. 

S08 Error: "This d-Card contains a sewing machine upgrade program. Click OK 
to continue" 

This message appears if the Personal d-Card placed in the VIP d-Card Reader/Writer 
contains a program that can update your Husqvarna Viking Designer II sewing machine 
software. If you do not wish to update at this time, click OK to continue the Write d-Card 
procedure. The update program will be erased when the designs are written to the d-Card. 

S09 Error: "No designs are loaded on the screen" 



This message appears if there are no designs loaded on the screen of the VIP d-Card 
Reader/Writer program when you select Write d-Card. 

S10 Error: "Too many stitch files for d-Card; only room for % stitch files" 

If there are more stitch files on the VIP d-Card Reader/Writer screen than will fit on a d-Card, 
this message appears when you select the Write Card function. The number of stitch files 
that can fit in sequence from the top left of the screen is listed. Delete stitch files as required, 
but unless these are chosen from the bottom right of the screen, the number can only be a 
guideline. This is because it is an approximation related to the type of stitches in each stitch 
file. 

S11 Error: "The d-Card is not an Embroidery d-Card" 

This message appears if the d-Card from which you are trying to load designs is another 
type of d-card, for example a Stitch d-Card. 

S12 Error: "Data on d-Card is corrupt; the d-Card may be faulty" 

This message may appear if a d-Card has been pulled out of the computer during the writing 
process. Try writing to the d-Card, then use the Read d-Card feature again. 

Icons and Toolbars 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

S13 Some of the icons in the Toolbar are 'grayed out' when I open the VIP d-
Card Reader/Writer Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons except for Preferences are only highlighted once a stitch file is shown on the 
VIP d-Card Reader/Writer screen. The menu icons (Second Menu, Third Menu and so on) in 
the Card Toolbar are only highlighted if the Read Card feature has been used to read in an 
Embroidery Card with more than 35 Stitch Files. 

S14 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 



To reset the icons: 
1. Close the program. 
2. Copy the VIPdCardRW.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPdCardRW.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 



• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

S01 The USB d-Card Reader does not function properly with a Toshiba portable 
computer 

There have been problems when trying to use the USB d-Card Reader on Toshiba Satellite 
or Satellite Pro laptop computers with early versions of the USB ports. The best way to avoid 
any problems is to install a second port by adding a PC-Card with one or two USB ports. 

Miscellaneous 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 



If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 



Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 



checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

S01 The USB d-Card Reader does not function properly with a Toshiba portable 
computer 

There have been problems when trying to use the USB d-Card Reader on Toshiba Satellite 
or Satellite Pro laptop computers with early versions of the USB ports. The best way to avoid 
any problems is to install a second port by adding a PC-Card with one or two USB ports. 

S16 There is no light showing on my d-Card Reader/Writer 
The green LED on the d-Card Reader/Writer is visible only while you are Reading a d-Card 
or Writing a d-Card. At all other times it is not lit up, even if the d-Card Reader/Writer is 
connected correctly to the USB port of your computer. 

S17 Can I use the d-Card Reader/Writer with my Mega Hoop? 

The d-Card Reader/Writer is designed to be compatible with the optional Mega Hoop. It will 
open, view and save designs up to 150mm x 360mm in size. If the design is more than 
150mm wide, but would fit in the Mega Hoop if it was rotated, that is it is between 150mm 
and 360mm wide, and less than 150mm high the following message will appear: "The design 
can only be saved and stitched out if it is rotated 90 degrees. Is that OK?" Click Yes to 
continue. 



Opening and Browsing Designs 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

S02 "The design can only be saved and stitched out if it is rotated 90 degrees. 
Is that OK?" 

This message will appear if the Stitch File you are attempting to load is more than 150mm 
wide, but would fit in a Designer II hoop if it was rotated; that is it is between 150mm and 
360mm wide, and less than 150mm high. Click Yes to continue. 

S03 Error: "Stitch file too big for hoop" 

This message appears if the Stitch File you are trying to load onto the VIP d-Card 
Reader/Writer screen is larger than the dimensions that will fit in the optional Mega Hoop 
(150x360mm). 

S04 Error: "Menu full" 



If there would be more than 35 stitch files on the screen after loading the desired designs, 
this message appears. Delete those you do not need and load again. 

S10 Error: "Too many stitch files for d-Card; only room for % stitch files" 

If there are more stitch files on the VIP d-Card Reader/Writer screen than will fit on a d-Card, 
this message appears when you select the Write Card function. The number of stitch files 
that can fit in sequence from the top left of the screen is listed. Delete stitch files as required, 
but unless these are chosen from the bottom right of the screen, the number can only be a 
guideline. This is because it is an approximation related to the type of stitches in each stitch 
file. 

Printing 

S15 I tried to use the Print Preview but I cannot see the desired Design Menu 

The Print Preview function always starts at Menu 1. Click Next Page or the Page Down key 
to see subsequent menus. Select the Design Menu number for the Designs you wish to print. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 



• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 



For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M10 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then you must lower the 
graphics acceleration provided by the card: 
For Windows® 95/98/ME users:  
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 



7. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 
'Full'. It is probably set to 'Full'. 

8. Move the slider all the way to the left for 'None'. 
9. Click 'OK' on both the windows to close them and try to view in Quick 3DStitch™ View 

again. If it now works you can try to place the slider into the optimum position. This is 
where the slider is at the rightmost, but still allows Quick 3DStitch™ View to work. This 
can only be down by trial and error; change the slider setting and test to see if you can 
still view in 3D. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the Settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled '3D Settings (OpenGL)'. 
8. Uncheck the option 'Use 3D acceleration'. 
9. Click 'OK' on both the windows to close them and try to view in 3D again. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Reading from a Card 

A29 What could cause the "No d-Card Reader/Writer unit is connected" error 
message? 



Check that the d-Card Reader/Writer is securely plugged into the USB port of the computer 
or hub. Check the cable is plugged in as shown in the Getting Started User’s Guide. 
If you still have a problem then plug the d-Card Reader/Writer directly into into your 
computer's USB port. If it is now OK, then the problem may be a damaged or poor quality 
device or cable 
If you have a problem installing a USB d-Card Reader/Writer ensure that your BIOS is 
configured to allow support of Legacy USB devices. 

S05 Error: "No d-Card is inserted" 

This message appears if there is no d-Card inserted in the d-Card Reader/Writer when you 
select the Write d-Card function. 

S11 Error: "The d-Card is not an Embroidery d-Card" 

This message appears if the d-Card from which you are trying to load designs is another 
type of d-card, for example a Stitch d-Card. 

S12 Error: "Data on d-Card is corrupt; the d-Card may be faulty" 

This message may appear if a d-Card has been pulled out of the computer during the writing 
process. Try writing to the d-Card, then use the Read d-Card feature again. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Screen Appearance 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

M05 I wish to change the background color for Quick 3DStitch™ View 



Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

S13 Some of the icons in the Toolbar are 'grayed out' when I open the VIP d-
Card Reader/Writer Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons except for Preferences are only highlighted once a stitch file is shown on the 
VIP d-Card Reader/Writer screen. The menu icons (Second Menu, Third Menu and so on) in 
the Card Toolbar are only highlighted if the Read Card feature has been used to read in an 
Embroidery Card with more than 35 Stitch Files. 

S14 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons: 
1. Close the program. 
2. Copy the VIPdCardRW.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPdCardRW.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Setting up the Reader/Writer Unit 

A29 What could cause the "No d-Card Reader/Writer unit is connected" error 
message? 

Check that the d-Card Reader/Writer is securely plugged into the USB port of the computer 
or hub. Check the cable is plugged in as shown in the Getting Started User’s Guide. 
If you still have a problem then plug the d-Card Reader/Writer directly into into your 
computer's USB port. If it is now OK, then the problem may be a damaged or poor quality 
device or cable 
If you have a problem installing a USB d-Card Reader/Writer ensure that your BIOS is 
configured to allow support of Legacy USB devices. 

S01 The USB d-Card Reader does not function properly with a Toshiba portable 
computer 

There have been problems when trying to use the USB d-Card Reader on Toshiba Satellite 
or Satellite Pro laptop computers with early versions of the USB ports. The best way to avoid 
any problems is to install a second port by adding a PC-Card with one or two USB ports. 

S16 There is no light showing on my d-Card Reader/Writer 



The green LED on the d-Card Reader/Writer is visible only while you are Reading a d-Card 
or Writing a d-Card. At all other times it is not lit up, even if the d-Card Reader/Writer is 
connected correctly to the USB port of your computer. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Using Designs on the Machine 

S17 Can I use the d-Card Reader/Writer with my Mega Hoop? 

The d-Card Reader/Writer is designed to be compatible with the optional Mega Hoop. It will 
open, view and save designs up to 150mm x 360mm in size. If the design is more than 
150mm wide, but would fit in the Mega Hoop if it was rotated, that is it is between 150mm 
and 360mm wide, and less than 150mm high the following message will appear: "The design 
can only be saved and stitched out if it is rotated 90 degrees. Is that OK?" Click Yes to 
continue. 

S18 Pressing the numbers on my Personal d-Card doesn't bring up the desired 
design on my Designer II LCD panel 

If you have the grid set to eight designs when you write the d-Card, then there will be eight 
touch-sensitive areas on the card when you insert it in the machine. If you print a label for the 
d-Card the positions will correspond to where the pictures are. If you prefer not to print a 
label, ensure that the grid size is set to 30 designs in Settings Preferences to correspond to 
the 30 numbered positions on the Personal d-Card. 

Writing to a Card 

A29 What could cause the "No d-Card Reader/Writer unit is connected" error 
message? 

Check that the d-Card Reader/Writer is securely plugged into the USB port of the computer 
or hub. Check the cable is plugged in as shown in the Getting Started User’s Guide. 
If you still have a problem then plug the d-Card Reader/Writer directly into into your 
computer's USB port. If it is now OK, then the problem may be a damaged or poor quality 
device or cable 
If you have a problem installing a USB d-Card Reader/Writer ensure that your BIOS is 
configured to allow support of Legacy USB devices. 

S05 Error: "No d-Card is inserted" 

This message appears if there is no d-Card inserted in the d-Card Reader/Writer when you 
select the Write d-Card function. 

S06 Error: "Cannot write to d-Card" 



This message appears if the d-Card is defective or if a d-card is pulled out of the d-Card 
Reader/Writer during the writing process. 

S07 Error: "d-Card is not programmable" 

This message appears if a Husqvarna Viking read-only Embroidery d-Card is inserted in the 
d-Card Reader/Writer when you select Write d-Card; replace with a Personal d-Card. 

S08 Error: "This d-Card contains a sewing machine upgrade program. Click OK 
to continue" 

This message appears if the Personal d-Card placed in the VIP d-Card Reader/Writer 
contains a program that can update your Husqvarna Viking Designer II sewing machine 
software. If you do not wish to update at this time, click OK to continue the Write d-Card 
procedure. The update program will be erased when the designs are written to the d-Card. 

S09 Error: "No designs are loaded on the screen" 

This message appears if there are no designs loaded on the screen of the VIP d-Card 
Reader/Writer program when you select Write d-Card. 

S12 Error: "Data on d-Card is corrupt; the d-Card may be faulty" 

This message may appear if a d-Card has been pulled out of the computer during the writing 
process. Try writing to the d-Card, then use the Read d-Card feature again. 

S17 Can I use the d-Card Reader/Writer with my Mega Hoop? 

The d-Card Reader/Writer is designed to be compatible with the optional Mega Hoop. It will 
open, view and save designs up to 150mm x 360mm in size. If the design is more than 
150mm wide, but would fit in the Mega Hoop if it was rotated, that is it is between 150mm 
and 360mm wide, and less than 150mm high the following message will appear: "The design 
can only be saved and stitched out if it is rotated 90 degrees. Is that OK?" Click Yes to 
continue. 

Reader/Writer 
Listed versions: Pro, system 2.1; VIP, version 6.0; Pro System 5, version 5.0; Windows 95; VIP, version 6.2 

Dongle 

A11 How do I set up my parallel Reader/Writer Unit and parallel Dongle? 

To set up a parallel Reader/Writer Unit and a parallel Dongle, do the following: 
1. Place one end of the cable into the connection marked 'COMPUTER' of the 

Reader/Writer. 
2. Plug the opposite end of the cable into the printer port of the computer, marked 'LPT1', 

'LPT2' or 'Printer'. 
3. Plug the AC Power Supply into the socket on the side of the Reader/Writer and into the 

power source. Note: only use the power supply that comes with your Reader/Writer kit. 
4. Plug the Dongle (with the Code Key securely in place if it is not a VIP System dongle) 

into the connection marked 'DONGLE' on the Reader/Writer. 



5. To read or write an embroidery card, flip the silver switch on the front of the 
Reader/Writer to the right (towards the card slot). For all other functions, flip the silver 
switch to the left. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 



Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 



[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

D01 Error message "Reader/Writer not found" 

For all Reader/Writers, check the following: 
• The Reader/Writer Unit is connected correctly to the computer. Ensure the connection is 

not loose. 
• You are using the power supply that was provided with your Reader/Writer Unit. 
• The power supply is switched on and connected to the Reader/Writer Unit. 
If you have a parallel Reader/Writer, also check the following: 
• The switch on the Reader/Writer Unit is set to 'Card', not 'Dongle' or 'Printer'. 
• If you are using an external Zip Drive, see FAQ #A13 for special instructions. 
• If you have a dongle in your LPT and your Reader/Writer Unit plugged into that, then 

remove it and place into the Dongle port of the Reader/Writer Unit. 
• If you have other items plugged into your LPT port then remove them and try again. If 

this works then your other hardware can be at fault, or it may be your cable is passing a 
weak signal. 

• Try running your computer in Safe Mode. If this works then it is likely to be another 
device's driver is accessing your printer port and preventing the Reader/Writer from 
working. See FAQ #A10 for more information. 

Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 



D02 Error message "No card inserted"? 

You have no card inserted in the Reader/Writer, or it is not inserted correctly. 

D03 Error message "Cannot write to card" 

This message appears if a read-only design card (from the Embroidery Library) is inserted in 
the Reader/ Writer; replace with a programmable card. It may also appear if the 
programmable card is defective or if a card is pulled out of the Reader/Writer during the 
writing process. 

D04 Error message "Cannot erase the card" 

The card is not erasable. Can appear if a card is pulled out of the Reader/Writer during the 
erasing process. 

D05 Error message "No LPT port available" 

The software may be corrupt; try uninstalling and reinstalling your Husqvarna Embroidery 
Customizing System. This message may also appear if another device driver is accessing 
the printer port. See FAQ #A10 on general difficulties with hardware and software for more 
information. 
Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 
This error message is only applicable to the parallel Reader/Writer. 

D06 Error message "Too many designs for memory card; only room for x 
designs" 

If there are more designs on the Reader/Writer screen than will fit on a card, this message 
appears when you select Write Memory Card. The number of designs that can fit IN 
SEQUENCE from the top left is listed. Delete designs as required, but unless these are 
chosen from the bottom of the Reader/Writer screen the number of designs can only be a 
guideline, as it is an approximation related to the type of stitches in each design. The other 
designs on the card will be 'reshuffled' so there are no empty spaces. 

D07 Error message "Data on card is corrupt; redo" 

This message may appear if a card has been pulled out of the Reader/Writer during the 
reading process. Try reading the card again. 

D10 Error message "Not enough memory for Reader/Writer routine" 

Try closing other programs. If the message still appear, contact your computer dealer for 
more information on configuring your computer. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 



L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 



1. On the original CD find the ".ini" file corresponding to the program; it has the same name 
as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

D14 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Reader/Writer Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons are only highlighted once a stitch file is shown on the VIP Reader/Writer 
screen. The menu icons (Second Menu, Third Menu and so on) in the Card Toolbar are only 
highlighted if the Read Card feature has been used to read in an Embroidery Card with more 
than 35 Stitch Files. 

D15 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons: 
1. Close the program. 
2. You now need to find the relevant .ini file on your program CD. If you have a parallel 

Reader/Writer on Windows 95, 98 or ME, you will need VIPReadWrite.ini. If you have a 
parallel Reader/Writer on Windows NT, 2000 or XP, you will need VIPReadWriteNT.ini. If 
you have a USB Reader/Writer you will VIPReadWriteUSB.ini. 

3. Copy the .ini file from the root folder of your CD. (If your VIP software was installed from 
a multi-language CD, you will find the .ini file in the relevant language folder. For 
instance, if you installed the English version of the software, you will find the .ini file in the 
"English" folder.) 

4. Paste it into the \Windows folder of your computer's hard drive. 
5. Right-click the pasted VIPReadWrite.ini file and select the Properties option from the 

popup menu. 
6. In the Properties dialog, un-check the Read Only check box and click OK. 
7. You can now restart the program and all the toolbars will be in their original positions. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 



Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A11 How do I set up my parallel Reader/Writer Unit and parallel Dongle? 

To set up a parallel Reader/Writer Unit and a parallel Dongle, do the following: 
1. Place one end of the cable into the connection marked 'COMPUTER' of the 

Reader/Writer. 
2. Plug the opposite end of the cable into the printer port of the computer, marked 'LPT1', 

'LPT2' or 'Printer'. 
3. Plug the AC Power Supply into the socket on the side of the Reader/Writer and into the 

power source. Note: only use the power supply that comes with your Reader/Writer kit. 
4. Plug the Dongle (with the Code Key securely in place if it is not a VIP System dongle) 

into the connection marked 'DONGLE' on the Reader/Writer. 
5. To read or write an embroidery card, flip the silver switch on the front of the 

Reader/Writer to the right (towards the card slot). For all other functions, flip the silver 
switch to the left. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 



However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 



Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A13 Are there special instructions for installing my external Zip drive? 

This only applies if you have a parallel Reader/Writer and want to use an external Zip drive 
that connects to a parallel printer port (LPT). 
A parallel Zip drive should always be connected directly to the computer's printer port and 
the switch box connected to the zip drive's out connector. The Zip drive's cable must be kept 
as short as possible or you will get data corruption. Also the length of the cable from the Zip 
drive to the switch box and from the switch box to the Reader/Writer must be as short as 
possible. Ideally the total length of the cable from the back of the computer to the 
Reader/Writer should not exceed 2 meters. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 



D08 The designs on my programmable card have gone corrupt and I can no 
longer use it 

Check first that both your Embroidery Machine and Reader/Writer Unit are reading your 
cards correctly. Insert a pre-programmed card, such as Embroidery Card 1, and try to read 
that. If that works then try to erase your faulty programmable card. Do this by inserting the 
card into the Reader/Writer Unit and run the Reader/Writer software. Do not open any 
designs, but click 'Send to Card'; this will remove any data on your card and leaves it totally 
blank. If you have tried this and your card still doesn't work you require another card. If you 
are within the 90 day warranty period, you may return it to your dealer and get it exchanged. 
A handy hint is to always label your programmable cards, maybe with the date you bought 
them, or with different colored stickers. This makes it easier to trace a faulty card. 
Also ensure that you are using the correct type of programmable card with your 
Reader/Writer unit. The USB Reader/Writer can read from all programmable cards, but they 
can only write to Programmable 512 cards. The Parallel Reader/Writer can only use 
Programmable cards (that is, cards that do not have "512" on them). 

D09 The design names do not show on my catalog printouts 

This is because the required font is not on the computer. The fonts used in the Husqvarna 
system are all standard computer fonts; however it is possible for the user to delete them 
from the system. The font used in the printout from Reader/Writer Pro the font is Courier. 
This should be found in the Windows\Fonts directory, file name coure.fon. 

D10 Error message "Not enough memory for Reader/Writer routine" 

Try closing other programs. If the message still appear, contact your computer dealer for 
more information on configuring your computer. 

D17 I can’t use my programmable card properly with my Reader/Writer unit. 
There are now two Reader/Writer units: Parallel and USB. The USB Reader/Writer is 
provided with a 512kB Programmable Embroidery Card, and additional 512kB 
Programmable Embroidery Cards can be bought separately. The USB Reader/Writer can 
readfrom any Embroidery Card, including the smaller Programmable Embroidery Cards, but 
it can only write(save designs) to a 512kB Programmable Embroidery Card. A Parallel 
Reader/Writer may not use 512kB Programmable Embroidery Cards. 

D18 I have installed a USB Reader/Writer using the download from the 
Husqvarna Viking Software web site, but the program always says 
“Reader/Writer not found” when I try to use it. 

Please ensure that you have a USB Reader/Writer unit, and not a Parallel Reader/Writer 
unit. If you download and install the driver for the USB Reader/Writer, the driver will not work 
with the parallel unit. 
You have not installed the drivers for the USB Reader/Writer, even though you have installed 
the Reader/Writer software. Use the following procedure to get the USB Reader/Writer 
working: 
1. Disconnect your USB Reader/Writer unit from your computer. 
2. Close any programs you are using and restart your computer. 
3. When your computer has started up, connect your USB Reader/Writer unit to your 

computer. When you do this, the computer should automatically detect that you have 



attached a new USB hardware device. It will then ask you to install the drivers. (If your 
computer does not automatically ask you to install the drivers, then you must initiate a 
hardware search manually. Do this by going to the Control Panel and starting the Add 
New Hardware wizard. Let the wizard search for hardware, and you should be asked to 
install the USB Reader/Writer drivers.) 

4. Select the option that allows you to select a specific location for the drivers. You will then 
be given a set of choices of where to search for the drivers. 

5. In the box where you can enter you own location, enter “C:\VipEmbroidery\Temp”. Also 
make sure that the checkbox that tells the wizard to use this location is checked. 

6. Continue with the wizard and the USB Reader/Writer drivers will be installed. You should 
now be able to use your USB Reader/Writer. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 



• Floppy disk operations were not possible within the software or within Windows Explorer, 
so it was not possible to read or write disks in VIP Disk Manager. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 



B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

D13 Error message "Stitch file too big for hoop" 

This message appears if the Stitch File you are trying to load onto the VIP Reader/Writer 
screen is larger than the dimensions that will fit in the standard Husqvarna hoop 
(100x100mm). 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

Printing 

A12 How do I connect my printer to the parallel Reader/Writer? 

Do not plug a printer into the parallel Reader/Writer, even if is says 'Printer' on it. It does not 
act as a switch-box and printer signals, which aren't blocked, may travel through and 
compromise your embroidery cards. Instead you must use one of the following options: 
• Disconnect the Reader/Writer cable when printing. 



• Connect a switch-box to the computer, and attach both the printer and Reader/Writer to 
this. Ensure that this switch-box is manual, for parallel connections, is bi-directional and 
has a cable no more than 6 feet long. 

• Install an extra Parallel (LPT) Port into your computer, and use the Reader/Writer on this. 
We highly recommend installation of a second printer port if the following printer drivers are 
installed on your system: Hewlett Packard 660 or above and the Lexmark WinWriter series. 

D09 The design names do not show on my catalog printouts 

This is because the required font is not on the computer. The fonts used in the Husqvarna 
system are all standard computer fonts; however it is possible for the user to delete them 
from the system. The font used in the printout from Reader/Writer Pro the font is Courier. 
This should be found in the Windows\Fonts directory, file name coure.fon. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 



• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 
checked 

Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 



For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 



2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 



If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Reading from a Card 

D01 Error message "Reader/Writer not found" 

For all Reader/Writers, check the following: 
• The Reader/Writer Unit is connected correctly to the computer. Ensure the connection is 

not loose. 
• You are using the power supply that was provided with your Reader/Writer Unit. 
• The power supply is switched on and connected to the Reader/Writer Unit. 
If you have a parallel Reader/Writer, also check the following: 
• The switch on the Reader/Writer Unit is set to 'Card', not 'Dongle' or 'Printer'. 
• If you are using an external Zip Drive, see FAQ #A13 for special instructions. 
• If you have a dongle in your LPT and your Reader/Writer Unit plugged into that, then 

remove it and place into the Dongle port of the Reader/Writer Unit. 
• If you have other items plugged into your LPT port then remove them and try again. If 

this works then your other hardware can be at fault, or it may be your cable is passing a 
weak signal. 

• Try running your computer in Safe Mode. If this works then it is likely to be another 
device's driver is accessing your printer port and preventing the Reader/Writer from 
working. See FAQ #A10 for more information. 

Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 

D02 Error message "No card inserted"? 

You have no card inserted in the Reader/Writer, or it is not inserted correctly. 

D05 Error message "No LPT port available" 

The software may be corrupt; try uninstalling and reinstalling your Husqvarna Embroidery 
Customizing System. This message may also appear if another device driver is accessing 
the printer port. See FAQ #A10 on general difficulties with hardware and software for more 
information. 
Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 
This error message is only applicable to the parallel Reader/Writer. 

D07 Error message "Data on card is corrupt; redo" 



This message may appear if a card has been pulled out of the Reader/Writer during the 
reading process. Try reading the card again. 

D08 The designs on my programmable card have gone corrupt and I can no 
longer use it 

Check first that both your Embroidery Machine and Reader/Writer Unit are reading your 
cards correctly. Insert a pre-programmed card, such as Embroidery Card 1, and try to read 
that. If that works then try to erase your faulty programmable card. Do this by inserting the 
card into the Reader/Writer Unit and run the Reader/Writer software. Do not open any 
designs, but click 'Send to Card'; this will remove any data on your card and leaves it totally 
blank. If you have tried this and your card still doesn't work you require another card. If you 
are within the 90 day warranty period, you may return it to your dealer and get it exchanged. 
A handy hint is to always label your programmable cards, maybe with the date you bought 
them, or with different colored stickers. This makes it easier to trace a faulty card. 
Also ensure that you are using the correct type of programmable card with your 
Reader/Writer unit. The USB Reader/Writer can read from all programmable cards, but they 
can only write to Programmable 512 cards. The Parallel Reader/Writer can only use 
Programmable cards (that is, cards that do not have "512" on them). 

D12 How do I read the designs from Embroidery Card 21? 

Embroidery Card 21 is a special embroidery card designed specifically for users who wish to 
create lettering without the use of a computer. It does not store designs in the same way that 
other cards do and therefore cannot be read back into the computer via the reader/writer 
unit. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Screen Appearance 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 



Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

D14 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Reader/Writer Program 

Certain Main Toolbar icons (Save As, Multi-Save and Quick 3DStitch™ View) and all Edit 
Toolbar icons are only highlighted once a stitch file is shown on the VIP Reader/Writer 
screen. The menu icons (Second Menu, Third Menu and so on) in the Card Toolbar are only 
highlighted if the Read Card feature has been used to read in an Embroidery Card with more 
than 35 Stitch Files. 

D15 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons: 
1. Close the program. 
2. You now need to find the relevant .ini file on your program CD. If you have a parallel 

Reader/Writer on Windows 95, 98 or ME, you will need VIPReadWrite.ini. If you have a 
parallel Reader/Writer on Windows NT, 2000 or XP, you will need VIPReadWriteNT.ini. If 
you have a USB Reader/Writer you will VIPReadWriteUSB.ini. 

3. Copy the .ini file from the root folder of your CD. (If your VIP software was installed from 
a multi-language CD, you will find the .ini file in the relevant language folder. For 
instance, if you installed the English version of the software, you will find the .ini file in the 
"English" folder.) 

4. Paste it into the \Windows folder of your computer's hard drive. 
5. Right-click the pasted VIPReadWrite.ini file and select the Properties option from the 

popup menu. 
6. In the Properties dialog, un-check the Read Only check box and click OK. 
7. You can now restart the program and all the toolbars will be in their original positions. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

Setting up the Reader/Writer Unit 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 



3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A11 How do I set up my parallel Reader/Writer Unit and parallel Dongle? 

To set up a parallel Reader/Writer Unit and a parallel Dongle, do the following: 
1. Place one end of the cable into the connection marked 'COMPUTER' of the 

Reader/Writer. 
2. Plug the opposite end of the cable into the printer port of the computer, marked 'LPT1', 

'LPT2' or 'Printer'. 
3. Plug the AC Power Supply into the socket on the side of the Reader/Writer and into the 

power source. Note: only use the power supply that comes with your Reader/Writer kit. 
4. Plug the Dongle (with the Code Key securely in place if it is not a VIP System dongle) 

into the connection marked 'DONGLE' on the Reader/Writer. 
5. To read or write an embroidery card, flip the silver switch on the front of the 

Reader/Writer to the right (towards the card slot). For all other functions, flip the silver 
switch to the left. 

A12 How do I connect my printer to the parallel Reader/Writer? 

Do not plug a printer into the parallel Reader/Writer, even if is says 'Printer' on it. It does not 
act as a switch-box and printer signals, which aren't blocked, may travel through and 
compromise your embroidery cards. Instead you must use one of the following options: 
• Disconnect the Reader/Writer cable when printing. 
• Connect a switch-box to the computer, and attach both the printer and Reader/Writer to 

this. Ensure that this switch-box is manual, for parallel connections, is bi-directional and 
has a cable no more than 6 feet long. 

• Install an extra Parallel (LPT) Port into your computer, and use the Reader/Writer on this. 
We highly recommend installation of a second printer port if the following printer drivers are 
installed on your system: Hewlett Packard 660 or above and the Lexmark WinWriter series. 

A13 Are there special instructions for installing my external Zip drive? 

This only applies if you have a parallel Reader/Writer and want to use an external Zip drive 
that connects to a parallel printer port (LPT). 
A parallel Zip drive should always be connected directly to the computer's printer port and 
the switch box connected to the zip drive's out connector. The Zip drive's cable must be kept 
as short as possible or you will get data corruption. Also the length of the cable from the Zip 
drive to the switch box and from the switch box to the Reader/Writer must be as short as 
possible. Ideally the total length of the cable from the back of the computer to the 
Reader/Writer should not exceed 2 meters. 

D01 Error message "Reader/Writer not found" 

For all Reader/Writers, check the following: 
• The Reader/Writer Unit is connected correctly to the computer. Ensure the connection is 

not loose. 
• You are using the power supply that was provided with your Reader/Writer Unit. 



• The power supply is switched on and connected to the Reader/Writer Unit. 
If you have a parallel Reader/Writer, also check the following: 
• The switch on the Reader/Writer Unit is set to 'Card', not 'Dongle' or 'Printer'. 
• If you are using an external Zip Drive, see FAQ #A13 for special instructions. 
• If you have a dongle in your LPT and your Reader/Writer Unit plugged into that, then 

remove it and place into the Dongle port of the Reader/Writer Unit. 
• If you have other items plugged into your LPT port then remove them and try again. If 

this works then your other hardware can be at fault, or it may be your cable is passing a 
weak signal. 

• Try running your computer in Safe Mode. If this works then it is likely to be another 
device's driver is accessing your printer port and preventing the Reader/Writer from 
working. See FAQ #A10 for more information. 

Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 

D05 Error message "No LPT port available" 

The software may be corrupt; try uninstalling and reinstalling your Husqvarna Embroidery 
Customizing System. This message may also appear if another device driver is accessing 
the printer port. See FAQ #A10 on general difficulties with hardware and software for more 
information. 
Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 
This error message is only applicable to the parallel Reader/Writer. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Writing to a Card 

D01 Error message "Reader/Writer not found" 

For all Reader/Writers, check the following: 
• The Reader/Writer Unit is connected correctly to the computer. Ensure the connection is 

not loose. 
• You are using the power supply that was provided with your Reader/Writer Unit. 
• The power supply is switched on and connected to the Reader/Writer Unit. 
If you have a parallel Reader/Writer, also check the following: 
• The switch on the Reader/Writer Unit is set to 'Card', not 'Dongle' or 'Printer'. 
• If you are using an external Zip Drive, see FAQ #A13 for special instructions. 



• If you have a dongle in your LPT and your Reader/Writer Unit plugged into that, then 
remove it and place into the Dongle port of the Reader/Writer Unit. 

• If you have other items plugged into your LPT port then remove them and try again. If 
this works then your other hardware can be at fault, or it may be your cable is passing a 
weak signal. 

• Try running your computer in Safe Mode. If this works then it is likely to be another 
device's driver is accessing your printer port and preventing the Reader/Writer from 
working. See FAQ #A10 for more information. 

Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 

D02 Error message "No card inserted"? 

You have no card inserted in the Reader/Writer, or it is not inserted correctly. 

D03 Error message "Cannot write to card" 

This message appears if a read-only design card (from the Embroidery Library) is inserted in 
the Reader/ Writer; replace with a programmable card. It may also appear if the 
programmable card is defective or if a card is pulled out of the Reader/Writer during the 
writing process. 

D04 Error message "Cannot erase the card" 

The card is not erasable. Can appear if a card is pulled out of the Reader/Writer during the 
erasing process. 

D05 Error message "No LPT port available" 

The software may be corrupt; try uninstalling and reinstalling your Husqvarna Embroidery 
Customizing System. This message may also appear if another device driver is accessing 
the printer port. See FAQ #A10 on general difficulties with hardware and software for more 
information. 
Please note that if problems persist then we recommend the use of a bi-directional switch 
box, or installing a second LPT port on your computer. For users of a Hewlett Packard 660 
(or above) or a Lexmark Winwriter series printer, we highly recommend installing a second 
printer port. 
This error message is only applicable to the parallel Reader/Writer. 

D06 Error message "Too many designs for memory card; only room for x 
designs" 

If there are more designs on the Reader/Writer screen than will fit on a card, this message 
appears when you select Write Memory Card. The number of designs that can fit IN 
SEQUENCE from the top left is listed. Delete designs as required, but unless these are 
chosen from the bottom of the Reader/Writer screen the number of designs can only be a 
guideline, as it is an approximation related to the type of stitches in each design. The other 
designs on the card will be 'reshuffled' so there are no empty spaces. 



D07 Error message "Data on card is corrupt; redo" 

This message may appear if a card has been pulled out of the Reader/Writer during the 
reading process. Try reading the card again. 

D08 The designs on my programmable card have gone corrupt and I can no 
longer use it 

Check first that both your Embroidery Machine and Reader/Writer Unit are reading your 
cards correctly. Insert a pre-programmed card, such as Embroidery Card 1, and try to read 
that. If that works then try to erase your faulty programmable card. Do this by inserting the 
card into the Reader/Writer Unit and run the Reader/Writer software. Do not open any 
designs, but click 'Send to Card'; this will remove any data on your card and leaves it totally 
blank. If you have tried this and your card still doesn't work you require another card. If you 
are within the 90 day warranty period, you may return it to your dealer and get it exchanged. 
A handy hint is to always label your programmable cards, maybe with the date you bought 
them, or with different colored stickers. This makes it easier to trace a faulty card. 
Also ensure that you are using the correct type of programmable card with your 
Reader/Writer unit. The USB Reader/Writer can read from all programmable cards, but they 
can only write to Programmable 512 cards. The Parallel Reader/Writer can only use 
Programmable cards (that is, cards that do not have "512" on them). 

D11 How do I write the designs from a Plus Embroidery Disk (e.g. Cards 15, 18 
& 20) to my programmable card? 

The numbering system for the Plus Embroidery Disks are as follows (using Card 18 as an 
example): 
• Design 1, Position 1 - des18101.hus 
• Design 1, Position 2 - des18201.hus 
• Design 1, Position 3 - des18301.hus 
 
Design 2, Position 1 - des18102.hus 
Design 2, Position 2 - des18202.hus 
Design 2, Position 3 - des18302.hus 
• Design 3, etc... 
The "18" designates Embroidery Disk 18, the following digit indicates the position number 
(P1, P2 or P3), the last two digits (01, 02, 03… 32, 33, 34) indicates the design number as 
indicated on the included booklet. Each section of the design is written to the card as a 
separate design. Once the sections are written to the Embroidery Card, all that is needed is 
for the hoop to be moved into the correct position to sew each section of the design. 

Digitizing 
Listed versions: Windows 95, version 4.0; Windows 95, version 4.1; Windows 95, version 4.11; Windows 95, 
version 4.21; Pro, system 2.1; System 5, version 5.0; System 5, version 5.1; VIP, version 6.0; VIP, version 
6.1; Pro System 5, version 5.0; VIP, version 6.2 



3D Create Stitches 

F18 When I Create Stitches I get the error 'Unable to find start point inside fill 
object. Re-edit' 

When a QuickStitch™ Fill is created it is given a start point inside the fill area. If the area is 
very small or thin, the program may be unable to Create Stitches because it cannot find the 
start point. Try clicking on the area and moving the first point. 

F29 Nothing appears when I try to use 3D Create Stitches. 
Your screen colors must be set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. If problems persist see 
FAQ #M12. 
If you are unable to save your stitch file using 3D Create Stitches then use the Create 
Stitches option from the View menu. 

F37 The size of my Design in the 3D Create Stitches dialog box is not the same 
as the figure I entered 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

F38 When I Create Stitches one of my fill areas doesn't fill completely with 
stitches 

Try changing the angle of orientation. Even one degree can be enough to allow the artificial 
intelligence of the program to fill the object. Another possibility is to move the start point 
slightly. 

F50 My computer takes a long time to draw the stitches when I do 3D Create 
Stitches 

There are two main reasons for this. The computer may relatively slow. In this case you can 
use the Create Stitches option from the View menu to be able to save your design in stitch 
format. Alternatively, the drivers for your graphics card are not up to date, for which you 
should download the latest version and try again. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If problems persist see FAQ #M10. 

F52 I wish to change the background color for 3D Create Stitches 



Use VIP Configure to alter the background color for 3D Create Stitches. This program may 
also be used to turn the texture on or off. 

F61 Error "Cannot create stitches." 

This error will occur if you attempt to use 3D Create Stitches or Create Stitches before you 
have placed any objects in your design. The minimum requirement is one object of any type. 

F62 Error "Fill object is too complicated." 

Appears if a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation 
functions. Try changing the angle by as little as one degree. This often lets the shape fill 
correctly. Another option is to try moving the start point of the fill area. 

F63 Error "No stitch data to save." 

This message appears if you try to use the Save function when there is no stitch information 
to save from 3D Create Stitches or Create Stitches (such as when there are only jump 
stitches in the design). 

F76 Error "VipDigitizing.e.exe has generated errors and will be closed by 
Windows. You will need to restart the program. An error log is being 
created." 

This error message only appears when you attempt to save a design or view a design with 
3D Create Stitches on a Windows 2000 computer. 
This issue is fixed by applying the latest Windows 2000 Service Pack, followed by all 
available Critical Updates. The latest Windows 2000 Service Pack and Critical Updates can 
be found at the Microsoft Windows 2000 [http://www.microsoft.com/windows2000] web site. 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 



M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Background Image 

F02 When I load my Design File, I get an error message that the PCX or BMP 
can not be found 

If you get a message that the PCX or BMP background picture can not be found, then 
chances are that you have moved the original picture to a different location. The program 
saves the location of the picture with the CAN file so you must replace the picture. Either 
replace the picture back into its original folder (the error messages defines where it should 
be), or you can 're-load' the picture: Go to 'File' and then 'Load Picture'. At that point tell the 
program where the picture is and it will load. Then click on the 'Save As' icon, (the Floppy 
Disk icon) and the new location will be saved with the CAN file. 

F03 What DPI setting should I use to scan a image for digitizing? 

The correct DPI (dots per inch) setting will depend on the size of the image to be scanned. 
The desired size for the digitizing is approximately 1000 X 1000 pixels. To achieve this take 
the size of your artwork in inches e.g 8" x 7" and divide the longest side into 1000 e.g. 1000 
divided by 8 = 125. The DPI setting of the scanner should then be 125 DPI to produce an 
image that is 1000 x 875. 

F04 Tips on using Stippled Areas and QuickStitch™ 



A stippled area, otherwise known as dithered or patterned area, is an area of one shade of 
color, which has actually been created using two other combined colors. For example mixing 
blocks of black and white can create gray. 

 
Stippled area, close-up 

 
This type of color shading is used regularly in clip-art, especially in old pictures, before 24-
color was regularly used. It is not always possible to see if the area is stippled even when 
magnified, as the picture may have been made in 16 million colors and the stippling created 
with two very close shades of a color. 
In Digitizing 95 the QuickStitch™ function will only work with areas of solid color. If a stippled 
area is selected no fill the function cannot detect a solid area. This causes the warning 
message "Unable to find start point, re-edit " when Create Stitches is selected. Digitizing Pro 
has QuickStitch II™ which can recognize areas of stippled colors. It does not have this 
limitation. 
If no outline appears around the fill area, and the above warning message occurs, you can 
confirm it is a stippling limitation by doing the following: 
1. Load the bitmap picture into MS Paint (The Paint Program supplied with Windows'95). 

This program has the same limitation of being unable to recognize areas of stippled 
colors. 

2. Select a color contrasting to the color of the suspect area. 
3. Select the 'Fill With Color' tool (Paint Bucket). 
4. Click in the area. 
5. If a dot, or small patch, appears then this area is stippled. 
6. If the entire area changes color, then it is not stippled and will work with QuickStitch. 
There are several ways to get round this limitation: 
1. Upgrade to Digitizing Pro. 
2. Digitize the area using FreeHand™ fill. 
3. If you have the original clip-art picture in a vector image file (such as .wmf or .cdr) then 

take it into a vector imaging package, for example Corel Draw, and chose a color for this 
area which you know is not stippled. 

4. Some paint packages do not have the stippling limitation that MS Paint has, for example 
Paint Shop Pro. If you load the bitmap into this package and fill an area using a flood fill 
tolerance of 1, a stippled area will become one solid color block. Reduce the amount of 
colors in the picture. Beware, though this may reduce stippled areas to just one color, but 
it can cause other areas to become stippled. 

F05 I loaded a small picture, and it has too many jagged lines 

Resize the image to make it more suitable for digitizing. See Loading a Picture: Optimizing 
Pictures in Help or User's Guide 

F06 The background image shows more of the picture than I want to digitize 

Crop the picture to show exactly what is desired. See Loading a Picture: Optimizing Pictures 
in Help or User's Guide. Alternatively, place the Start Point at the center of the desired part 



of the picture. The sewing machine will start stitching from this point, which will be at the 
center of the hoop 

F07 The background image is too bright to digitize over comfortably 

Dim the image to more restful colors (or try changing background color under Edit Menu, 
Preferences, Screen). See Loading a Picture: Optimizing Pictures in Help or User's Guide 

F08 My picture is not in the center of the screen. How can I move it? 

You can move it by centering it and saving it using the software that created the image such 
as Windows® Paint, but it is not really necessary to do so. Place the first jump in the center 
of the image. When you create stitches, the design will be saved in the center position. 

F09 Tips on using the Outline Thinner tool 
It is important where you click after selecting the Outline Thinner tool. The color you click on 
is the color that will be thinned. So if you click on a black outline, this outline will be thinned. 
Alternatively if you click on an area (such as white on a black and white drawing), this area 
will be thinned and the outline around it will be thickened to compensate. This leaves the 
drawing indistinguishable from the original. 
The Outline Thinner tool may not work if your picture has dithering, such as a scanned image 
or one that has been converted from a JPEG file. These pictures have additional colored 
pixels that can affect the result. 
As the picture is not saved after it is modified, you can return to the original by saving your 
CAN file, clicking new, then re-opening it. 

F33 I loaded a small picture, and it has too many jagged lines 

Although the program automatically doubles the size of an image if its height and width are 
less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan the 
image 

F34 The background image shows more of the picture than I want to digitize. 
Use the Design Area command to select the part of the picture you wish to digitize. 
Alternatively, in the Picture Window select the part of the Picture you want with Rectangle or 
Freehand Select then Crop the Picture (you can only do this before you start Digitizing). 

F35 The background image has a thick outline so that QuickStitch™ Fill leaves 
gaps between color areas 

Use the Outline Thinner to narrow the outline to one pixel. This will allow areas to join 
together better. 

F54 On opening a Design the background image is not loaded. 
This may happen if you are loading a Design Outline File from Embroidery System 5. If the 
original picture is moved to a different drive or folder from where the Design File was 
created, the program is unable to locate it. When you open the Design File a warning 
message appears showing where the picture should be stored. Find the picture and replace 
it in the original folder, click New Design, then reload the Design File. Alternatively, start your 



Embroidery System 5 Digitizing, click Load Picture and browse through the folders of your 
computer until you locate the picture. It may be loaded from the new location. After saving 
the Design File from Embroidery System 5 then load and save the Design Outline File in VIP 
Digitizing so that the image is saved as part of the Design. 

F73 Creating MiniPics for the VIP Digititizing program 

Before Starting 
An appropriate image editing package, such as Jasc® Paint Shop Pro, is required that will 
save .ras format, as well as a good knowledge of working with graphic files. 
About MiniPics 
Create Medium MiniPics at 400x400 pixels, and Small MiniPics at 250x250 pixels. 
The color palette can be 256 colors or more. 
White is treated as transparent when you load a MiniPic into VIP Digitizing, so anything 
underneath the white part of a MiniPic will show through. If you want an area to be white in 
your MiniPic, use a “false white” such as very pale yellow, then change it to white with the 
Flood Fill tool in the Picture Window of VIP Digitizing. 
It is recommended that you create a new folder for saving your own MinPics, for instance: 
C:\VipEmbroidery\MyDesigns\MyMiniPics. 
How To Make a MiniPic 
1. Use an existing image:Open an existing image; Either crop around the required area or 

resize the whole image to the size of a Medium or Small MiniPic. 
2. Or, create a new MiniPic from scratch:Start a new image and set it to the size of either 

a medium (400x400 pixels) or small (250x250 pixels) MiniPic; Use the drawing tools in 
the graphic package to create the desired image for the MiniPic. 

3. Ensure that the colors are solid color areas. See the existing MiniPics for examples. 
4. Save the file in Sun Raster Image format with the “.ras” extension. 
5. Start Windows® Explorer and browse to the folder where you saved the “.ras” file. 
6. Click on the file to highlight it. 
7. Right-click to bring up a popup menu, and select the Rename option from the menu. 
8. Edit the file name to change the extension from “.ras” to “.axw” and press Enter. 
9. You will be warned about changing the file extension and asked if you want to continue. 
10. Click Yes and the change to the file extension will be saved. 
11. Start VIP Digitizing and click the MiniPics icon so that the MiniPics Viewer appears. 
12. Click the button with three dots at the end of the Directory Browser box so that the 

Browse For Folder dialog appears. 
13. Browse to the directory where you saved your new MiniPic and click OK. 
14. The MiniPics View will show your new MiniPic, along with any MiniPics you have already 

created. 
15. Click the MiniPic and it will be used in the Picture. 

F77 Tips on using the Outline Thinner tool 
It is important where you click after selecting the Outline Thinner tool. The color you click on 
is the color that will be thinned. So if you click on a black outline, this outline will be thinned. 
Alternatively if you click on an area (such as white on a black and white drawing), this area 
will be thinned and the outline around it will be thickened to compensate. This leaves the 
drawing indistinguishable from the original. 
The Outline Thinner tool may not work if your picture has dithering, such as a scanned image 
or one that has been converted from a JPEG file. These pictures have additional colored 
pixels that can affect the result. 



R15 The picture does not redraw fully as I move around the image or work with 
dialog boxes. 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

Creating and Editing Designs 

F07 The background image is too bright to digitize over comfortably 

Dim the image to more restful colors (or try changing background color under Edit Menu, 
Preferences, Screen). See Loading a Picture: Optimizing Pictures in Help or User's Guide 

F08 My picture is not in the center of the screen. How can I move it? 

You can move it by centering it and saving it using the software that created the image such 
as Windows® Paint, but it is not really necessary to do so. Place the first jump in the center 
of the image. When you create stitches, the design will be saved in the center position. 

F09 Tips on using the Outline Thinner tool 
It is important where you click after selecting the Outline Thinner tool. The color you click on 
is the color that will be thinned. So if you click on a black outline, this outline will be thinned. 
Alternatively if you click on an area (such as white on a black and white drawing), this area 



will be thinned and the outline around it will be thickened to compensate. This leaves the 
drawing indistinguishable from the original. 
The Outline Thinner tool may not work if your picture has dithering, such as a scanned image 
or one that has been converted from a JPEG file. These pictures have additional colored 
pixels that can affect the result. 
As the picture is not saved after it is modified, you can return to the original by saving your 
CAN file, clicking new, then re-opening it. 

F20 How do I test the creation of fill areas properly when my Design File is 
incomplete? 

Digitize a jump stitch from the center to each extremity of the Background Image when you 
begin digitizing. Then, every time you Create Stitches the stitch file will be sized in proportion 
to the final desired result. Alternatively Digitizing System 5 has a Design Area tool where the 
edges of the design are defined before digitizing. 

F23 I have finished Inserting new objects, but I can't get back to the end of the 
Design File 

Click the Insert Object icon again to deselect it and complete the insertion. A Jump Stitch is 
placed from where the new objects end to their insertion point. 

F24 If I try to move the start point of my Design File, there seems to be an extra 
point after the first Color command 

When the initial Jump Stitch or Single Stitch was digitized, its start and end points were both 
placed by clicking the mouse, rather than clicking and dragging. To solve, click on the extra 
object and Delete it. 

F25 Why do I have to start my design with a Jump Stitch? 

The first Jump Stitch is what determines the center of the design. Without the stitch, when 
you Create Stitches, the program will not know where the center is and will not be able to 
determine the final size of the design.  

F27 I had inserted a series of objects into my design, but when I stitched the 
design my tie stitches were in the wrong place. 

When QuickStitch Tie Stitches are inserted into an embroidery design in Digitizing, there is a 
slight problem that they all get placed at the end of the inserted section; even if they appear 
in the right place on the display. Use the left and right arrow keys to move through the 
objects of the design and you will see. 
You can remove these tie stitches and then insert them individually in the correct places. But 
to prevent this happening in the future, it may be easier to insert all your stitches without ties, 
and then insert the tie stitches individually afterwards. Alternatively, create tie stitches 
freehand using Single Stitch. 

F36 If I try to move the start point of my Design File, there seems to be an extra 
point after the first Color command 



When the initial Jump Stitch or Single Stitch was digitized, its start and end points were both 
placed by clicking the mouse, rather than clicking and dragging. To solve, click on the extra 
object and Delete it. 

F44 I am starting a new Design and can't change the first color 
The first color can only be changed in the Edit window. Go to the Edit Window and click the 
first color in the color palette, then select the color you want to start with. Alternatively, simply 
mark out your Design Area and add a Color Change command. Then when you come to 
stitch out your design simply ignore the first color as it is entirely composed of jump stitches 
and has no effect on the design. 

F45 I have finished Inserting new objects, but I can't get back to the end of the 
Design File 

Click the Insert Object icon again to deselect it and complete the insertion. A Jump Stitch is 
placed from where the new objects end to their insertion point. 

F46 I am Inserting new objects but they have been added at the end of the 
design 

If you switch to the Edit or Picture Window while you are in Insert then Insert will be turned 
off and a Jump Stitch will be inserted to jump back to the next point in the design. When you 
return to the Create Window and create objects then you will Add them to the end of the 
design. You must reselect your Insert point and select Insert Objects again. The Status Bar 
in the Create Window shows whether you are using Add or Insert. 

F47 I am Inserting new objects but they are using the last thread color I 
selected, instead of the thread color that they should have, at the place 
where I am inserting 

This is a temporary effect that lasts only until you have finished inserting, that is when you 
switch back to Add or go to the Edit or Picture Window. If you insert a Color Change then the 
objects inserted after the Color Change will use the new color as usual. The objects before 
the Color Change will revert back to the correct color when you switch back to Add. 

F48 I can't see or edit a point under a Color Change or Stop Command 

You can turn off the markers for Color Change and Stop Commands. If you turn the markers 
off then you can see and select the point underneath. Turn off the markers by un-checking 
the Color or Stop Markers option in Screen Preferences. 

R15 The picture does not redraw fully as I move around the image or work with 
dialog boxes. 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 



1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

Creating Stitches 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 



2. Check the version number of your software. Digitizing version 4.11 (or above) has 
improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

F15 When I Create Stitches one of my fill areas doesn't fill completely with 
stitches 

Try changing the angle of orientation. Even one degree can be enough to allow the artificial 
intelligence of the program to fill the object. Another possibility is to move the start point 
slightly. 
The QuickStitch fill will find an area around the location where it was selected and fill it 
entirely, ignoring any sections or 'holes' inside the area. If the design that is to be filled has a 
hole in it, the design must be broken into separate areas around the hole, each section must 
be a solid area, or a area without a hole. The angle of the "break-up" lines should match the 
angle of the fill so that the stitches will blend into each other. 

 
Filling an area with holes 

 
This 0 should be filled in two sections, as divided, for a 45º fill. Dependent on the type of 
fabric that is being embroidered, a gap may be seen at the point at which the two areas 
meet. If so, edit the points of the area so that a overlap is created. 

F18 When I Create Stitches I get the error 'Unable to find start point inside fill 
object. Re-edit' 

When a QuickStitch™ Fill is created it is given a start point inside the fill area. If the area is 
very small or thin, the program may be unable to Create Stitches because it cannot find the 
start point. Try clicking on the area and moving the first point. 

F19 The size of my Design in the Create Stitches dialog box is not the same as 
the figure I entered 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. See Outputting Design Files, 
Setting Size in Help or User's Guide. 

F20 How do I test the creation of fill areas properly when my Design File is 
incomplete? 

Digitize a jump stitch from the center to each extremity of the Background Image when you 
begin digitizing. Then, every time you Create Stitches the stitch file will be sized in proportion 



to the final desired result. Alternatively Digitizing System 5 has a Design Area tool where the 
edges of the design are defined before digitizing. 

F21 I have created a design but some of the stitches are out of place 

You may have clicked Create Stitches, or saved your file while Insert Mode was on. This can 
lead to part of the stitch file being out of place, but doesn't show in the CAN file. Make sure 
the Insert Mode is off, then find the object where the design starts to go astray, and 
reposition it slightly. 

F22 When I Create Stitches, the message "Design Too Big to Save" comes up. 
What can I do? 

Be certain that the first stitch begins at the center of the design image. If the design is off-
center this could place it outside of the hoop. Also make sure that you have entered the right 
value for the selected dimension for the Size (from Preferences). For example, if you have 
entered a width of 99mm, and you have created a design taller than it is wide, then the 
height is going to be more than 100mm and will not fit inside a standard hoop. 

F37 The size of my Design in the 3D Create Stitches dialog box is not the same 
as the figure I entered 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

F61 Error "Cannot create stitches." 

This error will occur if you attempt to use 3D Create Stitches or Create Stitches before you 
have placed any objects in your design. The minimum requirement is one object of any type. 

F62 Error "Fill object is too complicated." 

Appears if a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation 
functions. Try changing the angle by as little as one degree. This often lets the shape fill 
correctly. Another option is to try moving the start point of the fill area. 

Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 



 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A15 I now have two dongles and two code keys, how do I set these up? 

Remove the code key from your oldest dongle and place it in the opposite side of your new 
dongle. If the black spacer is in the space then remove it with a screwdriver or coin. Use this 
new dongle as you had used your old one. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 



4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

F66 After attempting to start VIP Digitizing with no dongle attached I have lost 
some of my Preferences 

If you attempt to start VIP Digitizing with no dongle attached then you will get the error “No 
dongle attached. Cannot open program". When this happens, the VIPDigitizing.ini file in your 
windows folder (usually C:\Windows) is re-created with settings that are not the same as the 
installation defaults. Download VIPDigitizing.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_vipdig.ht
m] from the Husqvarna Viking Software web site and save it in the Windows folder. 

Error Messages 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 



 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 



Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

F01 What causes the message 'Design could not load BMP file:' or 'Design 
could not load PCX file:' 

This message appears if the picture file the program is trying to load is not actually a true 
BMP or PCX file. It may have corrupted, so that although the file extension is correct, the file 
format is not, or it could be a PCX file with more than 256 colors, or that was exported from 
Corel Draw with compression turned on. To check, try loading the picture in the 
Windows®95 Paint program. Click Start, Programs, Accessories, Paint, then open the file. If 
it opens correctly, try to save it again (it will be saved as a BMP) and reload into the 
Digitizing Program. If not, you know that the picture is corrupt. 

F02 When I load my Design File, I get an error message that the PCX or BMP 
can not be found 

If you get a message that the PCX or BMP background picture can not be found, then 
chances are that you have moved the original picture to a different location. The program 
saves the location of the picture with the CAN file so you must replace the picture. Either 
replace the picture back into its original folder (the error messages defines where it should 
be), or you can 're-load' the picture: Go to 'File' and then 'Load Picture'. At that point tell the 
program where the picture is and it will load. Then click on the 'Save As' icon, (the Floppy 
Disk icon) and the new location will be saved with the CAN file. 



F10 Why would this message appear: 'Fill object is too complicated' 
If a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation functions. 
Try changing the angle by as little as one degree. This often lets the shape fill correctly. 
Another option is to try moving the start point of the fill area. 

F11 When I try QuickStitch™ Fill on any background, including those with the 
software package, I get an error message 'Unable to find start point.' 

Some graphic drivers are incompatible with QuickStitch Fill, test to see if you get the same 
results with more, or less, colors in your Desktop Properties. Alternatively install the latest 
drivers for your graphics card. 

F18 When I Create Stitches I get the error 'Unable to find start point inside fill 
object. Re-edit' 

When a QuickStitch™ Fill is created it is given a start point inside the fill area. If the area is 
very small or thin, the program may be unable to Create Stitches because it cannot find the 
start point. Try clicking on the area and moving the first point. 

F22 When I Create Stitches, the message "Design Too Big to Save" comes up. 
What can I do? 

Be certain that the first stitch begins at the center of the design image. If the design is off-
center this could place it outside of the hoop. Also make sure that you have entered the right 
value for the selected dimension for the Size (from Preferences). For example, if you have 
entered a width of 99mm, and you have created a design taller than it is wide, then the 
height is going to be more than 100mm and will not fit inside a standard hoop. 

F53 Error "Design File is read-only. Cannot continue." 

This will happen if you attempt to open a design that has been set as read-only, or is read-
only because it is stored on a CD-ROM. If the design file is on your hard disk as read-only 
then you must change its properties in Windows® Explorer so that it is no longer read-only. 
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then 
change the properties so that they are no longer read-only. (Windows® Explorer Help has 
information on the read-only attribute.) 

F56 Why do I get the error ending with "?.bmp not found." 

This may happen if you are loading a Design Outline File from Embroidery System 5. If the 
original picture is moved to a different drive or folder from where the Design File was 
created, the program is unable to locate it. When you open the Design File a warning 
message appears showing where the picture should be stored. Find the picture and replace 
it in the original folder, click New Design, then reload the Design File. Alternatively, start your 
Embroidery System 5 Digitizing, click Load Picture and browse through the folders of your 
computer until you locate the picture. It may be loaded from the new location. After saving 
the Design File from Embroidery System 5 then load and save the Design Outline File in VIP 
Digitizing so that the image is saved as part of the Design. 

F57 Error "You must select an area first, before applying the crop tool." 



Use the Box Select feature to select an area of the Picture around which you wish to crop the 
background. 

F58 Error "Cannot rotate - image will be bigger than 2000 x 2000 pixels if 
rotated to this extent." 

When rotating a picture, certain angles could make the picture larger than the maximum 
allowed by the program. If this message appears, either rotate the picture to a different 
angle, or reduce the size of the picture, then try again. 

F59 Error "Unable to find start point. Retry using a different position." 

When you create a QuickStitch™ Fill area, the area is assessed from the point where you 
clicked. This error will occur when the fill area is complicated and the fill function might not fill 
the area correctly. Click in a different part of the area to try again. If the error still occurs then 
try simplifying or splitting up the area in the Picture Window. 

F60 Error "This is not an appropriate use of this tool. Areas of the image may 
be too wide." 

This happens when you use QuickTrace to follow an outline in the picture and then 
QuickTrace finds a part of the outline that is very thick. In this case, QuickTrace does not 
know where to trace the outline as the problem part of the outline is more like a fill area. Use 
the editing functions in the Picture Window to make the outline thinner or break up the outline 
so that the wide parts are isolated from the rest of the outline. 

F61 Error "Cannot create stitches." 

This error will occur if you attempt to use 3D Create Stitches or Create Stitches before you 
have placed any objects in your design. The minimum requirement is one object of any type. 

F62 Error "Fill object is too complicated." 

Appears if a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation 
functions. Try changing the angle by as little as one degree. This often lets the shape fill 
correctly. Another option is to try moving the start point of the fill area. 

F63 Error "No stitch data to save." 

This message appears if you try to use the Save function when there is no stitch information 
to save from 3D Create Stitches or Create Stitches (such as when there are only jump 
stitches in the design). 

F64 Error "Scanner or camera is in use by another application" 

This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the Twain-compliant device. Close VIP Digitizing 
and the other graphics programs, then reopen VIP Digitizing and try again. 

F65 An error appears in my language when starting VIP Digitizing Version 6.2 

This happens if you have installed the English VIP Digitizing Version 6.2 update over the top 
of a non-English version of VIP Digitizing. If you have done this, download the latest 



installation for VIP Digitizing Version 6.2 from the VIP Digitizing Updates page 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_vipdig.ht
m]. This contains language versions of VIP Digitizing Version 6.2. You will need to run the 
installation twice: once to remove the English version and once to install the language you 
require. 

F66 After attempting to start VIP Digitizing with no dongle attached I have lost 
some of my Preferences 

If you attempt to start VIP Digitizing with no dongle attached then you will get the error “No 
dongle attached. Cannot open program". When this happens, the VIPDigitizing.ini file in your 
windows folder (usually C:\Windows) is re-created with settings that are not the same as the 
installation defaults. Download VIPDigitizing.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_vipdig.ht
m] from the Husqvarna Viking Software web site and save it in the Windows folder. 

F74 Error “The ordinal 66 could not be located in the dynamic link library 
stitMan.dll” 

This error only occurs in VIP Digitizing 6.2 on Windows 2000 and Windows XP. It appears 
when starting the program and there is an incorrect version of the stitman.dll file is in your 
C:\VipEmbroidery folder. 
In order to resolve the error, you will need to uninstall and reinstall your VIP software. Before 
you start, please read through the instructions and make sure you are comfortable with the 
procedure. 
Resolve the error as follows: 
1. Backup any designs and embroidery files that you have saved in 

C:\VipEmbroidery\MyDesigns, or any other folder within C:\VipEmbroidery. 
2. Exit from all Windows programs. 
3. Open the Control Panel window. 
4. Using the Add/Remove tool, uninstall any VIP updates that you may have installed. 
5. Uninstall VIP Digitizing. 
6. Uninstall any other VIP software. 
7. Uninstall VIP Customizing. 
8. Delete the C:\VipEmbroidery folder. 
9. Restart your computer. 
10. Reinstall VIP Customizing. 
11. Restart your computer. 
12. Reinstall VIP Digitizing. 
13. Reinstall any additional VIP software CDs. 
14. Reinstall any VIP updates that were previously installed. 
15. Restart your computer. 

F75 Error "The CanFileViewer.dll file is linked to missing export StitMan.dll: 68" 

This message appears after you see "C:\VipEmbroidery\VipDigitizing.exe. A device attached 
to the system is not functioning" and click OK. 
This error only occurs in VIP Digitizing 6.2 on Windows 95/98/ME. It appears when starting 
the program and there is an incorrect version of the stitman.dll file is in your 
C:\VipEmbroidery folder. 



In order to resolve the error, you will need to uninstall and reinstall your VIP software. Before 
you start, please read through the instructions and make sure you are comfortable with the 
procedure. 
Resolve the error as follows: 
1. Backup any designs and embroidery files that you have saved in 

C:\VipEmbroidery\MyDesigns, or any other folder within C:\VipEmbroidery. 
2. Exit from all Windows programs. 
3. Open the Control Panel window. 
4. Using the Add/Remove tool, uninstall any VIP updates that you may have installed. 
5. Uninstall VIP Digitizing. 
6. Uninstall any other VIP software. 
7. Uninstall VIP Customizing. 
8. Delete the C:\VipEmbroidery folder. 
9. Restart your computer. 
10. Reinstall VIP Customizing. 
11. Restart your computer. 
12. Reinstall VIP Digitizing. 
13. Reinstall any additional VIP software CDs. 
14. Reinstall any VIP updates that were previously installed. 
15. Restart your computer. 

F76 Error "VipDigitizing.e.exe has generated errors and will be closed by 
Windows. You will need to restart the program. An error log is being 
created." 

This error message only appears when you attempt to save a design or view a design with 
3D Create Stitches on a Windows 2000 computer. 
This issue is fixed by applying the latest Windows 2000 Service Pack, followed by all 
available Critical Updates. The latest Windows 2000 Service Pack and Critical Updates can 
be found at the Microsoft Windows 2000 [http://www.microsoft.com/windows2000] web site. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 



L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 
check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 



6. Click Apply. The screen will be adjusted, then another message will appear asking if you 
wish to keep these settings. Click OK to continue (let the computer restart if required). 

If you are unable to alter your display, consult your computer retailer. 

N26 Error message "?.bmp not found." 

Design Outline (.can) Files can only load their Background Image if it is present and in the 
same folder as it was when the file was created. Files that were created in Embroidery 
System 5 Digitizing or Digitizing Pro may have their Background Images located in any 
folder; those produced by converting Stitch Files through View or Import into VIP ReSize 
Plus are stored in the same folder as the .can file. 

R07 Error "Failure to acquire image due to unknown causes." 

This message will appear in certain circumstances when trying to use your scanner or digital 
camera, for example if the cable is disconnected during the scan or download. Close your 
program, check the connections to your scanner or digital camera, then reopen the program 
and try again. 

R08 Error "Not enough memory to perform operation." 

This message will appear when trying to use your scanner or digital camera if system 
resources are low. Close other programs and try again. If this does not work, try restarting 
your computer. 

R09 Error "Could not load picture file." 

This message could appears if the desired Image File is not where the program expects it to 
be, for example if it was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you try to load the design from the 
Recent Files list on the File Menu. It could also appear if the file you are attempting to load is 
corrupt. For example, it might have an extension such as .BMP or .JPG, yet not be a proper 
image file. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 



1. On the original CD find the ".ini" file corresponding to the program; it has the same name 
as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

F16 I can’t see some of the floating toolbars for different types of stitches when 
I open the Digitizing Program 

Check the View Menu to see whether the view function has been turned off. If all the View 
Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. The solution to this also resets all the 
Preference Property Sheets, so to retain current settings, make a note of them. Close the 
Digitizing program, then delete the file C:\Windows\despro.ini. When the program is 
restarted, all the toolbars will be in their original positions. 

F17 The QuickStitch Tie-off icons look different when they are set to small or 
large icon display 

 

 
Small tie-off icons 

 
Large tie-off icons 

When using small icons (the default setting) the two tie-off icons for up and down are 
correctly displayed (left). 
However, when using large icons (selected under Tools / Customize...) the graphic display of 
the icons is reversed (right). The only difference is the display; the help system and actual 
final stitchout confirm that the higher of the two is the tie-off up, and the lower is the tie-off 
down. 
The menus are also set incorrectly. All 5 tie-offs are available from the Tools / Tie-Offs menu. 
However ties right and left work the wrong way round, and ties up and down are also the 
wrong way round. The description shown on the status bar for each feature is correct. 



When the right mouse button is clicked with a tie-off highlighted, the display shows the 
correct tie-off, so if you are not sure which one was selected, use this to check. Finally, the 
context-sensitive help for the tie-off down icon is slightly incorrect. It says it is one small stitch 
up, one down, and a third up rather than one small stitch down, one up and a third down. 

F30 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
The solution to this also resets all the Preference Property Sheet, so to retain current 
settings, make a note of them. 
To reset the icons 
1. Close the VIP Digitizing. 
2. Copy the VIPDigitizing.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDigitizing.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

F32 I can't add new Toolbars 

The ability to add new Toolbars is not available in VIP Digitizing. You can, however, change 
the icons that appear on each Toolbar. This is useful if you want to extend the icons shown 
on the QuickStitch™ Toolbar, for instance. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Installation and CD 

A01 Can I install Digitizing without the Customizing System? 

Digitizing System 5 requires a dongle which is not provided with the package. If you have a 
dongle from a previous version of Digitizing 95 then you are able to use this one. Otherwise 
you must purchase Customizing System 5 which does include a dongle. Husqvarna 
Digitizing 95 version 4.21 and all versions of Digitizing Pro will install without the Customizing 



program. Earlier versions of Digitizing 95 look for the program file named "Custom.exe" 
before they install. If you have one of these versions you can get around the limitation by 
creating a dummy text file in a directory C:\Husq95 and then renaming the text file as 
"Custom.exe". Then follow the installation instructions as normal. 

A05 Installing Digitizing 95 or Format Conversion Pro with Microsoft Internet 
Explorer 4 or Windows 98 

Digitizing 95 (versions up to and including 4.2) and Format Conversion Pro (versions up to 
and including 1.5) use a file which is incompatable with I.E.4 (Windows 95 or 98). If these 
programs are installed on the computer and then I.E.4 installed there will be no problems. If 
these programs are installed with I.E.4 on the computer when the computer re-boots 
Windows will report an error with Explorer and will fail to start. This can be avoided by 
proceeding as follows when installing these programs : 
1. At the end of installation do not select to re-boot the computer. 
2. Using the Windows Explorer delete the file Wininit.ini in the Windows directory. The 

computer system is now safe to re-start. 
Alternatively download the updated file Wininit.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ie4] and copy it to Disk 2 of the digitizing system overwriting the old file. For the Format 
Conversion Pro use the same file and overwrite the old Wininit.ini on the Disk. Then install as 
normal. If you have already installed the programs and now cannot get your copy of 
Windows to start, download the file Comctl32.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ie4] and proceed as follows :- 
1. Re-boot the computer. 
2. Press F8 to get the Start up Menu. 
3. Select Command Prompt Only. 
4. When the system comes up at the C:\ prompt insert a disk with the new Comctl32.dll file 

and copy it to C:\Windows\System. 
5. Re-boot system, the system will re-start as normal. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 



Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A15 I now have two dongles and two code keys, how do I set these up? 

Remove the code key from your oldest dongle and place it in the opposite side of your new 
dongle. If the black spacer is in the space then remove it with a screwdriver or coin. Use this 
new dongle as you had used your old one. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

A35 Error "This setup does not contain the Windows Installer engine 
(instmsia.exe) to run this installation". 

In order to reduce the size of the download, we do not include the Windows Installer engine 
in the updates. This is normally placed on the system when the original VIP program is 
installed. In some circumstances, the enigine is not installed. Download 



[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#win
dows] and run the Install Shield engine and then re-install. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 



the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 



A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 



For more information use the FAQ Search Wizard for your dongle type. 

F26 Digitizing doesn't open when I click on my CAN file from Windows® 
Explorer  

This error can occur if another program uses, or had used files that also requires the CAN 
extension. Because of this confusion, the computer doesn't understand what to do with your 
file and you may receive the message 'unexpected file format'. If you open up the files 
directly from the Open Dialog in the Digitizing software, you should find that they open 
correctly. 
You can restore this file association by doing the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Design Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 
6. Run Digitizing Pro by finding it in the Start menu (go to Start, Programs, Husqvarna 

Professional Embroidery System, Digitizing Pro). 
7. Close the Digitizing Pro program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your CAN files should now be associated correctly. 

F70 I am having problems running Digitizing on Windows 2000. 
Make sure that you have the latest Windows 2000 Service Pack installed on your computer. 
Go to the Microsoft web site and search for "Windows 2000 Service Pack". The site has 
instructions on how to download and install the Service Pack. 

F71 Digitizing crashes very quickly, before I can do any work, and I have a 
Kodak DC3400 digital camera. 

This is caused by a clash with the TWAIN drivers for the Kodak DC3400. First, check the 
Kodak web site to ensure that you have the latest drivers for your DC3400. If problems 
persist, you have two options that will allow Digitizing to work correctly: 
• Remove the Kodak DC3400 software from your system 
• This is the preferred option, especially if you have a second PC available that you can 

use for downloading pictures from the camera. Use the Uninstall option provided with the 
software. 

• Rename a part of the Kodak DC3400 TWAIN driver to disable the driver 
• This would allow you to re-enable the driver when you wanted to download images (but 

not with the Acquire option in Digitizing). You would need to disable the driver again to 
be able to use Digitizing. See the instructions below. 

How to temporarily disable the Kodak DC3400 TWAIN driver 
1. Start Windows Explorer and browse to your Windows folder (usually C:\Windows or 

C:\WinNT). (In some cases you will be warned about viewing files in the Windows folder. 
Use the option that allows you to continue.) 

2. In the Windows folder, find the folder named "twain_32" and browse its contents. 
3. Browse the folder named "DC3400" and you will see a file called "TwainDS.ds". 



4. Right-click on "TwainDS.ds" and rename it as "TwainDS.xds". Putting this extra "x" in the 
file name extension will cause the TWAIN system to ignore this device, which will allow 
Digitizing to run correctly. 

5. If you need to use the TWAIN driver for the Kodak DC3400 with other (not VIP) software, 
simply change the file name back to "TwainDS.ds" until you are ready to use Digitizing 
again. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 



This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Opening and Acquiring Images 

F03 What DPI setting should I use to scan a image for digitizing? 

The correct DPI (dots per inch) setting will depend on the size of the image to be scanned. 
The desired size for the digitizing is approximately 1000 X 1000 pixels. To achieve this take 



the size of your artwork in inches e.g 8" x 7" and divide the longest side into 1000 e.g. 1000 
divided by 8 = 125. The DPI setting of the scanner should then be 125 DPI to produce an 
image that is 1000 x 875. 

F04 Tips on using Stippled Areas and QuickStitch™ 

A stippled area, otherwise known as dithered or patterned area, is an area of one shade of 
color, which has actually been created using two other combined colors. For example mixing 
blocks of black and white can create gray. 

 
Stippled area, close-up 

 
This type of color shading is used regularly in clip-art, especially in old pictures, before 24-
color was regularly used. It is not always possible to see if the area is stippled even when 
magnified, as the picture may have been made in 16 million colors and the stippling created 
with two very close shades of a color. 
In Digitizing 95 the QuickStitch™ function will only work with areas of solid color. If a stippled 
area is selected no fill the function cannot detect a solid area. This causes the warning 
message "Unable to find start point, re-edit " when Create Stitches is selected. Digitizing Pro 
has QuickStitch II™ which can recognize areas of stippled colors. It does not have this 
limitation. 
If no outline appears around the fill area, and the above warning message occurs, you can 
confirm it is a stippling limitation by doing the following: 
1. Load the bitmap picture into MS Paint (The Paint Program supplied with Windows'95). 

This program has the same limitation of being unable to recognize areas of stippled 
colors. 

2. Select a color contrasting to the color of the suspect area. 
3. Select the 'Fill With Color' tool (Paint Bucket). 
4. Click in the area. 
5. If a dot, or small patch, appears then this area is stippled. 
6. If the entire area changes color, then it is not stippled and will work with QuickStitch. 
There are several ways to get round this limitation: 
1. Upgrade to Digitizing Pro. 
2. Digitize the area using FreeHand™ fill. 
3. If you have the original clip-art picture in a vector image file (such as .wmf or .cdr) then 

take it into a vector imaging package, for example Corel Draw, and chose a color for this 
area which you know is not stippled. 

4. Some paint packages do not have the stippling limitation that MS Paint has, for example 
Paint Shop Pro. If you load the bitmap into this package and fill an area using a flood fill 
tolerance of 1, a stippled area will become one solid color block. Reduce the amount of 
colors in the picture. Beware, though this may reduce stippled areas to just one color, but 
it can cause other areas to become stippled. 

F05 I loaded a small picture, and it has too many jagged lines 



Resize the image to make it more suitable for digitizing. See Loading a Picture: Optimizing 
Pictures in Help or User's Guide 

F33 I loaded a small picture, and it has too many jagged lines 

Although the program automatically doubles the size of an image if its height and width are 
less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan the 
image 

F64 Error "Scanner or camera is in use by another application" 

This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the Twain-compliant device. Close VIP Digitizing 
and the other graphics programs, then reopen VIP Digitizing and try again. 

F69 When I view some files before opening them in the preview Window of the 
Open dialog box they appear blue 

Files saved in Jpg format from Adobe® Photoshop® with non-image data may appear blue 
in the preview window. This does not affect the way they appear on the main program screen 
of VIP Digitizing. To avoid this, if you use Adobe® Photoshop® to save .jpg files, make sure 
to check the Exclude non-image data box. If you do not have access to this program and 
have received this type of file, open and re-save in another program such as Jasc® Paint 
Shop Pro. This automatically removes the non-image data. 

F71 Digitizing crashes very quickly, before I can do any work, and I have a 
Kodak DC3400 digital camera. 

This is caused by a clash with the TWAIN drivers for the Kodak DC3400. First, check the 
Kodak web site to ensure that you have the latest drivers for your DC3400. If problems 
persist, you have two options that will allow Digitizing to work correctly: 
• Remove the Kodak DC3400 software from your system 
• This is the preferred option, especially if you have a second PC available that you can 

use for downloading pictures from the camera. Use the Uninstall option provided with the 
software. 

• Rename a part of the Kodak DC3400 TWAIN driver to disable the driver 
• This would allow you to re-enable the driver when you wanted to download images (but 

not with the Acquire option in Digitizing). You would need to disable the driver again to 
be able to use Digitizing. See the instructions below. 

How to temporarily disable the Kodak DC3400 TWAIN driver 
1. Start Windows Explorer and browse to your Windows folder (usually C:\Windows or 

C:\WinNT). (In some cases you will be warned about viewing files in the Windows folder. 
Use the option that allows you to continue.) 

2. In the Windows folder, find the folder named "twain_32" and browse its contents. 
3. Browse the folder named "DC3400" and you will see a file called "TwainDS.ds". 
4. Right-click on "TwainDS.ds" and rename it as "TwainDS.xds". Putting this extra "x" in the 

file name extension will cause the TWAIN system to ignore this device, which will allow 
Digitizing to run correctly. 

5. If you need to use the TWAIN driver for the Kodak DC3400 with other (not VIP) software, 
simply change the file name back to "TwainDS.ds" until you are ready to use Digitizing 
again. 



R07 Error "Failure to acquire image due to unknown causes." 

This message will appear in certain circumstances when trying to use your scanner or digital 
camera, for example if the cable is disconnected during the scan or download. Close your 
program, check the connections to your scanner or digital camera, then reopen the program 
and try again. 

R08 Error "Not enough memory to perform operation." 

This message will appear when trying to use your scanner or digital camera if system 
resources are low. Close other programs and try again. If this does not work, try restarting 
your computer. 

R09 Error "Could not load picture file." 

This message could appears if the desired Image File is not where the program expects it to 
be, for example if it was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you try to load the design from the 
Recent Files list on the File Menu. It could also appear if the file you are attempting to load is 
corrupt. For example, it might have an extension such as .BMP or .JPG, yet not be a proper 
image file. 

Opening and Browsing Designs 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

F53 Error "Design File is read-only. Cannot continue." 

This will happen if you attempt to open a design that has been set as read-only, or is read-
only because it is stored on a CD-ROM. If the design file is on your hard disk as read-only 
then you must change its properties in Windows® Explorer so that it is no longer read-only. 
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then 
change the properties so that they are no longer read-only. (Windows® Explorer Help has 
information on the read-only attribute.) 

F54 On opening a Design the background image is not loaded. 
This may happen if you are loading a Design Outline File from Embroidery System 5. If the 
original picture is moved to a different drive or folder from where the Design File was 
created, the program is unable to locate it. When you open the Design File a warning 
message appears showing where the picture should be stored. Find the picture and replace 
it in the original folder, click New Design, then reload the Design File. Alternatively, start your 
Embroidery System 5 Digitizing, click Load Picture and browse through the folders of your 
computer until you locate the picture. It may be loaded from the new location. After saving 
the Design File from Embroidery System 5 then load and save the Design Outline File in VIP 
Digitizing so that the image is saved as part of the Design. 

F56 Why do I get the error ending with "?.bmp not found." 



This may happen if you are loading a Design Outline File from Embroidery System 5. If the 
original picture is moved to a different drive or folder from where the Design File was 
created, the program is unable to locate it. When you open the Design File a warning 
message appears showing where the picture should be stored. Find the picture and replace 
it in the original folder, click New Design, then reload the Design File. Alternatively, start your 
Embroidery System 5 Digitizing, click Load Picture and browse through the folders of your 
computer until you locate the picture. It may be loaded from the new location. After saving 
the Design File from Embroidery System 5 then load and save the Design Outline File in VIP 
Digitizing so that the image is saved as part of the Design. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

N26 Error message "?.bmp not found." 

Design Outline (.can) Files can only load their Background Image if it is present and in the 
same folder as it was when the file was created. Files that were created in Embroidery 
System 5 Digitizing or Digitizing Pro may have their Background Images located in any 
folder; those produced by converting Stitch Files through View or Import into VIP ReSize 
Plus are stored in the same folder as the .can file. 

Opening Designs 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 



2. Check the version number of your software. Digitizing version 4.11 (or above) has 
improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

F01 What causes the message 'Design could not load BMP file:' or 'Design 
could not load PCX file:' 

This message appears if the picture file the program is trying to load is not actually a true 
BMP or PCX file. It may have corrupted, so that although the file extension is correct, the file 
format is not, or it could be a PCX file with more than 256 colors, or that was exported from 
Corel Draw with compression turned on. To check, try loading the picture in the 
Windows®95 Paint program. Click Start, Programs, Accessories, Paint, then open the file. If 
it opens correctly, try to save it again (it will be saved as a BMP) and reload into the 
Digitizing Program. If not, you know that the picture is corrupt. 

F02 When I load my Design File, I get an error message that the PCX or BMP 
can not be found 

If you get a message that the PCX or BMP background picture can not be found, then 
chances are that you have moved the original picture to a different location. The program 
saves the location of the picture with the CAN file so you must replace the picture. Either 
replace the picture back into its original folder (the error messages defines where it should 
be), or you can 're-load' the picture: Go to 'File' and then 'Load Picture'. At that point tell the 
program where the picture is and it will load. Then click on the 'Save As' icon, (the Floppy 
Disk icon) and the new location will be saved with the CAN file. 

F26 Digitizing doesn't open when I click on my CAN file from Windows® 
Explorer  

This error can occur if another program uses, or had used files that also requires the CAN 
extension. Because of this confusion, the computer doesn't understand what to do with your 
file and you may receive the message 'unexpected file format'. If you open up the files 
directly from the Open Dialog in the Digitizing software, you should find that they open 
correctly. 
You can restore this file association by doing the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Design Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 



6. Run Digitizing Pro by finding it in the Start menu (go to Start, Programs, Husqvarna 
Professional Embroidery System, Digitizing Pro). 

7. Close the Digitizing Pro program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your CAN files should now be associated correctly. 

Preparing and Editing Images 

F31 The Delete key does not seem to do anything in the Picture Window 

The Delete key is not used as a shortcut in the Picture Window, only in the Create and Edit 
Windows. 

F34 The background image shows more of the picture than I want to digitize. 
Use the Design Area command to select the part of the picture you wish to digitize. 
Alternatively, in the Picture Window select the part of the Picture you want with Rectangle or 
Freehand Select then Crop the Picture (you can only do this before you start Digitizing). 

F35 The background image has a thick outline so that QuickStitch™ Fill leaves 
gaps between color areas 

Use the Outline Thinner to narrow the outline to one pixel. This will allow areas to join 
together better. 

F54 On opening a Design the background image is not loaded. 
This may happen if you are loading a Design Outline File from Embroidery System 5. If the 
original picture is moved to a different drive or folder from where the Design File was 
created, the program is unable to locate it. When you open the Design File a warning 
message appears showing where the picture should be stored. Find the picture and replace 
it in the original folder, click New Design, then reload the Design File. Alternatively, start your 
Embroidery System 5 Digitizing, click Load Picture and browse through the folders of your 
computer until you locate the picture. It may be loaded from the new location. After saving 
the Design File from Embroidery System 5 then load and save the Design Outline File in VIP 
Digitizing so that the image is saved as part of the Design. 

F57 Error "You must select an area first, before applying the crop tool." 

Use the Box Select feature to select an area of the Picture around which you wish to crop the 
background. 

F58 Error "Cannot rotate - image will be bigger than 2000 x 2000 pixels if 
rotated to this extent." 

When rotating a picture, certain angles could make the picture larger than the maximum 
allowed by the program. If this message appears, either rotate the picture to a different 
angle, or reduce the size of the picture, then try again. 

F69 When I view some files before opening them in the preview Window of the 
Open dialog box they appear blue 



Files saved in Jpg format from Adobe® Photoshop® with non-image data may appear blue 
in the preview window. This does not affect the way they appear on the main program screen 
of VIP Digitizing. To avoid this, if you use Adobe® Photoshop® to save .jpg files, make sure 
to check the Exclude non-image data box. If you do not have access to this program and 
have received this type of file, open and re-save in another program such as Jasc® Paint 
Shop Pro. This automatically removes the non-image data. 

F73 Creating MiniPics for the VIP Digititizing program 

Before Starting 
An appropriate image editing package, such as Jasc® Paint Shop Pro, is required that will 
save .ras format, as well as a good knowledge of working with graphic files. 
About MiniPics 
Create Medium MiniPics at 400x400 pixels, and Small MiniPics at 250x250 pixels. 
The color palette can be 256 colors or more. 
White is treated as transparent when you load a MiniPic into VIP Digitizing, so anything 
underneath the white part of a MiniPic will show through. If you want an area to be white in 
your MiniPic, use a “false white” such as very pale yellow, then change it to white with the 
Flood Fill tool in the Picture Window of VIP Digitizing. 
It is recommended that you create a new folder for saving your own MinPics, for instance: 
C:\VipEmbroidery\MyDesigns\MyMiniPics. 
How To Make a MiniPic 
1. Use an existing image:Open an existing image; Either crop around the required area or 

resize the whole image to the size of a Medium or Small MiniPic. 
2. Or, create a new MiniPic from scratch:Start a new image and set it to the size of either 

a medium (400x400 pixels) or small (250x250 pixels) MiniPic; Use the drawing tools in 
the graphic package to create the desired image for the MiniPic. 

3. Ensure that the colors are solid color areas. See the existing MiniPics for examples. 
4. Save the file in Sun Raster Image format with the “.ras” extension. 
5. Start Windows® Explorer and browse to the folder where you saved the “.ras” file. 
6. Click on the file to highlight it. 
7. Right-click to bring up a popup menu, and select the Rename option from the menu. 
8. Edit the file name to change the extension from “.ras” to “.axw” and press Enter. 
9. You will be warned about changing the file extension and asked if you want to continue. 
10. Click Yes and the change to the file extension will be saved. 
11. Start VIP Digitizing and click the MiniPics icon so that the MiniPics Viewer appears. 
12. Click the button with three dots at the end of the Directory Browser box so that the 

Browse For Folder dialog appears. 
13. Browse to the directory where you saved your new MiniPic and click OK. 
14. The MiniPics View will show your new MiniPic, along with any MiniPics you have already 

created. 
15. Click the MiniPic and it will be used in the Picture. 

F77 Tips on using the Outline Thinner tool 
It is important where you click after selecting the Outline Thinner tool. The color you click on 
is the color that will be thinned. So if you click on a black outline, this outline will be thinned. 
Alternatively if you click on an area (such as white on a black and white drawing), this area 
will be thinned and the outline around it will be thickened to compensate. This leaves the 
drawing indistinguishable from the original. 



The Outline Thinner tool may not work if your picture has dithering, such as a scanned image 
or one that has been converted from a JPEG file. These pictures have additional colored 
pixels that can affect the result. 

R15 The picture does not redraw fully as I move around the image or work with 
dialog boxes. 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 



ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 



2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 



2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

QuickStitch and FreeHand Borders 

F40 How do I change the color of the border of my FreeHand™ or QuickStitch™ 
fill area? 

To change the color of the border, create the fill area using QuickStitch™ Fill + AutoHole + 
Border, QuickStitch™ Fill + Border or FreeHand™ Fill + Border. Both the fill area and the 
border will use the current thread color. Go to the Edit window and you will see the current 
color three times in the color palette on the right, once for the fill, once for the border and 
once in case you wish to change the following color. Click the second square on the palette 
that sets the border color and choose the required thread color. 

F41 I have only selected part of the Picture with the Design Area but 
QuickStitch™ Fill or QuickStitch™ Border is going outside the Design Area 

If you have an area of color that is both inside and outside the Design Area then 
QuickStitch™ Fill will fill the whole color area with stitches. Either edit the Picture with the 
Picture Window to reduce the size of the color area, use FreeHand™ Fill to fill only the parts 
you want, or edit the QuickStitch™ Fill area on the Edit Window so that the fill area falls 
inside the Design Area. 

F42 The border shape created with QuickStitch™ Border/Running Stitch/Double 
Stitch/Triple Stitch/Applique when I click inside the area is not the one I 
want 

The pictures used should have well differentiated color areas, which may be solid or stippled, 
to create QuickStitch™ Borders easily. Clip-art is excellent for this purpose. If there is a gap 



where the same color flows into another area, the border will not work. Alter the image in the 
picture window, or another graphics package, or use the FreeHand™ Border functions. 

F43 A QuickStitch™ Border has a double layer of stitching in one section 

If border areas run into each other, two layers of stitching will be produced by the 
QuickStitch™ border functions. To avoid this, split the colors on the picture in the picture 
window, or another graphics package, e.g. put a visual 'end point' for each border area. 
Alternatively, use the FreeHand™ Satin Border function. 

F67 The border shape created with QuickStitch™ Border/Running Stitch/Double 
Stitch/Triple Stitch/Applique when I click inside the area is not the one I 
want 

Use Color Tolerance to preview the area that will be used. 
• Solid Colors. A solid color area must have well defined edges, either by having an outline 

of a different color or by being enclosed by other colors. Color Tolerance will show where 
there are gaps in a border around an area. If the area is not sufficiently well defined, alter 
the image in the Picture window, or another graphics package, so that the area is 
enclosed. 

• Stippled Colors. Stippled colors (also called 'dithered' colors) are treated the same as 
solid color areas. 

• Graduated Colors. If Color Tolerance is switched off then you will only be able to select a 
small, single colored part of a graduated color. It is also easier to select a graduated 
color area when it is enclosed by contrasting colors. 

Color Tolerance is switched on with the Color Tolerance option in Screen Preferences. 
Alternatively, use the relevant FreeHand™ function (FreeHand™ Border, FreeHand™ 
Running, FreeHand™ Double or FreeHand™ Triple). 

QuickStitch and FreeHand Fill Areas 

F04 Tips on using Stippled Areas and QuickStitch™ 

A stippled area, otherwise known as dithered or patterned area, is an area of one shade of 
color, which has actually been created using two other combined colors. For example mixing 
blocks of black and white can create gray. 

 
Stippled area, close-up 

 
This type of color shading is used regularly in clip-art, especially in old pictures, before 24-
color was regularly used. It is not always possible to see if the area is stippled even when 
magnified, as the picture may have been made in 16 million colors and the stippling created 
with two very close shades of a color. 
In Digitizing 95 the QuickStitch™ function will only work with areas of solid color. If a stippled 
area is selected no fill the function cannot detect a solid area. This causes the warning 



message "Unable to find start point, re-edit " when Create Stitches is selected. Digitizing Pro 
has QuickStitch II™ which can recognize areas of stippled colors. It does not have this 
limitation. 
If no outline appears around the fill area, and the above warning message occurs, you can 
confirm it is a stippling limitation by doing the following: 
1. Load the bitmap picture into MS Paint (The Paint Program supplied with Windows'95). 

This program has the same limitation of being unable to recognize areas of stippled 
colors. 

2. Select a color contrasting to the color of the suspect area. 
3. Select the 'Fill With Color' tool (Paint Bucket). 
4. Click in the area. 
5. If a dot, or small patch, appears then this area is stippled. 
6. If the entire area changes color, then it is not stippled and will work with QuickStitch. 
There are several ways to get round this limitation: 
1. Upgrade to Digitizing Pro. 
2. Digitize the area using FreeHand™ fill. 
3. If you have the original clip-art picture in a vector image file (such as .wmf or .cdr) then 

take it into a vector imaging package, for example Corel Draw, and chose a color for this 
area which you know is not stippled. 

4. Some paint packages do not have the stippling limitation that MS Paint has, for example 
Paint Shop Pro. If you load the bitmap into this package and fill an area using a flood fill 
tolerance of 1, a stippled area will become one solid color block. Reduce the amount of 
colors in the picture. Beware, though this may reduce stippled areas to just one color, but 
it can cause other areas to become stippled. 

F10 Why would this message appear: 'Fill object is too complicated' 
If a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation functions. 
Try changing the angle by as little as one degree. This often lets the shape fill correctly. 
Another option is to try moving the start point of the fill area. 

F11 When I try QuickStitch™ Fill on any background, including those with the 
software package, I get an error message 'Unable to find start point.' 

Some graphic drivers are incompatible with QuickStitch Fill, test to see if you get the same 
results with more, or less, colors in your Desktop Properties. Alternatively install the latest 
drivers for your graphics card. 

F12 The shape created with QuickStitch™ Fill or Border when I click inside the 
area is not the one I want 

For Digitizing software before System 5, the QuickStitch™ fill and border functions are 
screen-dependent, that is the area to fill must be completely visible on the screen, otherwise 
it will only fill the visible area. Zoom out to make sure the whole of the desired shape is 
included. 
For Digitizing 95 and Digitizing System 5, the pictures used should have solid color areas 
(non-pixellated or dithered) to fill easily. On all Digitizing systems, if there is a gap where the 
same color flows into another area, the fill will not work. Alter the image in Paint, the graphics 
program supplied with Windows®95/®98, or another graphics package, or use the 
FreeHand™ Fill functions. See the Help Topic Optimizing Pictures for Digitizing under 
Loading a Picture. 



F13 How do I change the color of the border of my FreeHand or QuickStitch™ 
fill area? 

To change the on-screen color of the border, Create Stitches, save the file in .hus format and 
open it in the Customizing Program. Then the border color can be changed as desired. 

F14 A QuickStitch™ Border has a double layer of stitching in one section 

If border areas run into each other, two layers of stitching will be produced by the 
QuickStitch™ border functions. To avoid this, split the colors on the picture in 
Windows®95/®98 Paint, or another graphics package, eg put a visual 'end point' for each 
border area. Alternatively, use the FreeHand™ satin border functions. 

F15 When I Create Stitches one of my fill areas doesn't fill completely with 
stitches 

Try changing the angle of orientation. Even one degree can be enough to allow the artificial 
intelligence of the program to fill the object. Another possibility is to move the start point 
slightly. 
The QuickStitch fill will find an area around the location where it was selected and fill it 
entirely, ignoring any sections or 'holes' inside the area. If the design that is to be filled has a 
hole in it, the design must be broken into separate areas around the hole, each section must 
be a solid area, or a area without a hole. The angle of the "break-up" lines should match the 
angle of the fill so that the stitches will blend into each other. 

 
Filling an area with holes 

 
This 0 should be filled in two sections, as divided, for a 45º fill. Dependent on the type of 
fabric that is being embroidered, a gap may be seen at the point at which the two areas 
meet. If so, edit the points of the area so that a overlap is created. 

F18 When I Create Stitches I get the error 'Unable to find start point inside fill 
object. Re-edit' 

When a QuickStitch™ Fill is created it is given a start point inside the fill area. If the area is 
very small or thin, the program may be unable to Create Stitches because it cannot find the 
start point. Try clicking on the area and moving the first point. 

F20 How do I test the creation of fill areas properly when my Design File is 
incomplete? 

Digitize a jump stitch from the center to each extremity of the Background Image when you 
begin digitizing. Then, every time you Create Stitches the stitch file will be sized in proportion 



to the final desired result. Alternatively Digitizing System 5 has a Design Area tool where the 
edges of the design are defined before digitizing. 

F35 The background image has a thick outline so that QuickStitch™ Fill leaves 
gaps between color areas 

Use the Outline Thinner to narrow the outline to one pixel. This will allow areas to join 
together better. 

F38 When I Create Stitches one of my fill areas doesn't fill completely with 
stitches 

Try changing the angle of orientation. Even one degree can be enough to allow the artificial 
intelligence of the program to fill the object. Another possibility is to move the start point 
slightly. 

F39 The fill shape created with QuickStitch™ Fill when I click inside the area is 
not the one I want 

The pictures used should have well differentiated color areas, which may be solid or stippled, 
to fill easily. Clip-art is excellent for this purpose. If there is a gap where the same color flows 
into another area, the fill will not work. Alter the image in the picture window, or another 
graphics package, or use the FreeHand™ Fill functions. 

F40 How do I change the color of the border of my FreeHand™ or QuickStitch™ 
fill area? 

To change the color of the border, create the fill area using QuickStitch™ Fill + AutoHole + 
Border, QuickStitch™ Fill + Border or FreeHand™ Fill + Border. Both the fill area and the 
border will use the current thread color. Go to the Edit window and you will see the current 
color three times in the color palette on the right, once for the fill, once for the border and 
once in case you wish to change the following color. Click the second square on the palette 
that sets the border color and choose the required thread color. 

F41 I have only selected part of the Picture with the Design Area but 
QuickStitch™ Fill or QuickStitch™ Border is going outside the Design Area 

If you have an area of color that is both inside and outside the Design Area then 
QuickStitch™ Fill will fill the whole color area with stitches. Either edit the Picture with the 
Picture Window to reduce the size of the color area, use FreeHand™ Fill to fill only the parts 
you want, or edit the QuickStitch™ Fill area on the Edit Window so that the fill area falls 
inside the Design Area. 

F49 Fill patterns don't display correctly in the Create Window 

The Create Window shows an approximate representation of the stitches, but the stitches 
are not created until you use 3D Create Stitches. Use 3D Create Stitches regularly to check 
the progress of your design. 

F51 When I use QuickStitch™ Fill + AutoHole or QuickStitch™ Fill + AutoHole + 
Border in an area with a fine border, the fill crosses over the line 



When using QuickStitch Fill + AutoHole or QuickStitch Fill + AutoHole + Border there are 
sometimes problems in cutting out the holes when the fill shapes and holes in the Picture 
have outlines that are only one pixel thick: 

 
Thin lines allow fills to 'bleed' 

 
This is because of the ability of QuickStitch™ Fill to identify areas of imported Pictures that 
use stipple fill: 

 
Close up of a stippled image 

 
There are a number of solutions to this: 
1. Use the Picture window to thicken any diagonal lines that are one pixel thick 
2. Use the Flood Fill tool to change the colors inside the shapes that are causing problems: 



 
Use solid fills instead 

 
3. Immediately after using QuickStitch Fill on your shape, use QuickStitch Hole to cut out 

any holes that were missed automatically 
4. Immediately after using QuickStitch™ Fill on your shape, use FreeHand Hole to cut out 

any holes that were missed by placing points 
For more details see the program Help, page "QuickStitch Fill + AutoHole Thin Outline 
Problem" under the Troubleshooting chapter. 

F59 Error "Unable to find start point. Retry using a different position." 

When you create a QuickStitch™ Fill area, the area is assessed from the point where you 
clicked. This error will occur when the fill area is complicated and the fill function might not fill 
the area correctly. Click in a different part of the area to try again. If the error still occurs then 
try simplifying or splitting up the area in the Picture Window. 

F62 Error "Fill object is too complicated." 

Appears if a QuickStitch™ or FreeHand™ fill area is too complex for the stitch generation 
functions. Try changing the angle by as little as one degree. This often lets the shape fill 
correctly. Another option is to try moving the start point of the fill area. 

QuickTrace 

F60 Error "This is not an appropriate use of this tool. Areas of the image may 
be too wide." 

This happens when you use QuickTrace to follow an outline in the picture and then 
QuickTrace finds a part of the outline that is very thick. In this case, QuickTrace does not 
know where to trace the outline as the problem part of the outline is more like a fill area. Use 
the editing functions in the Picture Window to make the outline thinner or break up the outline 
so that the wide parts are isolated from the rest of the outline. 

Saving Designs 

F53 Error "Design File is read-only. Cannot continue." 

This will happen if you attempt to open a design that has been set as read-only, or is read-
only because it is stored on a CD-ROM. If the design file is on your hard disk as read-only 
then you must change its properties in Windows® Explorer so that it is no longer read-only. 
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then 
change the properties so that they are no longer read-only. (Windows® Explorer Help has 
information on the read-only attribute.) 



F63 Error "No stitch data to save." 

This message appears if you try to use the Save function when there is no stitch information 
to save from 3D Create Stitches or Create Stitches (such as when there are only jump 
stitches in the design). 

F76 Error "VipDigitizing.e.exe has generated errors and will be closed by 
Windows. You will need to restart the program. An error log is being 
created." 

This error message only appears when you attempt to save a design or view a design with 
3D Create Stitches on a Windows 2000 computer. 
This issue is fixed by applying the latest Windows 2000 Service Pack, followed by all 
available Critical Updates. The latest Windows 2000 Service Pack and Critical Updates can 
be found at the Microsoft Windows 2000 [http://www.microsoft.com/windows2000] web site. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Screen Appearance 

F05 I loaded a small picture, and it has too many jagged lines 

Resize the image to make it more suitable for digitizing. See Loading a Picture: Optimizing 
Pictures in Help or User's Guide 

F06 The background image shows more of the picture than I want to digitize 

Crop the picture to show exactly what is desired. See Loading a Picture: Optimizing Pictures 
in Help or User's Guide. Alternatively, place the Start Point at the center of the desired part 
of the picture. The sewing machine will start stitching from this point, which will be at the 
center of the hoop 



F07 The background image is too bright to digitize over comfortably 

Dim the image to more restful colors (or try changing background color under Edit Menu, 
Preferences, Screen). See Loading a Picture: Optimizing Pictures in Help or User's Guide 

F17 The QuickStitch Tie-off icons look different when they are set to small or 
large icon display 

 

 
Small tie-off icons 

 
Large tie-off icons 

When using small icons (the default setting) the two tie-off icons for up and down are 
correctly displayed (left). 
However, when using large icons (selected under Tools / Customize...) the graphic display of 
the icons is reversed (right). The only difference is the display; the help system and actual 
final stitchout confirm that the higher of the two is the tie-off up, and the lower is the tie-off 
down. 
The menus are also set incorrectly. All 5 tie-offs are available from the Tools / Tie-Offs menu. 
However ties right and left work the wrong way round, and ties up and down are also the 
wrong way round. The description shown on the status bar for each feature is correct. 
When the right mouse button is clicked with a tie-off highlighted, the display shows the 
correct tie-off, so if you are not sure which one was selected, use this to check. Finally, the 
context-sensitive help for the tie-off down icon is slightly incorrect. It says it is one small stitch 
up, one down, and a third up rather than one small stitch down, one up and a third down. 

F30 I can't see some of the floating toolbars or icons when I open the program 

First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 



The solution to this also resets all the Preference Property Sheet, so to retain current 
settings, make a note of them. 
To reset the icons 
1. Close the VIP Digitizing. 
2. Copy the VIPDigitizing.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDigitizing.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

F32 I can't add new Toolbars 

The ability to add new Toolbars is not available in VIP Digitizing. You can, however, change 
the icons that appear on each Toolbar. This is useful if you want to extend the icons shown 
on the QuickStitch™ Toolbar, for instance. 

F33 I loaded a small picture, and it has too many jagged lines 

Although the program automatically doubles the size of an image if its height and width are 
less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan the 
image 

F34 The background image shows more of the picture than I want to digitize. 
Use the Design Area command to select the part of the picture you wish to digitize. 
Alternatively, in the Picture Window select the part of the Picture you want with Rectangle or 
Freehand Select then Crop the Picture (you can only do this before you start Digitizing). 

F49 Fill patterns don't display correctly in the Create Window 

The Create Window shows an approximate representation of the stitches, but the stitches 
are not created until you use 3D Create Stitches. Use 3D Create Stitches regularly to check 
the progress of your design. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Stitching Out 

F21 I have created a design but some of the stitches are out of place 

You may have clicked Create Stitches, or saved your file while Insert Mode was on. This can 
lead to part of the stitch file being out of place, but doesn't show in the CAN file. Make sure 



the Insert Mode is off, then find the object where the design starts to go astray, and 
reposition it slightly. 

F27 I had inserted a series of objects into my design, but when I stitched the 
design my tie stitches were in the wrong place. 

When QuickStitch Tie Stitches are inserted into an embroidery design in Digitizing, there is a 
slight problem that they all get placed at the end of the inserted section; even if they appear 
in the right place on the display. Use the left and right arrow keys to move through the 
objects of the design and you will see. 
You can remove these tie stitches and then insert them individually in the correct places. But 
to prevent this happening in the future, it may be easier to insert all your stitches without ties, 
and then insert the tie stitches individually afterwards. Alternatively, create tie stitches 
freehand using Single Stitch. 

Stitch Editor 
Listed versions: Pro, system 2.1; VIP, version 6.0; VIP, version 6.1; Pro System 5, version 5.0 

Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 



A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 



For more information use the FAQ Search Wizard for your dongle type. 

Editing Designs 

G02 When I view Tajima files, the Trim and Stop stitches do not show 

Unlike Husqvarna Viking/Pfaff (.vip) format files, Tajima (.dst) does not have stitches 
specially designated as trims or stops. Instead these are replaced as three extra jump 
stitches instead of a trim and a color change instead of a stop. When the machine is stitching 
the design, it converts these back to the correct stitch types 

G03 The Stitch File I want to work with appears too small on the screen 

Make sure the VIP Stitch Editor program window is maximized by clicking the Maximize icon 
on the title bar, then maximize the window of the desired Stitch File by clicking the Maximize 
icon on its title bar. Click Zoom To Fit to expand the Design so it fills the window or use 
Zoom In together with the Overview Window to move around the Design. Check the Hoop 
Size in Preferences to make sure the Hoop Size is not too large for the Design. 

G04 I find it hard to select the part of the design I wish to edit 
Many functions of the VIP Stitch Editor program can be used to help see sections of Stitch 
Files more easily. They include the Zoom Commands and the Overview Window, as well as 
Draw Next Color, Draw Previous Color, the slider bars and Ghost Mode. The Coordinates 
can also be used to help run through designs to find the required stitch or command. The 
different methods of selection (Block box, Color Block, Freehand Block, Polygon Block and 
Make Block From Visible Area are also useful for different situations. 

G05 I highlighted part of a Stitch File, then tried to Compensate the block. The 
compensation has been applied to the whole design, not just the area 
selected 

Compensation works on the visible part of a Stitch File. Use the slider bars, Draw Next Color 
or turn colors off by right-clicking in the Color Worksheet to isolate a specific area before 
using this function. 

G06 I highlighted part of a Stitch File, then tried to Break Up Stitches. Stitches 
have been broken up in the whole design, not just the area selected 

Break Up Stitches works on the visible part of a Stitch File. Use the slider bars, Draw Next 
Color or turn colors off by right-clicking in the Color Worksheet to isolate a specific area 
before using this function. 

G07 After moving a block of stitches to a different part of the Stitch File a long 
stitch was created between two parts of the design. When I stitched the file 
out this stitch became many stitches 

When a Stitch File is saved, any movement over 8mm long is automatically broken up into 
smaller stitches. Their stitch points would not be visible before saving the altered design. You 
may wish to convert these movements to Jump Stitches using the Insert Jump Stitch 
command. 
Please Note: This does not apply to VIP Stitch Editor. 



G08 I cannot select the desired color using the Color Block function, because 
one color is on top of the other 

Use Draw Next Color and Draw Previous Color or turn colors off by right-clicking in the Color 
Worksheet to isolate the desired color area, then click Color Block to select those stitches. 

G09 I opened a Block box around an area, but selected some stitches I didn't 
want. Undo is grayed out so I can't click it 

To cancel a stitch block selection made using Block Box, Color Block, Freehand Block, 
Polygon Block or Make Block From Visible Area, click anywhere in the currently active Stitch 
File, but outside the dotted box showing the selected stitches. The stitches will no longer be 
selected. 

G10 I have started to PatternMake™ a Stitch File using the Stamp Fill and 
realize I have not isolated the part of the design I wish to pattern 

Click the Esc button on the computer keyboard and the stamping process is cancelled. 

G16 It seems to take a long time to redraw stitch files when I choose different 
functions or switch to a new design. 

The refresh rate of the screen is limited by the power of your computer's processor and RAM 
as well as the video card and its memory. To get the best performance from your system, 
keep the Visual Directory Dialog Box closed, as this must be redrawn every time the screen 
changes. Also try turning the View Stitch Points option off if it is not critical to the function you 
are using. 

Error Messages 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 



If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 



If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

G11 Error "Design is either too big to fit inside hoop, or the design lies outside 
the hoop area. Please adjust the position of the design or change the 
hoop." 

This message appears if a Stitch File you are trying to Save is outside the selected hoop or 
larger than will fit in it. For example, with the 100mm x 100mm hoop selected, a design 
smaller than 100mm x 100mm might be placed partially outside the Stitch Area when you 
click Save. This message would then appear. Move the design completely within the four 
blue corners of the Stitch Area and try again. Alternatively, change the Hoop Use setting in 
General Preferences to No. 

G12 Error "No designs available to print. Only designs that are inside the hoop 
can be printed." 

This message appears if the Stitch File on screen is partially outside the selected hoop. 
Move the design completely within the four blue corners of the Stitch Area and try again. 
Alternatively, change the Hoop Use setting in General Preferences to No. 

G13 Error "The cut line crosses over itself. Please define another cut line and 
try again." 

This message appears when you place a cut line that crosses itself at some point. If you 
want to split the design then you must redo the cut line, without it crossing over itself. 

G14 Error "The cut line finishes in the middle of the design. Please define 
another cut line and try again." 

This message appears when you right-click to end the cut line before the cut line goes all the 
way through the design. If you want to split the design then you must redo the cut line. 



G15 Error "The cut line does not enter the design. Please define another cut line 
and try again." 

This message appears when you right-click to end the cut line before the cut line has 
crossed any stitches. If you want to split the design then you must redo the cut line. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 



M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

G09 I opened a Block box around an area, but selected some stitches I didn't 
want. Undo is grayed out so I can't click it 

To cancel a stitch block selection made using Block Box, Color Block, Freehand Block, 
Polygon Block or Make Block From Visible Area, click anywhere in the currently active Stitch 
File, but outside the dotted box showing the selected stitches. The stitches will no longer be 
selected. 

G17 Some of the icons in the Toolbar are 'grayed out' when I open the VIP Stitch 
Editor Program. 

Certain icons (for example Combine, Save As and Print on the Main Toolbar and all Edit 
Toolbar icons apart from Preferences) are only highlighted once a stitch file is shown on the 
VIP Stitch Editor screen. 



G18 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPStitchEditor.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPStitchEditor.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 



Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 



Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 



PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

Miscellaneous 

A10 General difficulties with hardware and software 



If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 



Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

G01 Sometimes the thumbnail images in the Visual Directory overlap the edges 
of the window, and designs repeat themselves in the sequence. Then I 
cannot load more designs 



Stitch Editor has a maximum number of designs that can be opened at any one time of 36. 
At this point the thumbnail images in the Visual Directory may begin to overlap the edges of 
the box, the scroll arrows and pull down tab may change from arrows to numbers. The Visual 
Directory may then return to the beginning of the sequence of designs. The background of 
stitch file(s) displayed in the program window may change to white. An error message 
"Failed to open - empty" will appear when trying to load designs. Close the Visual Directory 
window and close some of the design that are open on your screen. Then you will be able to 
open more designs 

G02 When I view Tajima files, the Trim and Stop stitches do not show 

Unlike Husqvarna Viking/Pfaff (.vip) format files, Tajima (.dst) does not have stitches 
specially designated as trims or stops. Instead these are replaced as three extra jump 
stitches instead of a trim and a color change instead of a stop. When the machine is stitching 
the design, it converts these back to the correct stitch types 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 



• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 
be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 



Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

G01 Sometimes the thumbnail images in the Visual Directory overlap the edges 
of the window, and designs repeat themselves in the sequence. Then I 
cannot load more designs 

Stitch Editor has a maximum number of designs that can be opened at any one time of 36. 
At this point the thumbnail images in the Visual Directory may begin to overlap the edges of 
the box, the scroll arrows and pull down tab may change from arrows to numbers. The Visual 
Directory may then return to the beginning of the sequence of designs. The background of 
stitch file(s) displayed in the program window may change to white. An error message 
"Failed to open - empty" will appear when trying to load designs. Close the Visual Directory 
window and close some of the design that are open on your screen. Then you will be able to 
open more designs 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 



L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

Printing 

G12 Error "No designs available to print. Only designs that are inside the hoop 
can be printed." 

This message appears if the Stitch File on screen is partially outside the selected hoop. 
Move the design completely within the four blue corners of the Stitch Area and try again. 
Alternatively, change the Hoop Use setting in General Preferences to No. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 



• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 
checked 

Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 



For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 



2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 



If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Saving Designs 

G11 Error "Design is either too big to fit inside hoop, or the design lies outside 
the hoop area. Please adjust the position of the design or change the 
hoop." 

This message appears if a Stitch File you are trying to Save is outside the selected hoop or 
larger than will fit in it. For example, with the 100mm x 100mm hoop selected, a design 
smaller than 100mm x 100mm might be placed partially outside the Stitch Area when you 
click Save. This message would then appear. Move the design completely within the four 
blue corners of the Stitch Area and try again. Alternatively, change the Hoop Use setting in 
General Preferences to No. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

Screen Appearance 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

G01 Sometimes the thumbnail images in the Visual Directory overlap the edges 
of the window, and designs repeat themselves in the sequence. Then I 
cannot load more designs 

Stitch Editor has a maximum number of designs that can be opened at any one time of 36. 
At this point the thumbnail images in the Visual Directory may begin to overlap the edges of 
the box, the scroll arrows and pull down tab may change from arrows to numbers. The Visual 
Directory may then return to the beginning of the sequence of designs. The background of 
stitch file(s) displayed in the program window may change to white. An error message 



"Failed to open - empty" will appear when trying to load designs. Close the Visual Directory 
window and close some of the design that are open on your screen. Then you will be able to 
open more designs 

G02 When I view Tajima files, the Trim and Stop stitches do not show 

Unlike Husqvarna Viking/Pfaff (.vip) format files, Tajima (.dst) does not have stitches 
specially designated as trims or stops. Instead these are replaced as three extra jump 
stitches instead of a trim and a color change instead of a stop. When the machine is stitching 
the design, it converts these back to the correct stitch types 

G03 The Stitch File I want to work with appears too small on the screen 

Make sure the VIP Stitch Editor program window is maximized by clicking the Maximize icon 
on the title bar, then maximize the window of the desired Stitch File by clicking the Maximize 
icon on its title bar. Click Zoom To Fit to expand the Design so it fills the window or use 
Zoom In together with the Overview Window to move around the Design. Check the Hoop 
Size in Preferences to make sure the Hoop Size is not too large for the Design. 

G16 It seems to take a long time to redraw stitch files when I choose different 
functions or switch to a new design. 

The refresh rate of the screen is limited by the power of your computer's processor and RAM 
as well as the video card and its memory. To get the best performance from your system, 
keep the Visual Directory Dialog Box closed, as this must be redrawn every time the screen 
changes. Also try turning the View Stitch Points option off if it is not critical to the function you 
are using. 

G17 Some of the icons in the Toolbar are 'grayed out' when I open the VIP Stitch 
Editor Program. 

Certain icons (for example Combine, Save As and Print on the Main Toolbar and all Edit 
Toolbar icons apart from Preferences) are only highlighted once a stitch file is shown on the 
VIP Stitch Editor screen. 

G18 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPStitchEditor.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPStitchEditor.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 



M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

Splitting Designs 

G13 Error "The cut line crosses over itself. Please define another cut line and 
try again." 

This message appears when you place a cut line that crosses itself at some point. If you 
want to split the design then you must redo the cut line, without it crossing over itself. 

G14 Error "The cut line finishes in the middle of the design. Please define 
another cut line and try again." 

This message appears when you right-click to end the cut line before the cut line goes all the 
way through the design. If you want to split the design then you must redo the cut line. 

G15 Error "The cut line does not enter the design. Please define another cut line 
and try again." 

This message appears when you right-click to end the cut line before the cut line has 
crossed any stitches. If you want to split the design then you must redo the cut line. 

Stitch Files 

G02 When I view Tajima files, the Trim and Stop stitches do not show 

Unlike Husqvarna Viking/Pfaff (.vip) format files, Tajima (.dst) does not have stitches 
specially designated as trims or stops. Instead these are replaced as three extra jump 
stitches instead of a trim and a color change instead of a stop. When the machine is stitching 
the design, it converts these back to the correct stitch types 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

Design Splitter 
Listed versions: VIP, version 6.0; VIP, version 6.1 

Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 



This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 



Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 



The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 



L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

T01 Error "Stitch file too big for hoop." 

This message appears if the Stitch File you are trying to load onto the VIP Design Splitter 
screen is larger than the dimensions that will fit in either the Plus Hoop or creative Big Hoop. 

T04 Error "Your cut line crosses back on itself." 

This message appears when you place a cut line that crosses itself at some point. If you 
want to split the design then you must redo the cut line, without it crossing over itself. 

Icons and Toolbars 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 



T02 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Design Splitter Program. 

Certain Main Toolbar icons (such as Quick 3DStitch™ View) and all Edit Toolbar icons 
except for Preferences are only highlighted once a stitch file is shown on the VIP Design 
Splitter screen. 

T03 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPDesignSplitter.ini file from the root folder of your CD. (If your VIP software 

was installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDesignSplitter.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 



If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 



However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Miscellaneous 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 



Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 



The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 



This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Opening and Browsing Designs 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L18 Error "Cannot open stitch file." 



This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

T01 Error "Stitch file too big for hoop." 

This message appears if the Stitch File you are trying to load onto the VIP Design Splitter 
screen is larger than the dimensions that will fit in either the Plus Hoop or creative Big Hoop. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 



If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 



M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 



Screen Appearance 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

T02 Some of the icons in the Toolbar are 'grayed out' when I open the VIP 
Design Splitter Program. 

Certain Main Toolbar icons (such as Quick 3DStitch™ View) and all Edit Toolbar icons 
except for Preferences are only highlighted once a stitch file is shown on the VIP Design 
Splitter screen. 

T03 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPDesignSplitter.ini file from the root folder of your CD. (If your VIP software 

was installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPDesignSplitter.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Splitting Designs 

T04 Error "Your cut line crosses back on itself." 

This message appears when you place a cut line that crosses itself at some point. If you 
want to split the design then you must redo the cut line, without it crossing over itself. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 



Color PictureStitch 
Listed versions: VIP, version 6.0; Version 5.5; VIP, version 6.2 

Creating Stitches 

R01 When I click on Create Stitches in Color Mode the program crashes 

First check the version number of the program that you are using. Use Windows Explorer to 
find the exe (by default installation C:\HusqPro\Color_PictureStitch.exe). Right-click on the 
exe and select Properties from the menu that appears. Click the version tab and check the 
File Version. If you have any of the following versions 5.5.0.27, 5.5.0.28, 5.5.1.29, 5.5.1.30 
download the upgrade CPS551a.exe 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#cps]. 

R19 The stitch files I create do not have the threads from my preferred thread 
manufacturer. 

In Color Mode, the four Sulky thread colors supplied in your sample spools are always used. 
Therefore, when you open stitch files in other VIP Embroidery System programs they must 
be changed manually if desired to shades in your preferred manufacturer’s thread range. 

R21 After Creating Stitches the Copy button on the dialog box appears grayed 
out as if it is unavailable. 

In Monochrome Mode, 170mm x 100mm (Plus Hoop), two files are created. Therefore this 
feature is not available. 

R22 I would like to get rid of the lines created from the white background of my 
Image File. 

After Creating and Saving Stitches, open the file in VIP Stitch Editor and use the following 
instructions. 
Monochrome Mode  
1. Use the Freehand Block Select feature to mark the stitches in the background. 
2. Click Delete Stitches. 
3. Save the adjusted Stitch File. 
Color Mode  
1. Select one of the three color changes (located in the top corners of the design and 

shown as blue circles with a white C in the middle). 
2. Click and drag it into the area of the design that you wish to keep. 
3. Repeat the two previous steps for the other two color changes. 
4. Use the Freehand Block Select feature to mark the stitches in the background. 
5. Click Delete Stitches. 
6. Save the adjusted Stitch File. 

Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 



This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 



Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 



The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

F57 Error "You must select an area first, before applying the crop tool." 

Use the Box Select feature to select an area of the Picture around which you wish to crop the 
background. 

F58 Error "Cannot rotate - image will be bigger than 2000 x 2000 pixels if 
rotated to this extent." 

When rotating a picture, certain angles could make the picture larger than the maximum 
allowed by the program. If this message appears, either rotate the picture to a different 
angle, or reduce the size of the picture, then try again. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

R04 Error "Please enter an integer between 16 and 2000." 

When creating a new file, the largest size available is 2000 x 2000. If you enter dimensions 
smaller than 16 or larger than 2000 pixels, this message will appear. Choose a different size 
and try again. 

R05 Error "Problem with scanner or camera software." 

This message will appear when trying to use your scanner or digital camera if the device has 
not been installed correctly. Close PictureStitch™, follow the manufacturer's instructions for 
the Twain-compliant device, then reopen PictureStitch™ and try again. 

R06 Error "Scanner or camera is in use by another application." 



This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the Twain-compliant device. Close 
PictureStitch™ and the other graphics programs, then reopen PictureStitch™ and try again. 

R07 Error "Failure to acquire image due to unknown causes." 

This message will appear in certain circumstances when trying to use your scanner or digital 
camera, for example if the cable is disconnected during the scan or download. Close your 
program, check the connections to your scanner or digital camera, then reopen the program 
and try again. 

R08 Error "Not enough memory to perform operation." 

This message will appear when trying to use your scanner or digital camera if system 
resources are low. Close other programs and try again. If this does not work, try restarting 
your computer. 

R09 Error "Could not load picture file." 

This message could appears if the desired Image File is not where the program expects it to 
be, for example if it was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you try to load the design from the 
Recent Files list on the File Menu. It could also appear if the file you are attempting to load is 
corrupt. For example, it might have an extension such as .BMP or .JPG, yet not be a proper 
image file. 

R10 Error "You cannot select a region smaller than 5 x 5 pixels." 

When using the Box Select or Freehand Select features, this message will appear if the area 
you try to select is extremely small. Click and drag to select a larger area. 

R11 Error "Could not save picture file." 

When saving a picture file to a floppy disk, this message will appear if the Write-Protect tab is 
activated. Take the floppy disk out of the drive, flip the tab the other way and try again. It 
could also appear if the disk is full. This is most likely to occur when saving to a floppy disk; 
use another disk. If the message appears when attempting to save to hard disk, delete some 
files then try again. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 



Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

R12 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPColorPict.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPColorPict.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

R21 After Creating Stitches the Copy button on the dialog box appears grayed 
out as if it is unavailable. 

In Monochrome Mode, 170mm x 100mm (Plus Hoop), two files are created. Therefore this 
feature is not available. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 



can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 



If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 



• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 
be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

R03 Embroidery System shortcuts on Desktop do not work after upgrading to 
VIP Color PictureStitch 

If you have installed the upgrade for Color PictureStitch on Windows 2000, and a shortcut 
folder of "Embroidery System" is created on your Desktop which does not work, then in order 
to fix this proceed as follows: 
1. Click on one of the "Embroidery System" shortcut folders on your Desktop. 
2. Press the Delete button on your keyboard. 
3. When asked to confirm that you want to delete the shortcut, click the YES button. 
4. Double-click the remaining "Embroidery System" folder on your Desktop. 
5. Right-Click on a blank area in the window. 
6. Hover your mouse button over the "New" option in the list. 
7. When a new column appears, click on the "Shortcut" option from this column. 
8. A "Create Shortcut" window will appear, click on the "Browse" button. 
9. Now use the box to locate VipColorPict.exe file - normally 

C:VipEmbroidery\VipColorPict.exe. 
10. Click on the file when you locate it, then click on the "Open" button. 
11. The previous screen should now appear, now click on the "Next" button. 
12. In the box that asks for a name for the shortcut, type VIP Color PictureStitch. 

R23 I have bought Color PictureStitch, but I was expecting VIP Color 
PictureStitch, version 6.0 

You need to upgrade Color PictureStitch to VIP Color PictureStitch using the VIP Upgrade 
from the VIP Customizing CD. This installation will also upgrade ReSize Plus if you have that 
installed on your computer. 
1. Install Color PictureStitch (and ReSize Plusif you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 



R25 How do I uninstall VIP Color PictureStitch? 

Use the following steps to remove VIP Color PictureStitch from your computer: 
1. Double-click on My Computer on your desktop. 
2. Double-click on Control Panel. 
3. Double-click on Add/Remove Programs. 
4. In the list of programs provided, scroll down until you see 'VIP Embroidery System 

Upgrade'. 
5. Highlight this and click 'Add/Remove'. 
6. Click 'Yes' to remove the VIP Upgrade from your Color PictureStitch. 
7. Now find 'Husqvarna Viking Color PictureStitch' in the list. 
8. Highlight this and click 'Add/Remove'. 
9. Click 'OK' to confirm you wish to remove the program. 
10. Click 'OK' to close the Add/Remove Programs window. 
Note this will also return VIP ReSize Plus (if you have it installed) to version 5.0. If you wish 
to retain VIP ReSize Plus, run the VIP Upgrade from the VIP Customizing CD once you have 
followed all the steps for removing VIP Color PictureStitch above. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 



4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 



Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 



L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

N36 I have clicked on the Tutor icon, but I cannot hear anything. 
Unless multimedia is installed on your computer (soundcard and speakers) you will not be 
able to hear the Personal Tutor messages. If you have multimedia installed, check that the 
speakers are plugged in and that the volume has not been turned down. 

R01 When I click on Create Stitches in Color Mode the program crashes 



First check the version number of the program that you are using. Use Windows Explorer to 
find the exe (by default installation C:\HusqPro\Color_PictureStitch.exe). Right-click on the 
exe and select Properties from the menu that appears. Click the version tab and check the 
File Version. If you have any of the following versions 5.5.0.27, 5.5.0.28, 5.5.1.29, 5.5.1.30 
download the upgrade CPS551a.exe 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#cps]. 

R02 PictureStitch crashes very quickly, before I can do any work, and I have a 
Kodak DC3400 digital camera. 

This is caused by a clash with the TWAIN drivers for the Kodak DC3400. First, check the 
Kodak web site to ensure that you have the latest drivers for your DC3400. If problems 
persist, you have two options that will allow PictureStitch to work correctly: 
• Remove the Kodak DC3400 software from your system:This is the preferred option, 

especially if you have a second PC available that you can use for downloading pictures 
from the camera. Use the Uninstall option provided with the software. 

• Rename a part of the Kodak DC3400 TWAIN driver to disable the driver:This would 
allow you to re-enable the driver when you wanted to download images (but not with the 
Acquire option in PictureStitch ). You would need to disable the driver again to be able to 
use PictureStitch. See the instructions below. 

How to temporarily disable the Kodak DC3400 TWAIN driver 
1. Start Windows Explorer and browse to your Windows folder (usually C:\Windows or 

C:\WinNT). (In some cases you will be warned about viewing files in the Windows folder. 
Use the option that allows you to continue.) 

2. In the Windows folder, find the folder named "twain_32" and browse its contents. 
3. Browse the folder named "DC3400" and you will see a file called "TwainDS.ds". 
4. Right-click on "TwainDS.ds" and rename it as "TwainDS.xds". Putting this extra "x" in the 

file name extension will cause the TWAIN system to ignore this device, which will allow 
PictureStitch to run correctly. 

5. If you need to use the TWAIN driver for the Kodak DC3400 with other (not VIP) software, 
simply change the file name back to "TwainDS.ds" until you are ready to use 
PictureStitch again. 

R03 Embroidery System shortcuts on Desktop do not work after upgrading to 
VIP Color PictureStitch 

If you have installed the upgrade for Color PictureStitch on Windows 2000, and a shortcut 
folder of "Embroidery System" is created on your Desktop which does not work, then in order 
to fix this proceed as follows: 
1. Click on one of the "Embroidery System" shortcut folders on your Desktop. 
2. Press the Delete button on your keyboard. 
3. When asked to confirm that you want to delete the shortcut, click the YES button. 
4. Double-click the remaining "Embroidery System" folder on your Desktop. 
5. Right-Click on a blank area in the window. 
6. Hover your mouse button over the "New" option in the list. 
7. When a new column appears, click on the "Shortcut" option from this column. 
8. A "Create Shortcut" window will appear, click on the "Browse" button. 
9. Now use the box to locate VipColorPict.exe file - normally 

C:VipEmbroidery\VipColorPict.exe. 
10. Click on the file when you locate it, then click on the "Open" button. 
11. The previous screen should now appear, now click on the "Next" button. 



12. In the box that asks for a name for the shortcut, type VIP Color PictureStitch. 

R15 The picture does not redraw fully as I move around the image or work with 
dialog boxes. 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

R23 I have bought Color PictureStitch, but I was expecting VIP Color 
PictureStitch, version 6.0 

You need to upgrade Color PictureStitch to VIP Color PictureStitch using the VIP Upgrade 
from the VIP Customizing CD. This installation will also upgrade ReSize Plus if you have that 
installed on your computer. 
1. Install Color PictureStitch (and ReSize Plusif you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 

R25 How do I uninstall VIP Color PictureStitch? 

Use the following steps to remove VIP Color PictureStitch from your computer: 
1. Double-click on My Computer on your desktop. 



2. Double-click on Control Panel. 
3. Double-click on Add/Remove Programs. 
4. In the list of programs provided, scroll down until you see 'VIP Embroidery System 

Upgrade'. 
5. Highlight this and click 'Add/Remove'. 
6. Click 'Yes' to remove the VIP Upgrade from your Color PictureStitch. 
7. Now find 'Husqvarna Viking Color PictureStitch' in the list. 
8. Highlight this and click 'Add/Remove'. 
9. Click 'OK' to confirm you wish to remove the program. 
10. Click 'OK' to close the Add/Remove Programs window. 
Note this will also return VIP ReSize Plus (if you have it installed) to version 5.0. If you wish 
to retain VIP ReSize Plus, run the VIP Upgrade from the VIP Customizing CD once you have 
followed all the steps for removing VIP Color PictureStitch above. 

Opening and Acquiring Images 

R02 PictureStitch crashes very quickly, before I can do any work, and I have a 
Kodak DC3400 digital camera. 

This is caused by a clash with the TWAIN drivers for the Kodak DC3400. First, check the 
Kodak web site to ensure that you have the latest drivers for your DC3400. If problems 
persist, you have two options that will allow PictureStitch to work correctly: 
• Remove the Kodak DC3400 software from your system:This is the preferred option, 

especially if you have a second PC available that you can use for downloading pictures 
from the camera. Use the Uninstall option provided with the software. 

• Rename a part of the Kodak DC3400 TWAIN driver to disable the driver:This would 
allow you to re-enable the driver when you wanted to download images (but not with the 
Acquire option in PictureStitch ). You would need to disable the driver again to be able to 
use PictureStitch. See the instructions below. 

How to temporarily disable the Kodak DC3400 TWAIN driver 
1. Start Windows Explorer and browse to your Windows folder (usually C:\Windows or 

C:\WinNT). (In some cases you will be warned about viewing files in the Windows folder. 
Use the option that allows you to continue.) 

2. In the Windows folder, find the folder named "twain_32" and browse its contents. 
3. Browse the folder named "DC3400" and you will see a file called "TwainDS.ds". 
4. Right-click on "TwainDS.ds" and rename it as "TwainDS.xds". Putting this extra "x" in the 

file name extension will cause the TWAIN system to ignore this device, which will allow 
PictureStitch to run correctly. 

5. If you need to use the TWAIN driver for the Kodak DC3400 with other (not VIP) software, 
simply change the file name back to "TwainDS.ds" until you are ready to use 
PictureStitch again. 

R05 Error "Problem with scanner or camera software." 

This message will appear when trying to use your scanner or digital camera if the device has 
not been installed correctly. Close PictureStitch™, follow the manufacturer's instructions for 
the Twain-compliant device, then reopen PictureStitch™ and try again. 

R06 Error "Scanner or camera is in use by another application." 



This message will appear when trying to use your scanner or digital camera if another 
graphics program is already open that uses the Twain-compliant device. Close 
PictureStitch™ and the other graphics programs, then reopen PictureStitch™ and try again. 

R07 Error "Failure to acquire image due to unknown causes." 

This message will appear in certain circumstances when trying to use your scanner or digital 
camera, for example if the cable is disconnected during the scan or download. Close your 
program, check the connections to your scanner or digital camera, then reopen the program 
and try again. 

R08 Error "Not enough memory to perform operation." 

This message will appear when trying to use your scanner or digital camera if system 
resources are low. Close other programs and try again. If this does not work, try restarting 
your computer. 

R09 Error "Could not load picture file." 

This message could appears if the desired Image File is not where the program expects it to 
be, for example if it was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you try to load the design from the 
Recent Files list on the File Menu. It could also appear if the file you are attempting to load is 
corrupt. For example, it might have an extension such as .BMP or .JPG, yet not be a proper 
image file. 

R13 When I view some files before opening them in the preview Window of the 
Open dialog box they appear blue. 

Files saved in Jpg format from Adobe® Photoshop® with non-image data may appear blue 
in the preview window. This does not affect the way they appear on the main program screen 
of PictureStitch™. To avoid this, if you use Adobe® Photoshop® to save .jpg files, make 
sure to check the Exclude non-image data box. If you do not have access to this program 
and have received this type of file, open and re-save in another program such as Jasc® 
Paint Shop Pro. This automatically removes the non-image data. 

Preparing and Editing Images 

F57 Error "You must select an area first, before applying the crop tool." 

Use the Box Select feature to select an area of the Picture around which you wish to crop the 
background. 

F58 Error "Cannot rotate - image will be bigger than 2000 x 2000 pixels if 
rotated to this extent." 

When rotating a picture, certain angles could make the picture larger than the maximum 
allowed by the program. If this message appears, either rotate the picture to a different 
angle, or reduce the size of the picture, then try again. 

R04 Error "Please enter an integer between 16 and 2000." 



When creating a new file, the largest size available is 2000 x 2000. If you enter dimensions 
smaller than 16 or larger than 2000 pixels, this message will appear. Choose a different size 
and try again. 

R10 Error "You cannot select a region smaller than 5 x 5 pixels." 

When using the Box Select or Freehand Select features, this message will appear if the area 
you try to select is extremely small. Click and drag to select a larger area. 

R11 Error "Could not save picture file." 

When saving a picture file to a floppy disk, this message will appear if the Write-Protect tab is 
activated. Take the floppy disk out of the drive, flip the tab the other way and try again. It 
could also appear if the disk is full. This is most likely to occur when saving to a floppy disk; 
use another disk. If the message appears when attempting to save to hard disk, delete some 
files then try again. 

R14 I am drawing thin outlined boxes but I can only see two sides of them. 
When drawing single-pixel outlined boxes at Zoom to Fit, it is sometimes difficult to see the 
whole of the box. Zoom in to see the lines clearly. If you are using PictureStitch™ simply to 
prepare a drawing for another VIP Embroidery System program, change to draw-optimized 
mode in Image Preferences. 

R15 The picture does not redraw fully as I move around the image or work with 
dialog boxes. 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 



4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

R16 There is a black box under the line of lettering I have created. 
If you press ENTER after typing letters in the Create Text dialog box, a new line is created 
with no text. This appears as a black area under the text on the PictureStitch™ screen when 
you click OK. To remove, click Undo, then click the Text icon again. Place the I-bar cursor at 
the end of the line of lettering you wish to keep, then press Delete on the keyboard a couple 
of times. Click OK again. 

R17 I am trying to Resize an area, but nothing happens when I click the Resize 
icon or select Resize from the Image Menu. 

To Resize when part of a Picture is selected, simply click and drag any of the corner handles 
of the selection box to Resize (out to increase, in to decrease). When the mouse is near a 
corner of the selection box the cursor changes from an arrow to the Resize cursor. 

R18 I am trying to Rotate an area, but nothing happens when I click the Rotate 
icon or select Rotate from the Image Menu. 

To Rotate when part of a Picture is selected, simply click and drag the round Rotation handle 
on the middle right of the selection box. Click and drag down to rotate clockwise, up to rotate 
counterclockwise. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 



If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

R23 I have bought Color PictureStitch, but I was expecting VIP Color 
PictureStitch, version 6.0 

You need to upgrade Color PictureStitch to VIP Color PictureStitch using the VIP Upgrade 
from the VIP Customizing CD. This installation will also upgrade ReSize Plus if you have that 
installed on your computer. 
1. Install Color PictureStitch (and ReSize Plusif you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 



Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

R11 Error "Could not save picture file." 

When saving a picture file to a floppy disk, this message will appear if the Write-Protect tab is 
activated. Take the floppy disk out of the drive, flip the tab the other way and try again. It 
could also appear if the disk is full. This is most likely to occur when saving to a floppy disk; 
use another disk. If the message appears when attempting to save to hard disk, delete some 
files then try again. 

R19 The stitch files I create do not have the threads from my preferred thread 
manufacturer. 

In Color Mode, the four Sulky thread colors supplied in your sample spools are always used. 
Therefore, when you open stitch files in other VIP Embroidery System programs they must 
be changed manually if desired to shades in your preferred manufacturer’s thread range. 

R24 I have no option to save as a Husqvarna Viking Pfaff (.vip) stitch file 

Your Color PictureStitch has not been upgraded to the VIP Embroidery System. You need to 
use the VIP Upgrade from the VIP Customizing CD. This installation will also upgrade 
ReSize Plus if you have that installed on your computer. 
1. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
2. Double-click on the Setup.exe file to run it. 
3. Follow the instructions to install the upgrade. 

Screen Appearance 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 



If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

R12 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPColorPict.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPColorPict.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Stitching Out 

R20 In a design for the Plus Hoop the two sections line up on one side but 
overlap slightly on the other. 



Check that the insert for the Plus Hoop is not upside down but placed correctly inside it, so 
that the markings match up to the outer hoop. The problem may still be noticeable on 
designs with little detail in the area where the two sections meet. Such files contain many 
parallel lines of running stitch and demonstrate the slight built-in curvature of the hoop. 

R22 I would like to get rid of the lines created from the white background of my 
Image File. 

After Creating and Saving Stitches, open the file in VIP Stitch Editor and use the following 
instructions. 
Monochrome Mode  
1. Use the Freehand Block Select feature to mark the stitches in the background. 
2. Click Delete Stitches. 
3. Save the adjusted Stitch File. 
Color Mode  
1. Select one of the three color changes (located in the top corners of the design and 

shown as blue circles with a white C in the middle). 
2. Click and drag it into the area of the design that you wish to keep. 
3. Repeat the two previous steps for the other two color changes. 
4. Use the Freehand Block Select feature to mark the stitches in the background. 
5. Click Delete Stitches. 
6. Save the adjusted Stitch File. 

PictureStitch Pro 
Listed versions: system 2.1 (PhotoStitch Pro); System 5, version 5.0 

Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 



If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

Error Messages 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 
check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

Stitching Out 

R20 In a design for the Plus Hoop the two sections line up on one side but 
overlap slightly on the other. 

Check that the insert for the Plus Hoop is not upside down but placed correctly inside it, so 
that the markings match up to the outer hoop. The problem may still be noticeable on 
designs with little detail in the area where the two sections meet. Such files contain many 
parallel lines of running stitch and demonstrate the slight built-in curvature of the hoop. 



R26 I would like to get rid of the lines created from the white background of my 
Image File. 

After Creating and Saving Stitches, open the file in Stitch Editor Pro and use the following 
instructions: 
1. Use the Freehand Block Select feature to mark the stitches in the background. 
2. Click Delete Stitches. 
3. Save the adjusted Stitch File. 

ReSize Plus 
Listed versions: System 5, version 5.0; System 5, version 5.5; VIP, version 6.0; VIP, version 6.2 

3D Create Stitches 

F52 I wish to change the background color for 3D Create Stitches 

Use VIP Configure to alter the background color for 3D Create Stitches. This program may 
also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 



Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

N28 Error message "Fill object is too complicated." 

Appears if a fill area is too complex for the stitch generation functions. Try changing the 
angle by as little as one degree. This often lets the shape fill correctly. Another option is to try 
moving the start point of the fill area. Occasionally, Fill Reconnection may produce a fill area 
that is too complex for the program routines to fill with stitches. In such a case, click the 
checkbox to deselect, then import the file again. Remember to click Preferences and reselect 
the Fill Reconnection option before continuing. 

N42 I have loaded a Stitch File and the areas do not look the way I expect them 
to when I click 3D Create Stitches. 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. 
Click on the first Fill Area to select it, hold the Shift key down and click on the second Fill 
Area, then click Edit, FreeHand Fill Reconnection. Occasionally an error message appear, 
stating: "Areas cannot be reconnected. Try adjusting points." The end points of the adjacent 
fill areas may not be exactly parallel. Move the points to make the lines where the two areas 
meet parallel, then try FreeHand Fill Reconnection again. 

N43 One of the fill areas on my design does not fill completely when I click 3D 
Create Stitches 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally this routine may produce a fill area 
that is too complex for the program to fill with stitches. In such a case, click the checkbox to 
deselect, then import the file again. Remember to click Preferences and reselect the Fill 
Reconnection option before continuing. 

N44 There seem to be some stitches missing in my design when I click 3D 
Create Stitches. 

When a Stitch File is loaded by View or Import, Clean CAN File removes stitches adjacent to 
a fill or satin area that do not seem to be part of the area. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Clean CAN File option before continuing. 



N45 The shape of my design does not match the original Stitch File when I click 
3D Create Stitches. 

When a Stitch File is loaded by View or Import, Minimize Points reduces the number of 
defining points generated for fill areas and produces as few satin columns as possible for an 
area. Its purpose is to make editing easier by minimizing the number of points generated for 
a Design Outline File. The checkbox is selected initially. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Minimize Points option before continuing. 

N46 The size of my Design when I click 3D Create Stitches is not the same as 
the figure I entered. 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

N47 The number of stitches in my design when I click 3D Create Stitches seems 
to vary from previous results with that design. 

Every time a Stitch File is loaded into VIP ReSize the stitch to outline file conversion process 
occurs. If you save a Stitch File after opening it in VIP ReSize, and then open the saved file, 
the conversion process will be acting on what is, in effect, a different file. Therefore areas 
could be interpreted differently and densities may change slightly, producing different figures 
when you use 3D Create Stitches. Whenever a file is edited, for example changing the shape 
of an area or altering a fill pattern, the number of stitches is likely to alter. 

Creating Stitches 

N05 I have loaded a Stitch File and the areas do not look the way I expect them 
to when I click Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. 
Click on the first Fill Area to select it, hold the Shift key down and click on the second Fill 
Area, then click Edit, FreeHand Fill Reconnection. Occasionally an error message appear, 
stating: "Areas cannot be reconnected. Try adjusting points." The end points of the adjacent 
fill areas may not be exactly parallel. Move the points to make the lines where the two areas 
meet parallel, then try FreeHand Fill Reconnection again. 

N06 One of the fill areas on my design does not fill completely when I click 
Create Stitches or Quick 3DView 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally this routine may produce a fill area 
that is too complex for the program to fill with stitches. In such a case, click the checkbox to 
deselect, then import the file again. Remember to click Preferences and reselect the Fill 
Reconnection option before continuing. 



N07 There seem to be some stitches missing in my design when I click Create 
Stitches or Quick 3D View. 

When a Stitch File is loaded by View or Import, Clean CAN File removes stitches adjacent to 
a fill or satin area that do not seem to be part of the area. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Clean CAN File option before continuing. 

N08 The shape of my design does not match the original Stitch File when I click 
Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Minimize Points reduces the number of 
defining points generated for fill areas and produces as few satin columns as possible for an 
area. Its purpose is to make editing easier by minimizing the number of points generated for 
a Design Outline File. The checkbox is selected initially. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Minimize Points option before continuing. 

N09 The size of my Design when I click Create Stitches or Quick 3DView is not 
the same as the figure I entered. 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

N10 The number of stitches in my design when I click Create Stitches or Quick 
3DView seems to vary from previous results with that design. 

Every time a Stitch File is loaded into ReSize Plus the stitch to outline file conversion 
process occurs. If you save a Stitch File after opening it in ReSize Plus, and then open the 
saved file, the conversion process will be acting on what is, in effect, a different file. 
Therefore areas could be interpreted differently and densities may change slightly, producing 
different figures when you Create Stitches. Whenever a file is edited, for example changing 
the shape of an area or altering a fill pattern, the number of stitches is likely to alter. 

N28 Error message "Fill object is too complicated." 

Appears if a fill area is too complex for the stitch generation functions. Try changing the 
angle by as little as one degree. This often lets the shape fill correctly. Another option is to try 
moving the start point of the fill area. Occasionally, Fill Reconnection may produce a fill area 
that is too complex for the program routines to fill with stitches. In such a case, click the 
checkbox to deselect, then import the file again. Remember to click Preferences and reselect 
the Fill Reconnection option before continuing. 

N42 I have loaded a Stitch File and the areas do not look the way I expect them 
to when I click 3D Create Stitches. 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. 



Click on the first Fill Area to select it, hold the Shift key down and click on the second Fill 
Area, then click Edit, FreeHand Fill Reconnection. Occasionally an error message appear, 
stating: "Areas cannot be reconnected. Try adjusting points." The end points of the adjacent 
fill areas may not be exactly parallel. Move the points to make the lines where the two areas 
meet parallel, then try FreeHand Fill Reconnection again. 

N43 One of the fill areas on my design does not fill completely when I click 3D 
Create Stitches 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally this routine may produce a fill area 
that is too complex for the program to fill with stitches. In such a case, click the checkbox to 
deselect, then import the file again. Remember to click Preferences and reselect the Fill 
Reconnection option before continuing. 

N44 There seem to be some stitches missing in my design when I click 3D 
Create Stitches. 

When a Stitch File is loaded by View or Import, Clean CAN File removes stitches adjacent to 
a fill or satin area that do not seem to be part of the area. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Clean CAN File option before continuing. 

N45 The shape of my design does not match the original Stitch File when I click 
3D Create Stitches. 

When a Stitch File is loaded by View or Import, Minimize Points reduces the number of 
defining points generated for fill areas and produces as few satin columns as possible for an 
area. Its purpose is to make editing easier by minimizing the number of points generated for 
a Design Outline File. The checkbox is selected initially. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Minimize Points option before continuing. 

N46 The size of my Design when I click 3D Create Stitches is not the same as 
the figure I entered. 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

N47 The number of stitches in my design when I click 3D Create Stitches seems 
to vary from previous results with that design. 

Every time a Stitch File is loaded into VIP ReSize the stitch to outline file conversion process 
occurs. If you save a Stitch File after opening it in VIP ReSize, and then open the saved file, 
the conversion process will be acting on what is, in effect, a different file. Therefore areas 
could be interpreted differently and densities may change slightly, producing different figures 
when you use 3D Create Stitches. Whenever a file is edited, for example changing the shape 
of an area or altering a fill pattern, the number of stitches is likely to alter. 



Design Appearance 

N01 I selected a different color for an area, but it did not change on the design 

If you have imported a stitch file then a picture is created. This picture uses the original 
colors from the file, and cannot be changed. When you change a color it will only affect the 
object outline, not the background image. This at first seems not to have done anything, but 
look closely and you will see that the outline color has changed. Create Stitches or use Quick 
3DStitch View to see your new color clearly. 

N02 I created a design using Digitizing System 5 but when I open it in Resize 
Plus the objects have changed 

If a design is imported as a stitch file, the objects are recreated. Very likely different objects 
are created. For better results, open up the Design Outline (.can) File of your design and use 
that to resize instead. 

N03 I have resized a Stitch File and the outlining stitches are loose and pull 
easily. 

When single stitches are ReSized they are increased proportionally, eg a 2mm stitch will 
become 4mm long when the file is doubled in Height or Width. If you wish these stitches to 
remain at a small size, set the Maximum Stitch Length in Preferences to a lower value and 
import the file again. This time when you Create Stitches the outline stitches should be 
smaller. The maximum length is initially set to 8mm, as otherwise Single Stitches used for 
hand stitching effects may be made smaller than desired. 

N04 A Fill Area in my Stitch File has been split into two when I loaded it into 
ReSize 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. Click on the first 
Fill Area to select it, hold the Shift key down and click on the second Fill Area, then click Edit, 
FreeHand Fill Reconnection. 
Occasionally an error message appear, stating: "Areas cannot be reconnected. Try adjusting 
points." The end points of the adjacent fill areas may not be exactly parallel. Move the points 
to make the lines where the two areas meet parallel, then try FreeHand Fill Reconnection 
again. 

N05 I have loaded a Stitch File and the areas do not look the way I expect them 
to when I click Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. 
Click on the first Fill Area to select it, hold the Shift key down and click on the second Fill 
Area, then click Edit, FreeHand Fill Reconnection. Occasionally an error message appear, 
stating: "Areas cannot be reconnected. Try adjusting points." The end points of the adjacent 



fill areas may not be exactly parallel. Move the points to make the lines where the two areas 
meet parallel, then try FreeHand Fill Reconnection again. 

N06 One of the fill areas on my design does not fill completely when I click 
Create Stitches or Quick 3DView 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally this routine may produce a fill area 
that is too complex for the program to fill with stitches. In such a case, click the checkbox to 
deselect, then import the file again. Remember to click Preferences and reselect the Fill 
Reconnection option before continuing. 

N07 There seem to be some stitches missing in my design when I click Create 
Stitches or Quick 3D View. 

When a Stitch File is loaded by View or Import, Clean CAN File removes stitches adjacent to 
a fill or satin area that do not seem to be part of the area. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Clean CAN File option before continuing. 

N08 The shape of my design does not match the original Stitch File when I click 
Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Minimize Points reduces the number of 
defining points generated for fill areas and produces as few satin columns as possible for an 
area. Its purpose is to make editing easier by minimizing the number of points generated for 
a Design Outline File. The checkbox is selected initially. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Minimize Points option before continuing. 

N09 The size of my Design when I click Create Stitches or Quick 3DView is not 
the same as the figure I entered. 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

N10 The number of stitches in my design when I click Create Stitches or Quick 
3DView seems to vary from previous results with that design. 

Every time a Stitch File is loaded into ReSize Plus the stitch to outline file conversion 
process occurs. If you save a Stitch File after opening it in ReSize Plus, and then open the 
saved file, the conversion process will be acting on what is, in effect, a different file. 
Therefore areas could be interpreted differently and densities may change slightly, producing 
different figures when you Create Stitches. Whenever a file is edited, for example changing 
the shape of an area or altering a fill pattern, the number of stitches is likely to alter. 

N41 I created a design using Digitizing but when I open it in ReSize the objects 
have changed 



If a design is imported as a stitch file, the objects are recreated. Very likely different objects 
are created. For better results, open up the CAN file of your design and use that to resize 
instead. 

Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 



Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Editing Designs 

N01 I selected a different color for an area, but it did not change on the design 

If you have imported a stitch file then a picture is created. This picture uses the original 
colors from the file, and cannot be changed. When you change a color it will only affect the 
object outline, not the background image. This at first seems not to have done anything, but 
look closely and you will see that the outline color has changed. Create Stitches or use Quick 
3DStitch View to see your new color clearly. 

N29 Error "Areas cannot be reconnected. Try adjusting points." 

This message appears, when using the FreeHand Fill Reconnection feature, if the end points 
of the adjacent fill areas may not be exactly parallel. Move the points to make the lines where 
the two areas meet parallel, then try FreeHand Fill Reconnection again. 

N30 Error "You cannot connect two fills which are separated by a color 
change." 

This message appears when using FreeHand Fill Reconnection if the two areas you are 
attempting to connect have a color change between them. Such sections cannot be 
connected, as they were not originally part of the same Fill Area. 

N31 Error "Areas are not suitable for reconnection." 

This message appears when using FreeHand Fill Reconnection if the two areas you are 
attempting to connect cannot be reconnected. Such sections cannot be connected, as they 
were not originally part of the same Fill Area. 

N34 I have added a border to a Fill Area and when I click 3D Create Stitches it is 
not the color I want it to be. 

If a border is added to a Fill Area it is given the next color in the palette. A color change is 
inserted automatically before the border, and another one returning to the color of the fill 
area after the border. This color is displayed in the Stitch File, but not in the Design Outline 
File. If you wish to change the display color, Create Stitches and Copy or Save the 
embroidery design, then Paste or Open it into VIP Customizing. 

N35 When I click the help icon to see the fill patterns available I cannot see all 
60 of them. 

The screen resolution must be 1024 x 768 or above to see the whole of the picture of the fill 
patterns. Reset the display as follows: 
1. Right-click on the desktop and a shortcut menu appears. 



2. Click on Properties and a dialog box appears. 
3. Click the Settings tab. 
4. Change the Desktop area to 1024 x 768 or greater using the slider bar. 
5. Click Apply, and allow your computer to restart if required. 

Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 



If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 



L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 



check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

N26 Error message "?.bmp not found." 

Design Outline (.can) Files can only load their Background Image if it is present and in the 
same folder as it was when the file was created. Files that were created in Embroidery 
System 5 Digitizing or Digitizing Pro may have their Background Images located in any 
folder; those produced by converting Stitch Files through View or Import into VIP ReSize 
Plus are stored in the same folder as the .can file. 

N28 Error message "Fill object is too complicated." 

Appears if a fill area is too complex for the stitch generation functions. Try changing the 
angle by as little as one degree. This often lets the shape fill correctly. Another option is to try 
moving the start point of the fill area. Occasionally, Fill Reconnection may produce a fill area 
that is too complex for the program routines to fill with stitches. In such a case, click the 
checkbox to deselect, then import the file again. Remember to click Preferences and reselect 
the Fill Reconnection option before continuing. 

N29 Error "Areas cannot be reconnected. Try adjusting points." 

This message appears, when using the FreeHand Fill Reconnection feature, if the end points 
of the adjacent fill areas may not be exactly parallel. Move the points to make the lines where 
the two areas meet parallel, then try FreeHand Fill Reconnection again. 

N30 Error "You cannot connect two fills which are separated by a color 
change." 

This message appears when using FreeHand Fill Reconnection if the two areas you are 
attempting to connect have a color change between them. Such sections cannot be 
connected, as they were not originally part of the same Fill Area. 

N31 Error "Areas are not suitable for reconnection." 

This message appears when using FreeHand Fill Reconnection if the two areas you are 
attempting to connect cannot be reconnected. Such sections cannot be connected, as they 
were not originally part of the same Fill Area. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 



Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

N27 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPReSizePlus.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPReSizePlus.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

N33 A file I loaded previously does not appear on the Recent Files menu (1, 2, 3, 
4 Command) 

Only Design Outline (.can) Files appear on this menu. Stitch Files do not. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 



then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 



5. The display should look similar to the picture to the right, with the Rainbow USB 
SuperPro device listed. 

If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 



PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N13 Embroidery System shortcuts on Desktop do not work after upgrading to 
VIP ReSize Plus 



If you have installed the upgrade for ReSize Plus on Windows 2000, and a shortcut folder of 
"Embroidery System" is created on your Desktop which does not work, then in order to fix 
this proceed as follows: 
1. Click on one of the "Embroidery System" shortcut folders on your Desktop. 
2. Press the Delete button on your keyboard. 
3. When asked to confirm that you want to delete the shortcut, click the YES button. 
4. Double-click the remaining "Embroidery System" folder on your Desktop. 
5. Right-Click on a blank area in the window. 
6. Hover your mouse button over the "New" option in the list. 
7. When a new column appears, click on the "Shortcut" option from this column. 
8. A "Create Shortcut" window will appear, click on the "Browse" button. 
9. Now use the box to locate VipReSizePlus.exe file - normally 

C:VipEmbroidery\VipReSizePlus.exe. 
10. Click on the file when you locate it, then click on the "Open" button. 
11. The previous screen should now appear, now click on the "Next" button. 
12. In the box that asks for a name for the shortcut, type VIP ReSize Plus. 

N38 I have bought ReSize Plus, but I was expecting VIP ReSize Plus, version 6.0 

You need to upgrade ReSize Plus to VIP ReSize Plus using the VIP Upgrade from the VIP 
Customizing CD. This installation will also upgrade Color PictureStitch if you have that 
installed on your computer. 
1. Install ReSize Plus (and Color PictureStitch if you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 

N40 How do I uninstall VIP ReSize Plus? 

Use the following steps to remove VIP ReSize Plus from your computer: 
1. Double-click on My Computer on your desktop. 
2. Double-click on Control Panel. 
3. Double-click on Add/Remove Programs. 
4. In the list of programs provided, scroll down until you see 'VIP Embroidery System 

Upgrade'. 
5. Highlight this and click 'Add/Remove'. 
6. Click 'Yes' to remove the VIP Upgrade from your ReSize Plus. 
7. Now find 'Husqvarna Viking ReSize Plus Embroidery System 5' in the list. 
8. Highlight this and click 'Add/Remove'. 
9. Click 'OK' to confirm you wish to remove the program. 
10. Click 'OK' to close the Add/Remove Programs window. 
Note this will also return VIP Color PictureStitch (if you have it installed) to version 5.0. If you 
wish to retain VIP Color PictureStitch, run the VIP Upgrade from the VIP Customizing CD 
once you have followed all the steps for removing VIP ReSize Plus above. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 



the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 



L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 



• Floppy disk operations were not possible within the software or within Windows Explorer, 
so it was not possible to read or write disks in VIP Disk Manager. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 



you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

N13 Embroidery System shortcuts on Desktop do not work after upgrading to 
VIP ReSize Plus 

If you have installed the upgrade for ReSize Plus on Windows 2000, and a shortcut folder of 
"Embroidery System" is created on your Desktop which does not work, then in order to fix 
this proceed as follows: 
1. Click on one of the "Embroidery System" shortcut folders on your Desktop. 
2. Press the Delete button on your keyboard. 
3. When asked to confirm that you want to delete the shortcut, click the YES button. 
4. Double-click the remaining "Embroidery System" folder on your Desktop. 
5. Right-Click on a blank area in the window. 
6. Hover your mouse button over the "New" option in the list. 
7. When a new column appears, click on the "Shortcut" option from this column. 
8. A "Create Shortcut" window will appear, click on the "Browse" button. 
9. Now use the box to locate VipReSizePlus.exe file - normally 

C:VipEmbroidery\VipReSizePlus.exe. 
10. Click on the file when you locate it, then click on the "Open" button. 
11. The previous screen should now appear, now click on the "Next" button. 
12. In the box that asks for a name for the shortcut, type VIP ReSize Plus. 

N36 I have clicked on the Tutor icon, but I cannot hear anything. 
Unless multimedia is installed on your computer (soundcard and speakers) you will not be 
able to hear the Personal Tutor messages. If you have multimedia installed, check that the 
speakers are plugged in and that the volume has not been turned down. 

N38 I have bought ReSize Plus, but I was expecting VIP ReSize Plus, version 6.0 

You need to upgrade ReSize Plus to VIP ReSize Plus using the VIP Upgrade from the VIP 
Customizing CD. This installation will also upgrade Color PictureStitch if you have that 
installed on your computer. 
1. Install ReSize Plus (and Color PictureStitch if you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 

N40 How do I uninstall VIP ReSize Plus? 

Use the following steps to remove VIP ReSize Plus from your computer: 
1. Double-click on My Computer on your desktop. 
2. Double-click on Control Panel. 
3. Double-click on Add/Remove Programs. 



4. In the list of programs provided, scroll down until you see 'VIP Embroidery System 
Upgrade'. 

5. Highlight this and click 'Add/Remove'. 
6. Click 'Yes' to remove the VIP Upgrade from your ReSize Plus. 
7. Now find 'Husqvarna Viking ReSize Plus Embroidery System 5' in the list. 
8. Highlight this and click 'Add/Remove'. 
9. Click 'OK' to confirm you wish to remove the program. 
10. Click 'OK' to close the Add/Remove Programs window. 
Note this will also return VIP Color PictureStitch (if you have it installed) to version 5.0. If you 
wish to retain VIP Color PictureStitch, run the VIP Upgrade from the VIP Customizing CD 
once you have followed all the steps for removing VIP ReSize Plus above. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

B16 When I try to open a Pes file the error message "Unrecognized file format" 
appears 

The Pes format has been updated since the release of these programs. Download the 
update of the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to version 1.05. 

B18 I am trying to load a file and the message "Can't open design file" appears. 
This message appears if the design file is corrupt or if it has the extension '.vip' but is not a 
true VIP Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). 

L18 Error "Cannot open stitch file." 

This message appears if the desired Stitch File is not where the program expects it to be, for 
example if a Stitch File was loaded into the program from a floppy disk, then closed and the 
floppy disk removed. The message would appear if you tried to load the design from the 
Recent Files list on the File Menu. 



L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L22 Error: "Unrecognized file extension" when opening a file 

This message appears if you attempt to load a file with an extension that does not belong to 
any Stitch File types. For example, it would appear if you tried to Drag and Drop a .doc file 
onto the VIP Customizing screen.  

N04 A Fill Area in my Stitch File has been split into two when I loaded it into 
ReSize 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. Click on the first 
Fill Area to select it, hold the Shift key down and click on the second Fill Area, then click Edit, 
FreeHand Fill Reconnection. 
Occasionally an error message appear, stating: "Areas cannot be reconnected. Try adjusting 
points." The end points of the adjacent fill areas may not be exactly parallel. Move the points 
to make the lines where the two areas meet parallel, then try FreeHand Fill Reconnection 
again. 

N26 Error message "?.bmp not found." 

Design Outline (.can) Files can only load their Background Image if it is present and in the 
same folder as it was when the file was created. Files that were created in Embroidery 
System 5 Digitizing or Digitizing Pro may have their Background Images located in any 
folder; those produced by converting Stitch Files through View or Import into VIP ReSize 
Plus are stored in the same folder as the .can file. 

N32 I can't drag and drop stitch files from Windows® Explorer onto the Work 
Area 

Only Design Outline (.can) Files may be opened using Drag and Drop. Stitch Files cannot. 

N33 A file I loaded previously does not appear on the Recent Files menu (1, 2, 3, 
4 Command) 

Only Design Outline (.can) Files appear on this menu. Stitch Files do not. 

N37 I tried to open a Design Outline (.can) File but nothing happens 



Resize Plus System 5 and VIP ReSize Plus version 6.0 can only open Design Outline (.can) 
Files created itself, or by Digitizing System 5 or earlier. Open the .can file back into VIP 
Digitizing and resize or edit it there. 

N39 I have no option to open or save Husqvarna Viking Pfaff (.vip) stitch files 

Your ReSize Plus has not been upgraded to the VIP Embroidery System. You need to use 
the VIP Upgrade from the VIP Customizing CD. This installation will also upgrade Color 
PictureStitch if you have that installed on your computer. 
1. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
2. Double-click on the Setup.exe file to run it. 
3. Follow the instructions to install the upgrade. 

N41 I created a design using Digitizing but when I open it in ReSize the objects 
have changed 

If a design is imported as a stitch file, the objects are recreated. Very likely different objects 
are created. For better results, open up the CAN file of your design and use that to resize 
instead. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 



Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

N38 I have bought ReSize Plus, but I was expecting VIP ReSize Plus, version 6.0 

You need to upgrade ReSize Plus to VIP ReSize Plus using the VIP Upgrade from the VIP 
Customizing CD. This installation will also upgrade Color PictureStitch if you have that 
installed on your computer. 
1. Install ReSize Plus (and Color PictureStitch if you have it). 
2. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
3. Double-click on the Setup.exe file to run it. 
4. Follow the instructions to install the upgrade. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 



3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 



3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

N05 I have loaded a Stitch File and the areas do not look the way I expect them 
to when I click Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally there may be areas that the 
automatic routine does not link that it would be desirable to reconnect. This may be 
attempted using the FreeHand Fill Reconnection option on the Edit Menu. 
Click on the first Fill Area to select it, hold the Shift key down and click on the second Fill 
Area, then click Edit, FreeHand Fill Reconnection. Occasionally an error message appear, 
stating: "Areas cannot be reconnected. Try adjusting points." The end points of the adjacent 
fill areas may not be exactly parallel. Move the points to make the lines where the two areas 
meet parallel, then try FreeHand Fill Reconnection again. 

N06 One of the fill areas on my design does not fill completely when I click 
Create Stitches or Quick 3DView 

When a Stitch File is loaded by View or Import, Fill Reconnection links adjacent areas of fill 
or step stitch together to make one Fill Area. Occasionally this routine may produce a fill area 
that is too complex for the program to fill with stitches. In such a case, click the checkbox to 
deselect, then import the file again. Remember to click Preferences and reselect the Fill 
Reconnection option before continuing. 

N07 There seem to be some stitches missing in my design when I click Create 
Stitches or Quick 3D View. 

When a Stitch File is loaded by View or Import, Clean CAN File removes stitches adjacent to 
a fill or satin area that do not seem to be part of the area. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 



the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Clean CAN File option before continuing. 

N08 The shape of my design does not match the original Stitch File when I click 
Create Stitches or Quick 3DView. 

When a Stitch File is loaded by View or Import, Minimize Points reduces the number of 
defining points generated for fill areas and produces as few satin columns as possible for an 
area. Its purpose is to make editing easier by minimizing the number of points generated for 
a Design Outline File. The checkbox is selected initially. Occasionally this may result in a 
lack of clarity on a particular shape compared to the original stitch file. In such a case, click 
the checkbox to deselect, then import the file again. Remember to click Preferences and 
reselect the Minimize Points option before continuing. 

N09 The size of my Design when I click Create Stitches or Quick 3DView is not 
the same as the figure I entered. 

The size is set according to the distance between the two outermost control points of the 
Design File. The Objects of the Design File may extend outside this line, so the size of the 
actual stitch file may exceed the length that was inputted. 

N10 The number of stitches in my design when I click Create Stitches or Quick 
3DView seems to vary from previous results with that design. 

Every time a Stitch File is loaded into ReSize Plus the stitch to outline file conversion 
process occurs. If you save a Stitch File after opening it in ReSize Plus, and then open the 
saved file, the conversion process will be acting on what is, in effect, a different file. 
Therefore areas could be interpreted differently and densities may change slightly, producing 
different figures when you Create Stitches. Whenever a file is edited, for example changing 
the shape of an area or altering a fill pattern, the number of stitches is likely to alter. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

L23 Error: "Unrecognized file extension" when saving a file 

This message appears if you type an incorrect extension that does not belong to any Stitch 
File types in the File Name box when trying to save a file. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 



Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

N18 I can't save .Can files in Windows 95 and Windows 98 for the French or 
German versions of ReSize Plus v5.5 

Copy the ReSizePlus.ini file from the root of the main Professional System CD to the 
Windows folder and overwrite the existing ReSizePlus.ini file. The toolbars will now revert to 
the English titles if they are moved off their standard positions. 

N39 I have no option to open or save Husqvarna Viking Pfaff (.vip) stitch files 

Your ReSize Plus has not been upgraded to the VIP Embroidery System. You need to use 
the VIP Upgrade from the VIP Customizing CD. This installation will also upgrade Color 
PictureStitch if you have that installed on your computer. 
1. Using Windows Explorer, open the 'VIP Upgrade' folder on your VIP Customzing CD. 
2. Double-click on the Setup.exe file to run it. 
3. Follow the instructions to install the upgrade. 

Screen Appearance 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

B22 I have changed the screen background color and now I wish to return to 
the original light blue 

Use the Screen Preferences to change the background color. Follow the instructions in 
Screen Preferences and select the RGB values 200, 232, 247 in the Color Window. 

F52 I wish to change the background color for 3D Create Stitches 

Use VIP Configure to alter the background color for 3D Create Stitches. This program may 
also be used to turn the texture on or off. 



N27 I can't see some of the floating toolbars or icons when I open the program. 
First, check the View Menu to see whether the view function has been turned off. If all the 
View Toolbar functions are turned on and you still cannot locate a toolbar, it may have been 
moved to the edge of the screen so it is hard to see. If you move icons around it is possible 
to delete them. 
To reset the icons 
1. Close the program. 
2. Copy the VIPReSizePlus.ini file from the root folder of your CD. (If your VIP software was 

installed from a multi-language CD, you will find the .ini file in the relevant language 
folder. For instance, if you installed the English version of the software, you will find the 
.ini file in the "English" folder.) 

3. Paste it into the \Windows folder of your computer's hard drive. 
4. Right-click the pasted VIPReSizePlus.ini file and select the Properties option from the 

popup menu. 
5. In the Properties dialog, un-check the Read Only check box and click OK. 
6. You can now restart the program and all the toolbars will be in their original positions. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Stitching Out 

L14 My design stitches out of alignment on my Pfaff or Janome machine 

In Husqvarna Viking Cross Stitcher (verison 3.0x), ReSize Plus (5.0) and 3DConvert & Sort 
(5.0), some designs that were created in Pfaff (.pcs) and Janome/New Home (.sew) and then 
sewn out on the appropriate machine may move out of alignment. Upgrade to version 1.05 of 
the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to correct this. 

N03 I have resized a Stitch File and the outlining stitches are loose and pull 
easily. 

When single stitches are ReSized they are increased proportionally, eg a 2mm stitch will 
become 4mm long when the file is doubled in Height or Width. If you wish these stitches to 
remain at a small size, set the Maximum Stitch Length in Preferences to a lower value and 
import the file again. This time when you Create Stitches the outline stitches should be 
smaller. The maximum length is initially set to 8mm, as otherwise Single Stitches used for 
hand stitching effects may be made smaller than desired. 

3DView & Convert 
Listed versions: System 5, version 5.0 



Background Image 

P05 Why can't I load any backgrounds? 

There are several possible answers to this: 
• Check you are using 3DView & Convert and not trying to open a background into Quick 

3DViewTM. The only background this can have is the green knitwear. 
• You cannot use Open to find a background, ensure you are using the 'Load Background' 

button or menu option. 
• Your graphics card may be causing the backgrounds to not appear. See FAQ #P06 for 

an answer. 

P06 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users:  
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'.Most likely the pointer is set to 'Full'. 
8. Move the slider all the way to the left for 'None'. 
9. Click 'OK' on both the windows to close them and try to view in 3DView & Convert again. 

If it now works you can try to place the slider into the optimum position. This is where the 
slider is at the rightmost, but still allows the 3DView & Convert to work. This can only be 
down by trial and error; change the slider setting and test to see if you can still view in 
3DView & Convert . 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the Settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled '3D Settings (OpenGL)'. 
8. Uncheck the option 'Use 3D acceleration'. 
9. Click 'OK' on both the windows to close them and try to view in 3DView & Convert again. 

Design Appearance 

P01 Why do some jump stitches show up in 3DView & Convert? 



The 3Dstitch program has a feature which will automatically remove jump stitches from the 
view. Sometimes it is not possible to determine what is a jump stitch, which would be 
manually trimmed out, and what is just a long stitch. In the event of a stitch being either, it is 
not removed from the display. 
If you have a design with these stitches showing and prefer to remove them, then the file can 
be adjusted using Stitch Editor Pro: 
1. Load the design into Stitch Editor Pro. 
2. To make the task easier we need to get a clear view of the jump stitch to be hidden. Do 

this by moving the 'Draw From Start' and 'Draw From End' sliders to hide all unnecessary 
stitches. Then use the 'Zoom In' tool around the stitch to magnify the display. 

3. If there is no stitch point midway along the jump stitch then you will have to insert one. To 
do this, select 'Insert Stitches' and click halfway along the jump stitch line. Click on the 
right mouse button to cancel the function. Then convert this stitch to a jump stitch; select 
'Insert Jump Stitch' and click on the new stitch point. 

4. By now, whether or not a new stitch point was inserted, the jump should have least one 
point along its length. For example:  

 
Stitch point in the center of a jump sti 

 
5. Select this stitch by using 'Block Box', and then clicking onto the stitch point. 
6. Move the point far to one side. This has the effect of increasing the size and angle of the 

jump stitch, thus ensuring the program sees it as a jump, and not a long stitch. For 
example:  

 
Move stitch point to angle the jump stit 

 
7. Repeat this if you have any other jump stitches which are showing in 3Dstitch. 
8. Save the design. 
9. View the design in 3DView & Convert, if the stitch is still showing you will have to move 

the midway point further. 

Error Messages 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 



L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 
check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

P02 My copy of 3DView & Convert will not run, and I get the error message 
'Failed to Create Empty Document' 

There are two possible reasons why 3DView & Convert will not run correctly: 
• 3DView & Convert will not execute correctly if you have your display options set too low. 

This program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 
6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
7. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
8. If you are unable to alter your display, consult your computer retailer. 



• If you are an owner of the full Professional System, then your copy of 3DStitch requires 
the dongle. It may not be correctly inserted. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

Installation and CD 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 



you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

P02 My copy of 3DView & Convert will not run, and I get the error message 
'Failed to Create Empty Document' 

There are two possible reasons why 3DView & Convert will not run correctly: 
• 3DView & Convert will not execute correctly if you have your display options set too low. 

This program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 
6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
7. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
8. If you are unable to alter your display, consult your computer retailer. 
• If you are an owner of the full Professional System, then your copy of 3DStitch requires 

the dongle. It may not be correctly inserted. 

P07 My program crashes whenever I try to view in 3DView & Convert 
This is for the same reason as FAQ #P06, please refer to this answer. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 



1. On the original CD find the ".ini" file corresponding to the program; it has the same name 
as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

P02 My copy of 3DView & Convert will not run, and I get the error message 
'Failed to Create Empty Document' 

There are two possible reasons why 3DView & Convert will not run correctly: 



• 3DView & Convert will not execute correctly if you have your display options set too low. 
This program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 
6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
7. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
8. If you are unable to alter your display, consult your computer retailer. 
• If you are an owner of the full Professional System, then your copy of 3DStitch requires 

the dongle. It may not be correctly inserted. 

P04 Can I back up my database? 

The database files should be backed up regularly. First make sure the 3DView & Convert 
program is closed. In 'C:\HusqPro' these is a folder called 'Infos' which contains two files; 
index.dat and info.dat. Copy these to a floppy disk or other form of removable storage, label 
them with the date the backup was made and store in a safe place in case your computer 
hard disk becomes faulty. 

P07 My program crashes whenever I try to view in 3DView & Convert 
This is for the same reason as FAQ #P06, please refer to this answer. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

Printing 

P03 My designs do not print in 3D 



Before continuing, make sure that you are using the correct function. Two buttons are 
located on the toolbar, and only one, Print 3D, will print in 3D with the background. Also, if 
you choose Print All or Print Book, from the search results, then these do not print the 3D 
image either. There is a lot of data involved with sending a full 3D image with background to 
the printer and this may be slowing your printer down and preventing it from printing at all. 
There are a few steps you can try: 
1. Use the most up-to-date driver for your printer. 
2. Check you have plenty of free space on your hard drive, at least 20MB. 
3. Defragment your hard drive (from the Start menu, choose Programs, Accessories, 

System Tools, Disk Defragmenter). 
4. Try using a lower setting on your printer (eg. draft mode, low dpi, high speed). 
5. If your printer options offer alternative ways of printing, try changing these. 
6. If all these fail, try using older printer drivers. We have had some users who have 

managed to get results from a previous version of a printer driver. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

Stitching Out 

L14 My design stitches out of alignment on my Pfaff or Janome machine 

In Husqvarna Viking Cross Stitcher (verison 3.0x), ReSize Plus (5.0) and 3DConvert & Sort 
(5.0), some designs that were created in Pfaff (.pcs) and Janome/New Home (.sew) and then 
sewn out on the appropriate machine may move out of alignment. Upgrade to version 1.05 of 
the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to correct this. 

ColorSort 
Listed versions: System 5, version 5.0 

Error Messages 

B16 When I try to open a Pes file the error message "Unrecognized file format" 
appears 

The Pes format has been updated since the release of these programs. Download the 
update of the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to version 1.05. 



L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

Installation and CD 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 



If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 



Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

Opening and Browsing Designs 

B16 When I try to open a Pes file the error message "Unrecognized file format" 
appears 

The Pes format has been updated since the release of these programs. Download the 
update of the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to version 1.05. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 



1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 



1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

Stitching Out 

L14 My design stitches out of alignment on my Pfaff or Janome machine 

In Husqvarna Viking Cross Stitcher (verison 3.0x), ReSize Plus (5.0) and 3DConvert & Sort 
(5.0), some designs that were created in Pfaff (.pcs) and Janome/New Home (.sew) and then 
sewn out on the appropriate machine may move out of alignment. Upgrade to version 1.05 of 
the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to correct this. 

3DStitch Pro 
Listed versions: Version 1.51; System 5, version 5.0; Version 1.5 

Background Image 

H05 Why can't I load any backgrounds? 

There are several possible answers to this: 
• Check you are using 3DView & Convert and not trying to open a background into Quick 

3DViewTM. The only background this can have is the green knitwear. 
• You cannot use Open to find a background, ensure you are using the 'Load Background' 

button or menu option. 
• Your graphics card may be causing the backgrounds to not appear. See FAQ #H06 for 

an answer. 



H06 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to not function correctly then you must lower 
the graphics acceleration provided by the card: 
For Windows® 95/98/ME users:  
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'.Most likely the pointer is set to 'Full'. 
8. Move the slider all the way to the left for 'None'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. If it 

now works you can try to place the slider into the optimum position. This is where the 
slider is at the rightmost, but still allows the 3DStitch Pro to work. This can only be down 
by trial and error; change the slider setting and test to see if you can still view in 3DStitch 
Pro. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the Settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled '3D Settings (OpenGL)'. 
8. Uncheck the option 'Use 3D acceleration'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. 

Design Appearance 

H01 Why do some jump stitches show up in 3D Stitch Pro? 

The 3Dstitch program has a feature which will automatically remove jump stitches from the 
view. Sometimes it is not possible to determine what is a jump stitch, which would be 
manually trimmed out, and what is just a long stitch. In the event of a stitch being either, it is 
not removed from the display. 
If you have a design with these stitches showing and prefer to remove them, then the file can 
be adjusted using Stitch Editor Pro: 
1. Load the design into Stitch Editor Pro. 
2. To make the task easier we need to get a clear view of the jump stitch to be hidden. Do 

this by moving the 'Draw From Start' and 'Draw From End' sliders to hide all unnecessary 
stitches. Then use the 'Zoom In' tool around the stitch to magnify the display. 

3. If there is no stitch point midway along the jump stitch then you will have to insert one. To 
do this, select 'Insert Stitches' and click halfway along the jump stitch line. Click on the 



right mouse button to cancel the function. Then convert this stitch to a jump stitch; select 
'Insert Jump Stitch' and click on the new stitch point. 

4. By now, whether or not a new stitch point was inserted, the jump should have least one 
point along its length. For example:  

 
Stitch point in the center of a jump sti 

 
5. Select this stitch by using 'Block Box', and then clicking onto the stitch point. 
6. Move the point far to one side. This has the effect of increasing the size and angle of the 

jump stitch, thus ensuring the program sees it as a jump, and not a long stitch. For 
example:  

 
Move stitch point to angle the jump stit 

 
7. Repeat this if you have any other jump stitches which are showing in 3Dstitch. 
8. Save the design. 
9. View the design in 3DStitch, if the stitch is still showing you will have to move the midway 

point further. 

Error Messages 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

H02 My copy of 3D Stitch will not run, and I get the error message 'Failed to 
Create Empty Document' 

There are three possible reasons why 3D Stitch will not run correctly: 
• 3D Stitch will not execute correctly if you have your display options set too low. This 

program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 



6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 
greater. 

7. Click Apply. The screen will be adjusted, then another message will appear asking if you 
wish to keep these settings. Click OK to continue (let the computer restart if required). 

If you are unable to alter your display, consult your computer retailer. 
• If you downloaded the free bonus program, it is only for owners of the full Professional 

Embroidery System. If you are unsure which system you are using, run Customizing and 
look at the name on the title bar at the top. If it reads 'Customizing Pro' then you are 
eligible for the 3D Stitch Bonus program. 

• If you are an owner of the full Professional System, then your copy of 3DStitch requires 
the dongle. It may not be correctly inserted. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L35 Error "Copyright verification. Program CD not detected. Copyright 
verification procedure failed." 

This error can appear when starting Embroidery System 5 programs after upgrading from 
Windows 95/98/ME to Windows 2000 or XP. This is happening because the software was 
installed under one user name and you are attempting to use the software with a different 
user name. There are three ways you can work around this: 
• Uninstall the software using the user name it was installed under, then log in using the 

required user name and reinstall the software. 
or 
• Find the exe file for the program (for instance, customiz.exe). Right-click the exe and 

select the Run As option. Enter the user name and password that the software was 
installed under and the program will start. This will only work for one session of the 
program 

or 
• Right-click the shortcut to the program and select Properties. In Windows 2000, check 

the "Run as different user" box then click OK. In Windows XP, click the Advanced button, 
check the "Run with different credentials" box, click OK and click OK again. Each time 
you use this shortcut to start the program, you will be prompted for the correct User 
Name and Password. 

Icons and Toolbars 

A08 Hints on Customizing toolbars 



It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

Installation and CD 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

H02 My copy of 3D Stitch will not run, and I get the error message 'Failed to 
Create Empty Document' 

There are three possible reasons why 3D Stitch will not run correctly: 
• 3D Stitch will not execute correctly if you have your display options set too low. This 

program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 
6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
7. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 
• If you downloaded the free bonus program, it is only for owners of the full Professional 

Embroidery System. If you are unsure which system you are using, run Customizing and 
look at the name on the title bar at the top. If it reads 'Customizing Pro' then you are 
eligible for the 3D Stitch Bonus program. 



• If you are an owner of the full Professional System, then your copy of 3DStitch requires 
the dongle. It may not be correctly inserted. 

H07 My program crashes whenever I try to view in 3DStitch Pro 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users:  
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'.Most likely the pointer is set to 'Full'. 
8. Move the slider all the way to the left for 'None'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. If it 

now works you can try to place the slider into the optimum position. This is where the 
slider is at the rightmost, but still allows the 3DStitch Pro to work. This can only be down 
by trial and error; change the slider setting and test to see if you can still view in 3DStitch 
Pro. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the Settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled '3D Settings (OpenGL)'. 
8. Uncheck the option 'Use 3D acceleration'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 



Miscellaneous 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

H02 My copy of 3D Stitch will not run, and I get the error message 'Failed to 
Create Empty Document' 

There are three possible reasons why 3D Stitch will not run correctly: 
• 3D Stitch will not execute correctly if you have your display options set too low. This 

program must be run with at least a screen size of 800 x 600 pixels and high color 
(16bit): 

1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Change the Desktop area to 800 x 600 or greater. 



6. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 
greater. 

7. Click Apply. The screen will be adjusted, then another message will appear asking if you 
wish to keep these settings. Click OK to continue (let the computer restart if required). 

If you are unable to alter your display, consult your computer retailer. 
• If you downloaded the free bonus program, it is only for owners of the full Professional 

Embroidery System. If you are unsure which system you are using, run Customizing and 
look at the name on the title bar at the top. If it reads 'Customizing Pro' then you are 
eligible for the 3D Stitch Bonus program. 

• If you are an owner of the full Professional System, then your copy of 3DStitch requires 
the dongle. It may not be correctly inserted. 

H04 Can I back up my database? 

The database files should be backed up regularly. First make sure the 3DStitch™ Pro 
program is closed. In 'C:\HusqPro' these is a folder called 'Infos' which contains two files; 
index.dat and info.dat. Copy these to a floppy disk or other form of removable storage, label 
them with the date the backup was made and store in a safe place in case your computer 
hard disk becomes faulty. 

H07 My program crashes whenever I try to view in 3DStitch Pro 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users:  
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'.Most likely the pointer is set to 'Full'. 
8. Move the slider all the way to the left for 'None'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. If it 

now works you can try to place the slider into the optimum position. This is where the 
slider is at the rightmost, but still allows the 3DStitch Pro to work. This can only be down 
by trial and error; change the slider setting and test to see if you can still view in 3DStitch 
Pro. 

For Windows® NT/2000 users, your options may vary depending on your Graphics Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. 
4. Click on the Settings tab at the top. 
5. Click on the Advanced button. 
6. Select the Performance tab at the top of the new window. 
7. You should now see a box labeled '3D Settings (OpenGL)'. 



8. Uncheck the option 'Use 3D acceleration'. 
9. Click 'OK' on both the windows to close them and try to view in 3DStitch Pro again. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

Opening and Browsing Designs 

B01 I am trying to open a file and the message "Can't open design file" appears 

This message appears if the design file is corrupt or if it has the extension '.hus' but is not a 
true Husqvarna Embroidery System file (for example if it is another type of file that has been 
renamed by mistake). Alternatively, the association of .hus files properties could be incorrect; 
check the File Properties. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

B14 When I use the View function (Camera icon) the program crashes 

There is a corrupt file in the directory you are trying to view. If the program crashes before 
you are able to select a file then this corrupt file is in the last directory you browsed. 
To find the corrupt file use File > Open to individually open each file in this directory. When a 
file is reported to be corrupt use Windows® Explorer to delete it. 

Printing 

H03 My designs do not print in 3D 

Before continuing, make sure that you are using the correct function. Two buttons are 
located on the toolbar, and only one, Print 3D, will print in 3D with the background. Also, if 
you choose Print All or Print Book, from the search results, then these do not print the 3D 
image either. There is a lot of data involved with sending a full 3D image with background to 
the printer and this may be slowing your printer down and preventing it from printing at all. 
There are a few steps you can try: 
1. Use the most up-to-date driver for your printer. 
2. Check you have plenty of free space on your hard drive, at least 20MB. 
3. Defragment your hard drive (from the Start menu, choose Programs, Accessories, 

System Tools, Disk Defragmenter). 
4. Try using a lower setting on your printer (eg. draft mode, low dpi, high speed). 
5. If your printer options offer alternative ways of printing, try changing these. 



6. If all these fail, try using older printer drivers. We have had some users who have 
managed to get results from a previous version of a printer driver. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

Cross Stitch 
Listed versions: Version 3.0; Version 3.01; Version 3.02 

Creating and Editing Designs 

N15 I have selected Triple thread in Stitch Generation Preferences, but the 
thread doesn't appear thicker 

The changes made to the number of threads cannot be viewed in the program or when 
Creating Stitches, only as information in the Thread Colors box. 

N16 Why can't I select the Pfaff color palette? 

There is no fixed color palette for Pfaff machines; therefore it is not one of the available 
machine manufacturer's palettes. 

N17 I can't select my machine manufacturer's color palette in Wizard Screen 1 

Only the eight thread databases, not machine manufacturers' palettes, are available for the 
initial color mapping in the Wizard. This is because photographic images cannot easily be 
reduced to such a small number of colors; a wider range of colors is desirable, as found in 
the thread databases. 

N19 I am trying to erase part of my design, but it doesn't all disappear 
The eraser deletes the selected type of stitch from the squares of the grid. For example, it is 
necessary to select Line Stitches separately to erase Outlines. 

N23 The letters in my cross stitch monogram are running into each other 
In general, cross stitch text looks better at larger sizes - the recommended size for Cross 
Stitch Text is 12-14 pts or above. Font styles vary in their suitability for Cross Stitch - the best 
way to see how the text looks is in the Preview box. Bold fonts are more likely to have 
overlapping characters. 



Creating Stitches 

L17 I have exported a design in .sew format, and two files have been created 

Janome software cannot load designs with more than 12 colors. If a file to be exported in 
.sew format has more than 12 color changes, it will automatically be split into multiple files, 
with the last character of the filename "1", "2", and so on. 

N20 When I Create Stitches the design has a different number of stitches than 
when I view it in other programs 

The number of stitches shown in the Create Stitches window is an approximation and may 
not match the number of stitches shown when the saved stitch file is loaded into other 
embroidery programs. 

Design Appearance 

N15 I have selected Triple thread in Stitch Generation Preferences, but the 
thread doesn't appear thicker 

The changes made to the number of threads cannot be viewed in the program or when 
Creating Stitches, only as information in the Thread Colors box. 

Error Messages 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

Icons and Toolbars 

N24 Some of the icons in the Toolbar are 'grayed out' when I open the Cross 
Stitch Program 

Certain icons are only highlighted once a Cross Stitch Design (.krz) File is shown on the 
screen. Other icons are only highlighted if part or all of a Design is selected. 

Installation and CD 

A23 I have already installed my software but whenever I insert the CD it starts to 
install again 

Cross Stitch has an automatic installation whenever the CD is inserted. You may hold down 
the Shift Key for 30 seconds upon insertion to prevent the installation menu appearing. There 



is no need to go though the installation procedure again. If the Welcome window does 
appear, simply click 'Cancel' and then 'Exit Setup' to quit the installation, allowing you access 
to the CD. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 



• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 
be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 

Miscellaneous 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 

All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

B02 I can't drag and drop designs from the Open or View dialog boxes 

To drag and drop designs onto the Display Area, use Windows Explorer. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 



ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

N11 Why does the program sometimes ask for the CD when I run it? 

To ensure you own the original program CD, a Copyright Verification Procedure will take 
place at random intervals. When you are prompted to insert your program CD do so and then 
you will be able to continue using your program. When you insert the CD, hold down the Shift 
key for 30 seconds to prevent the Installation menu appearing. 

N12 When I enter my CD for verification it is not recognized 

This will happen if the drive letter of the CD has changed from when the program was 
installed, such as when another drive is installed. To correct this you will need to either re-
map your drive letters or re-install the program. 



Opening Designs 

N14 I can't drag and drop Cross Stitch Design files from the Open dialog box 

To drag and drop Cross Stitch Design Files onto the Work Area, right-click Start, then 
Explore to start Windows® Explorer. Then follow the instructions under Drag and Drop in the 
Loading Files chapter of the program Help. 

Printing 

N21 My printout shows a different number of stitches than when I view the 
design in other programs 

The number of stitches shown in the Print Preview window and on the printout is an 
approximation and may not match the number of stitches shown when the saved stitch file is 
loaded into other embroidery programs. 

Q01 When I send my design to the printer, nothing prints 

Some systems will not print anything at all should your printout span over two pages. The 
program goes through the process of printing and you will see the progress bars, but no print 
dialog box appears. This may simply be resolved by using the latest printer driver for your 
printer. Otherwise download and install the Cross Stitcher 3.02 Update 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_crossstitc
her.htm]. 

Product Information 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 



Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Screen Appearance 

N22 I can't see the Background Grid, even though it is turned on in Grid and 
Background Preferences 

When you zoom out, the Background Grid may not be able to be viewed, depending on the 
chosen cross size and the resolution of your screen. The large hoop size will not show the 
grid at Zoom to Fit unless you are using a high screen resolution. A message will be shown 
on the Status Bar: "Zoom in to see grid"; if the grid is turned off it says so. 

Stitch Files 

L17 I have exported a design in .sew format, and two files have been created 

Janome software cannot load designs with more than 12 colors. If a file to be exported in 
.sew format has more than 12 color changes, it will automatically be split into multiple files, 
with the last character of the filename "1", "2", and so on. 

Stitching Out 

N25 The thread shades in my design don't match the colors of the picture in 
Wizard Screen 2 

When using the Cross Stitch Wizard to create designs automatically, the colors are mapped 
to their nearest match in your chosen thread manufacturer's database. To change the color 
mapping you can either use another manufacturer's threads, or try Starting From a higher 
number of colors in Wizard Screen 1. R-A Rayon is especially suited to QuickCross creation 
of designs from photos, as it has a particularly good range of pink and brown "flesh" tones. 

Q02 My design stitches out of alignment 
If you are saving your files from Cross Stitcher as Pfaff (.pcs) or Janome/New Home (.sew) 
then please also refer to FAQ #Q03. When stitching out a design from Cross Stitcher you are 



working on a grid of squares. Unlike any other type of embroidery design you cannot add 
compensation, or overlap objects to allow for pull of the fabric. If you fabric is not hooped up 
correctly then gaps can appear between sections, sometimes appearing that stitches are 
missing altogether. Use extra backing and ensure the fabric is tight in the hoop. Lowering the 
number of cross threads and enlarging the cross size also helps. 

Q03 My design stitches out of alignment on my Pfaff or Janome machine 

In version 3.0x of the Husqvarna Viking Cross Stitcher, some designs that were created in 
Pfaff (.pcs) and Janome/New Home (.sew) and then sewn out on the appropriate machine 
may move out of alignment. Upgrade to version 1.05 of the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_pro_crossstitc
her.htm] to correct this. 

Format Conversion Pro 
Listed versions: Version 1.50; Version 1.51; Version 1.6; Version 5.0 

Installation and CD 

A05 Installing Digitizing 95 or Format Conversion Pro with Microsoft Internet 
Explorer 4 or Windows 98 

Digitizing 95 (versions up to and including 4.2) and Format Conversion Pro (versions up to 
and including 1.5) use a file which is incompatable with I.E.4 (Windows 95 or 98). If these 
programs are installed on the computer and then I.E.4 installed there will be no problems. If 
these programs are installed with I.E.4 on the computer when the computer re-boots 
Windows will report an error with Explorer and will fail to start. This can be avoided by 
proceeding as follows when installing these programs : 
1. At the end of installation do not select to re-boot the computer. 
2. Using the Windows Explorer delete the file Wininit.ini in the Windows directory. The 

computer system is now safe to re-start. 
Alternatively download the updated file Wininit.ini 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ie4] and copy it to Disk 2 of the digitizing system overwriting the old file. For the Format 
Conversion Pro use the same file and overwrite the old Wininit.ini on the Disk. Then install as 
normal. If you have already installed the programs and now cannot get your copy of 
Windows to start, download the file Comctl32.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#ie4] and proceed as follows :- 
1. Re-boot the computer. 
2. Press F8 to get the Start up Menu. 
3. Select Command Prompt Only. 
4. When the system comes up at the C:\ prompt insert a disk with the new Comctl32.dll file 

and copy it to C:\Windows\System. 
5. Re-boot system, the system will re-start as normal. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 



The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

Pro System 
Listed versions: Version 2.1; System 5; System 5.5; Plus, system 6 (VIP) 

Dongle 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Error Messages 

A03 When I install Husqvarna Professional embroidery System from my CD, I 
get the error message 'File Not Found: D:/EMNETFILE.DLL' 

Your system cannot find the file EMNETFILE.DLL on your CD because it seems that your 
CD driver is DOS-based and can't read file names longer than 8 characters. To complete 



installation you must get the latest driver for your CD, which must be compatible with 
Windows'95. 

A14 What could cause the "No dongle attached" error message? 

Check the code key is securely snapped into the dongle and that the dongle is plugged into 
the parallel port marked LPT1, LPT2 or PRINTER of the computer, or the output port marked 
DONGLE or PRINTER on the Reader/Writer.  

 
Dongle Code-Key hole close-up 

 Some dongles (security devices) have a manufacturing fault which causes a dongle not 
found error. Remove the code key (the circular device that looks like a battery) and check the 
metal is broken in the two places displayed below. Check both sides of the dongle, and if all 
is clear replace the code key and try again. If you are using a switch box check that the 
switch is in the correct position. Ensure the dip switches on the Reader/Writer are in the 
correct position. If you are using a zip drive check the set-up is as described above. If you 
have manually installed the program check that you have copied the "Vsauthd.vxd" file to the 
Windows\System directory. 
If you still have a problem proceed as follows: 
1. Place the dongle directly on the Printer port. If it is now OK, suspect a damaged or poor 

quality printer cable lead - replace it with Husqvarna approved cable. 
2. Check the version number of your software. Digitizing version 4.11 (or above) has 

improvements in the Dongle code to work with different types of printer ports. If you do 
not own version 4.11 or higher then contact your dealer for a free upgrade. 

A20 When I re-install the Professional Embroidery System 5, I get the message 
'An error occurred during the move data process: - 103' 

This error occurs when re-installing the Professional Embroidery System 5 and you still have 
the Application Bar active. Close the Application Bar, by right-clicking on the bar and 
selecting 'Exit', and try again. If the Application Bar is not visible then hold down Control and 
Alt, and press Del; the Close Program window appears. Select 'Husqvarna Viking Application 
Bar' and click 'End Task' to close it. Then try to re-install again. 

A22 When installing version 5.5 the message "Setup has detected a version of 
The Husqvarna Viking Professional Embroidery System on your machine" 
appears 

Before installing the program you must uninstall the old program. This will not delete any files 
you may have created. To uninstall select this option in the program group Husqvarna Viking 
Professional System 5. If the message still appears use Windows Explorer to search for 
CustomPro.exe, if this is found it must be removed from the system. If the message still 
appears check that CustomPro.exe is not in the Recycle bin, if it is remove it. After 
uninstalling the earlier version try installing again. 



A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 



For more information use the FAQ Search Wizard for your dongle type. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Icons and Toolbars 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 

Installation and CD 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 
You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

A03 When I install Husqvarna Professional embroidery System from my CD, I 
get the error message 'File Not Found: D:/EMNETFILE.DLL' 

Your system cannot find the file EMNETFILE.DLL on your CD because it seems that your 
CD driver is DOS-based and can't read file names longer than 8 characters. To complete 



installation you must get the latest driver for your CD, which must be compatible with 
Windows'95. 

A04 Installing Husqvarna Professional System version 2.1 with Windows 98 

I have Windows '98 on my computer and while I was installing the Husqvarna Professional 
Embroidery System version 2.1 CD an error appeared which prevented the installation from 
completing. 
Automatic installation of the sample files does not work under Windows 98. Install the 
programs only, then copy the sample folders from the CD manually (HusqPro and its 
subdirectories) 
1. Start the installation again, but this time select 'Install programs only'. 
2. Once the installation is complete, run Windows Explorer (from the Start; Programs 

menu). 
3. Find the CD drive icon in the left-hand column; you may have to move the slider down to 

see it. Click on this icon and the contents of the CD will appear in the right-hand side. 
4. Locate the 'Husqpro' folder icon and click on it with the right mouse button, A menu will 

appear; click on 'Copy'. 
5. Now find the C: drive on the left-hand column; you may have to move the slider back to 

the top. 
6. Right-click on the icon and a different menu will appear; click on 'Paste'. 
7. If you had installed the software to the default location C:\HUSQPRO then a 'Confirm 

Folder Replace' box will appear, click on 'Yes to All'. Another box will then appear entitled 
'Confirm File Replace'; again click on 'Yes to All'. 

8. All the sample files and guides will be installed onto your hard drive. 
Creating empty folders to use for help exercises: (optional) If desired, create some empty 
folders ready for your own files to be put into. 
1. On the left-hand column find 'Husqpro', which is listed somewhere underneath the C: 

drive icon. 
2. If this is not visible click on the plus symbol next to the C: drive icon. 
3. Next to 'Husqpro' is either a plus or a minus symbol. If this is a plus, then click on it; more 

folders will appear and the symbol becomes a minus. 
4. Click on the folder 'convert1' and 'convert1' will appear on the right-hand side. 
5. Move the mouse pointer to the blank space beneath the 'convert1' icon and click with the 

right mouse button. 
6. A menu will appear; move the mouse pointer to 'New' and another menu will appear. 
7. Click on 'Folder'. Now a folder icon will appear with 'New Folder' highlighted by it. 
8. Type 'convert2' and press Enter. You have just created a new folder. 
9. Now return to the left-hand column and find the 'Design' folder, which is below 'Convert'. 
10. Click on it and some folders will appear on the right-hand side. As before, right-click on a 

blank area beneath these icons to get the menu with 'New' and then click on 'Folder' on 
the second menu. 

11. Type in 'Bmp2' and press Enter. 
12. Repeat this to create two more folders with the names 'Can2' and 'Hus2'. 
13. Again return to the left-hand column and click on 'Hus', which is below 'Design'. 
14. On the right-hand side use the above procedure to create two folders called 'Hus2' and 

'Samples2'. 
15. Installation is now complete. 

A17 I have already installed my software but whenever I insert the CD it starts to 
install again 



All System 5 software has an automatic installation whenever the CD is inserted. You may 
hold down the Shift Key for 30 seconds upon insertion to prevent the installation menu 
appearing. There is no need to go though the installation procedure again. If the Welcome 
window does appear, simply click ' Cancel' and then 'Exit Setup' to quit the installation, 
allowing you access to the CD. 

A20 When I re-install the Professional Embroidery System 5, I get the message 
'An error occurred during the move data process: - 103' 

This error occurs when re-installing the Professional Embroidery System 5 and you still have 
the Application Bar active. Close the Application Bar, by right-clicking on the bar and 
selecting 'Exit', and try again. If the Application Bar is not visible then hold down Control and 
Alt, and press Del; the Close Program window appears. Select 'Husqvarna Viking Application 
Bar' and click 'End Task' to close it. Then try to re-install again. 

A22 When installing version 5.5 the message "Setup has detected a version of 
The Husqvarna Viking Professional Embroidery System on your machine" 
appears 

Before installing the program you must uninstall the old program. This will not delete any files 
you may have created. To uninstall select this option in the program group Husqvarna Viking 
Professional System 5. If the message still appears use Windows Explorer to search for 
CustomPro.exe, if this is found it must be removed from the system. If the message still 
appears check that CustomPro.exe is not in the Recycle bin, if it is remove it. After 
uninstalling the earlier version try installing again. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 



Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 



To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L30 The programs are not being installed to the correct directory  
The installation program will by default put the embroidery system onto the fixed disk or 
partition with the most amount of free space. 
The drive letter that the embroidery system will install to is shown during the install and can 
be changed by the user. 
The drive or partition that the embroidery system is installed to will make no difference to its 
operation. 



L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L36 I have received my free Husqvarna Viking Professional Upgrade Kit 4 but 
there were no manuals in the kit 

The Husqvarna Viking Professional Upgrade Kit 4 is not supplied with printed manuals. 
However, the manuals are supplied on the upgrade CD as PDF documents that you can 
view on screen or print. They are in the 'User Guides' folder on the CD. 
Alternatively, consult the Help system in each program for information on how to use the 
program features. 

Miscellaneous 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 
You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

A08 Hints on Customizing toolbars 

It is possible to move and add icons to toolbars without entering the Customize Tools dialog 
box using the Alt and AltGr buttons. If you click on an icon while holding down the Alt key, 
the button can be dragged and dropped to another toolbar. If it is not dropped on a toolbar it 
is removed from view. 
If you click on a toolbar button while holding down the AltGr key, or the Ctrl and Alt keys 
together, the button is duplicated. If it is dragged and dropped onto another toolbar, the 
duplicate will be positioned there. If it is not placed on another toolbar, then a new one is 
created with this button on. If a toolbar is dragged back to the sides or top of the program 
window its name disappears and a separator is shown between this and other toolbars. 
Lost buttons can be retrieved within the Customize dialog box, under Tools, Customize. If 
you wish to reset the toolbars exactly as they were when the program was installed, use the 
following instructions. 
1. On the original CD find the ".ini" file corresponding to the program; it has the same name 

as the executable file except it has the file extension ".ini" instead of ".exe". For example, 
VIP Customizing requires the file "Customiz.ini". 

2. Copy this file into C:\Windows (or wherever your main Windows folder is stored). 
3. Now the program will start with the same configuration as when it was first installed. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 



Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 



Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L08 I have not received any free updates for my Professional System 

Please ensure that you have sent in your registration form from your Professional 
Embroidery System package. Then, when new updates are available, you will receive 
notification on how to obtain it. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 



• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

L25 Whenever I insert my CD it asks if I want to uninstall my software 

All VIP Embroidery System Software has an automatic installation whenever the CD is 
inserted. The CD detected your software was already installed so only gives you the option 
to uninstall it. Simply click 'Cancel', and then 'Yes' to confirm it. Then click 'Finish' to close 
the installation window. Whenever using the CD again you may hold down the Shift Key for 
30 seconds upon insertion to prevent the installation menu appearing. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

L32 My VIP programs are very slow to close 

This can happen on Windows® NT/2000/XP when virus protection software is installed. This 
will affect many applications, not just the VIP programs. 
To solve this, your virus protection software must allow you to choose the file types that it 
checks. You can then improve performance by preventing the virus protection software from 
checking files with the extension “.ini”. This will have a negligible effect on security. To find 
out how to do this, you may find it helpful to look at the documentation or consult the 
software support for your virus protection software. 
For example, in McAfee VirusScan V4.5 onwards: 
1. Double-click the VShield icon in the System Tray and the System Scan Status dialog 

appears. 
2. Click the Properties button in the dialog box that appears. 
3. On the Detection tab, select the User specified files option. 
4. Click the Extensions... button and you will see a list of file type extensions. 
5. Scroll down the list until you see “IN?” and click this entry (the “?” means any file 

extension starting with “IN” followed by any letter or number). 
6. Click the Delete button and the “IN?” entry is removed from the list. 
7. Click OK to close the list, click OK to close the Properties dialog, then Close the System 

Scan Status dialog. The effect is immediate, even if you already have a VIP program 
open. 

L33 I keep changing the Preferences but they don’t stay changed when I restart 
the program 

This happens if the “.ini” file is Read Only, such as when the “.ini” is copied from the CD 
using Windows® Explorer. This also affects the Toolbars if you use the Customize Toolbars 
and Commands features. You can change the Read Only attribute as follows: 
1. Use Windows® Explorer to go to the C:\Windows directory (or the directory where you 

installed Windows on your computer). 
2. Right-click on the “.ini” file for the program and choose the Properties option from the 

popup menu. 
3. Un-check the Read Only option and click OK. You will now be able to change your 

Preferences without them being reset. 



Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 

L08 I have not received any free updates for my Professional System 

Please ensure that you have sent in your registration form from your Professional 
Embroidery System package. Then, when new updates are available, you will receive 
notification on how to obtain it. 

L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 



• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Quick 3DStitch View 

L34 I have downloaded the 3D Viewer DLL version 2.0 but it has had no effect 
The new 3D Viewer DLL is intended for use with the VIP System (version 6.0 onwards). If 
you have a previous version of software then it will not be used. 
Also, the new DLL provides fixes that bypass the features on some graphics cards that 
prevented the previous 3D viewer from working correctly. If your graphics system was 
already working correctly then you may not notice any improvement. 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 



9. If it now works you can try to place the slider into the optimum position. This is where the 
slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M05 I wish to change the background color for Quick 3DStitch™ View 



Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

M06 Error "QuickView requires a color palette of High Color (16 bit) or higher." 

This message appears when attempting to display a design using the Quick 3DStitch™ View 
if your computer is set to a display of 256 colors or less. You must have your screen colors 
set to High Color (16 bit) or greater (True Color, 24-bit)). Reset the display as follows: 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M11 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then download the relevant language 
version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

M12 The background does not appear in the Quick 3DStitch™ View window 
even though it is switched on in VIP Configure or the Quick 3DStitch™ 
View window does not display designs correctly, for example there is a 
'hole' in the design 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card. This may clear 
the problem instantly. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the program functions incorrectly even with the latest driver, then download the relevant 
language version of the 3D Viewer DLL Version 2.0 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#3dvi
ewer] from the Husqvarna Viking Software web site. When the download is complete, 
double-click on the downloaded file to install the new DLL to your VIP Embroidery system. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 



The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Embroidery Shop 
Listed versions: Version 1.0; Version 2.0; Version 2.01; Version 3.0 

Installation and CD 

A09 Installation conflict with Microsoft Intellimouse or other scrolling mouse 
drivers 

If you are installing Husqvarna Embroidery Shop or Plus Borders and Fonts and you use a 
mouse with a scrolling wheel, then you must close your mouse driver first. If you are unsure 
on how to close it, then do the following: 
1. Press Ctrl-Alt-Del to open the 'Close Program' window. 
2. Find the name of your mouse driver in the list. (Microsoft's mouse is called MS Wheel). 
3. Highlight this mouse driver. 
4. Click 'End Task' and the bottom of the window. 
5. Now install the software. 
6. Reboot your computer to restart the mouse driver. 

A18 After installing Embroidery Shop version 3, it will not run 

If it continually asks for the CD letter and refuses to continue even if you enter the correct 
letter then this is caused by old files from Embroidery Shop version 2 on your system. Simply 
select uninstall and reinstall version 3 again. 

A19 When I install Embroidery Shop or Plus Borders and Fonts, I get the 
message 'Isinst30. An error has occurred in your program' 

This inst30 error message is caused by software for a mouse with a scroll wheel or third 
button. See FAQ #A09 for details on how to install your software. 

J04 When I enter my CD drive letter it does not accept it 
When asked for the CD Drive letter, just enter that letter (such as D or E) and no symbols 
(such as : or \). Otherwise it will not be able to locate your CD. 



Miscellaneous 

J01 I have been using the CD-ROM Editor for some time; now it won't open my 
Embroidery Library. What could have changed? 

In your Owner's Collection screen, click on Defaults, Catalog Location. Check the location of 
the CD-ROM drive and change it to correspond with the letter of your CD-ROM drive. 

J02 Can I add designs to my Owner's Collection from a floppy disk? 

Yes, you can; however, you must have that floppy in the drive when attempting to access the 
design later. The Owner's Collection only has a thumbnail image of the design; the actual 
stitch information is retrieved from its original location when the user clicks this thumbnail 
image. 

J03 Is there a manual for the Embroidery Shop On-line Catalog and Editor? 

The instruction manual is included in the CD-ROM Editor. Directions for installation and 
printing out are on the inside front cover of the CD-ROM jacket: 
For Windows 95:  
1. Click on Start and select Programs > Husqvarna Embroidery Shop > Install Guide. 
2. Follow screen instructions - when you see a box come up stating that installation is 

complete, close all open windows to get back to the Windows 95 desktop. 
3. Click on Start and select Programs > Husqvarna Embroidery Shop > Guide or Creative 

Guide. 
4. The instruction manual will come up on the screen. You can then print it out. 

Plus Borders & Fonts 
Listed versions: Version 1.0; Version 2.0 

Installation and CD 

A09 Installation conflict with Microsoft Intellimouse or other scrolling mouse 
drivers 

If you are installing Husqvarna Embroidery Shop or Plus Borders and Fonts and you use a 
mouse with a scrolling wheel, then you must close your mouse driver first. If you are unsure 
on how to close it, then do the following: 
1. Press Ctrl-Alt-Del to open the 'Close Program' window. 
2. Find the name of your mouse driver in the list. (Microsoft's mouse is called MS Wheel). 
3. Highlight this mouse driver. 
4. Click 'End Task' and the bottom of the window. 
5. Now install the software. 
6. Reboot your computer to restart the mouse driver. 

A19 When I install Embroidery Shop or Plus Borders and Fonts, I get the 
message 'Isinst30. An error has occurred in your program' 

This inst30 error message is caused by software for a mouse with a scroll wheel or third 
button. See FAQ #A09 for details on how to install your software. 



K01 When I enter my CD drive letter it does not accept it 
When asked for the CD Drive letter, just enter that letter (such as D or E) and no symbols 
(such as : or \). Otherwise it will not be able to locate your CD. 

Miscellaneous 
Listed versions: Not Applicable 

Demos and Documentation 

L02 I get an error message when I try to open documents in Acrobat Reader, 
either from CD or when I download from this web site. 

Errors such as 'Unable to open document' or 'Could not find ColorSpace named Cs8' appear 
because you are trying to use an old version of Acrobat Reader. Make sure you are using 
the latest version of Acrobat (version 4 or above). 
If you have ReSize Plus, 3DConvert & Sort, or Cross Stitcher then you can install the current 
version from there, simply insert the CD and select the option from the menu that appears. 
Alternatively go to the Acrobat Page at Adobe's web site [http://www.adobe.com] where you 
can download the latest copy and also check for any conflicting software you may have on 
your machine. 

L11 When I view the Designer I Demo, Apple QuickTime opens but doesn't play 
it. 

Apple QuickTime 2.02 associates itself with MPEG movies but is unable to play them. 
Upgrade to the latest version of QuickTime 
[http://www.apple.com/quicktime/download/indext.html] or run Windows® Media Player (Start 
> Programs > Accessories > Entertainment > Windows Media Player for Windows® 98, or 
Start > Programs > Accessories > Multimedia > Media Player for Windows® 95) and use File 
> Open to open the file. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 



L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

Product Information 

L07 What is the price of the software, and where can I get it? 

Please contact your local dealer for prices and availability on all the Husqvarna Viking 
software. To find your local dealer see the Husqvarna Viking Dealer Locator 
[http://www.sew.husqvarna.se/dealers.htm]. You can always find this on the bottom bar of 
the Husqvarna Viking Software website. 



L09 Can I run the software on a Macintosh computer? 

Husqvarna Viking Software is made to run on a PC with Windows®95/98/ME/NT/2000/XP 
and we can not guarantee that our software will work on a Macintosh computer. There are 
ways of running PC software on MAC computers by use of emulators such as Virtual PC and 
Soft Windows. 
However, Husqvarna Viking can not support, by way of phone help or warranty, the use of 
our software on Macintosh computers and recommends that you purchase a standard 
Windows® based PC to use our embroidery systems. 
To use any of the Husqvarna Viking System 5 software, or previous versions, you require a 
parallel-port dongle and maybe the parallel-port Reader/Writer Unit, which the MAC does not 
usually have. Therefore you must buy a bi-directional parallel port for this purpose. 
If you still wish to use our software on a Macintosh computer, the following information may 
be of help. Please note that this DOES NOT constitute support and no support will be offered 
or provided for using Husqvarna Viking Software in the manner described below. 
PLEASE NOTE: Husqvarna Viking Software has not been tested with any Windows® 
emulation software on Mac OS X. 
Husqvarna Viking Professional Plus has been tested and shown to run on a Macintosh G4 
using the following configuration: 
• Mac OS 9.0.4 
• Memory: 786Mb 
• Virtual PC 4.0 running Windows® ME 
Virtual PC 4.0 was configured as follows: 
• Processor: “Enable MMX compatibility” checked 
• PC Memory: 460MB 
• USB:“Enable USB” checked, “USB-232 Adapter” unchecked and “USB Token” (dongle) 

checked 
Husqvarna Viking Professional Plus ran normally as on any other Windows platform. 
However, the following was found in regard to hardware and communications: 
• The “USB Token” option is only be available in the USB section of Virtual PC when the 

dongle is inserted into the MAC. 
• Restarting the Mac with the dongle inserted gives a message that 'The software cannot 

be found for USB Token'. This message is generated by OS 9, which does not use the 
dongle. Click OK to close the message and carry on as normal. 

• The USB Reader/Writer worked correctly. (The parallel Reader/Writer was not tested.) 
• No communication could be established with the dCard Reader/Writer. 
• Floppy disk operations were not possible within the software or within Windows Explorer, 

so it was not possible to read or write disks in VIP Disk Manager. 

M08 What hardware do I need for my machine? 

To be able to send designs to your machine you will need: 
Rose #1+ / Orchidea 
• Reader/Writer unit for USB port (part number 412 7219-01) 
• or Reader/Writer unit for parallel port (part number 412 6007-02 *) 
Designer II 
• d-Card Reader/Writer unit (part number 412 6278-01) 



Designer I 
• 3.5" floppy disk drive for your computer 
* This part number is for the US only. For other countries please contact your local dealer - 
Husqvarna Viking Dealer Locator [http://www.sew.husqvarna.se/dealers.htm]. 

Quick 3DStitch View 

M01 Some designs appear upside-down when I view them in 3D 

Some corrupt designs do appear upside down in Quick 3DStitch View. For some reason, the 
height of the design is stored as a negative number. If you combine the file first and then 
view it, it should appear correctly. 

M02 Nothing appears when I try to use Quick 3DStitch View in any of my System 
5 programs 

You must have your screen colors set to High Color (16 bit) or greater (True Color, 24-bit). 
1. First close any programs you are using. 
2. Right-click the mouse on the desktop and a pop-up menu will appear. 
3. Left-click on Properties and the Display Properties dialog box will appear. 
4. Click the Settings tab. 
5. Use the drop-down arrow in the box titled Color Palette to select High Color (16-bit) or 

greater. 
6. Click Apply. The screen will be adjusted, then another message will appear asking if you 

wish to keep these settings. Click OK to continue (let the computer restart if required). 
If you are unable to alter your display, consult your computer retailer. 

M03 My background image does not appear, or only partly appears 

Your graphics card driver is misinterpreting the 3D calculations from the program. Check that 
you have downloaded and installed the latest drivers for your graphics card, this may clear 
the problem instantly. If the latest driver is still causing the program to not function correctly 
then you must lower the graphics acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 



3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M04 My program crashes whenever I try to view my Design in 3D 

Check that you have downloaded and installed the latest drivers for your graphics card, this 
may clear the problem. 
Anti-virus software can prevent correct installation of graphics drivers. Disable your anti-virus 
software while installing new graphics drivers. 
If the latest driver is still causing the program to crash then you must lower the graphics 
acceleration provided by the card: 
For Windows® 95/98/ME users: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled 'Hardware acceleration' with a slider marked 'None' to 

'Full'. 
7. Most likely the pointer is set to 'Full'. Move the slider all the way to the left for 'None'. 
8. Click 'OK' on both the windows to close them and try to view in Quick 3D View again. 
9. If it now works you can try to place the slider into the optimum position. This is where the 

slider is at the rightmost, but still allows the 3D View to work. This can only be down by 
trial and error; change the slider setting and test to see if you can still view in Quick 3D 
View. 

For Windows® NT/2000 users, your options may vary depending on your Graphics 
Card: 
1. Close all programs. 
2. Right-click on an empty spot on your desktop to get a menu and choose Properties. 
3. The Display Properties window appears. Click on the Settings tab at the top. 
4. Click on the Advanced button. 
5. Select the Performance tab at the top of the new window. 
6. You should now see a box labeled '3D Settings (OpenGL)'. 
7. Uncheck the option 'Use 3D acceleration'. 
8. Click 'OK' on both the windows to close them and try to view using Quick 3DStitch View 

again. 

M07 The program crashes occasionally when viewing 3D 

If the program crashes when viewing in 3D after using a Hewlett Packard Deskjet 930c 
printer, then you must update the printer driver program from driver 'hpz9xd02.drv' version 
4.00 onwards. 

Stitch Files 

A02 I do not have the Husqvarna logos beside each file in Windows® Explorer 



You need to set your associations so that your computer can link the Husqvarna logo to any 
HUS files: Restart your computer. 
1. Start the Customizing program directly (using the Start Menu or the Application Bar) 
2. Close the Customizing program immediately, this should be enough to reset the file 

association. 
3. If this has not fixed the association, see FAQ #B03 for resetting file associations. 

B03 I get an error message when I open my HUS file from Windows Explorer 
When you double-click on a HUS file from explorer it should open that file into the 
Customizing Software. This relies on the computer knowing which programs are associated 
with which files. It seems that somehow this association may have been confused and would 
have to be restored. To restore this association, do the following: 
1. Go to Windows Explorer and go to the 'View' menu and choose 'Options' (or 'Folder 

Options'). 
2. Click on the 'File Types' tab. 
3. Find 'Stitch Document' in the list and click on it. 
4. Click 'Remove', when asked for confirmation, click 'Yes'. 
5. Click 'OK' to close the Options box. 
6. Run Customizing by finding it in the Start menu (go to Start, Programs, Husqvarna Viking 

Embroidery System 5, Customizing). 
7. Close the Customizing program immediately, this is enough to reset the association. 
8. Now Shut Down and Restart the computer. 
9. Your HUS files should now be associated correctly. 

L10 I have saved my design as Tajima format, but it now has more colors 

If your original design had a stop command in it then this would be replaced by a color 
change, thus adding a color for every stop you have in your design. As the Tajima file format 
does not have a stop command in its format, it requires the machine operator to manually 
enter stops into the machine. If you save or distribute files in Tajima format, then you must 
also specify all colors and stops and where they occur in the design. 

L14 My design stitches out of alignment on my Pfaff or Janome machine 

In Husqvarna Viking Cross Stitcher (verison 3.0x), ReSize Plus (5.0) and 3DConvert & Sort 
(5.0), some designs that were created in Pfaff (.pcs) and Janome/New Home (.sew) and then 
sewn out on the appropriate machine may move out of alignment. Upgrade to version 1.05 of 
the Multitype.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_sys5_general
.htm#mul] to correct this. 

L31 I do not have the VIP logos beside each file in Windows Explorer 
Your icon association is set up during installation. You will have to re-install. 

QuickFont 
Listed versions: VIP, version 6.0; VIP, version 6.1 



Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 



The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

A32 What could cause the "No dongle attached" error message? 

 
• Make sure that the dongle is connected to the computer, disconnect any devices such as 

printers that may be attached. 
• Check that the dongle is plugged into the parallel port marked LPT1, LPT2 or PRINTER 

of the computer. 
• If you are using a switch box check that the switch is in the correct position. 
If you still have a problem then place the dongle directly on the Printer port. 

Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 



If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

A32 What could cause the "No dongle attached" error message? 

 
• Make sure that the dongle is connected to the computer, disconnect any devices such as 

printers that may be attached. 
• Check that the dongle is plugged into the parallel port marked LPT1, LPT2 or PRINTER 

of the computer. 
• If you are using a switch box check that the switch is in the correct position. 
If you still have a problem then place the dongle directly on the Printer port. 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Font Disks 

V03 Error "No disk in drive." 

This message will appear when you have checked the Make Disk option, but have not put a 
floppy disk in the drive before clicking Next on the Output Options page. Disk creation is 
skipped, so if you wanted to create the disk, click Back on the Print Options page, insert a 
floppy disk and click Next again. 

V04 Error "Font is too large to fit onto one disk. Three font disks will be created, 
one for each menu. Continue?" 

As you increase the Output Size, the number of stitches required to build each character will 
increase. If the characters are very large then the combined number of stitches for all the 



characters may mean that the full character set will not fit on a single floppy disk. This 
message will appear, allowing you to make a three-disk set. 

V05 Error "This font is too big to fit onto one disk, or even onto three disks. 
Continue?" 

As you increase the Output Size, the number of stitches required to build each character will 
increase. If the characters are very large then the combined number of stitches for all the 
characters may mean that the character set will not fit onto floppy disks, even when divided 
according to the three character menus. This message will appear to inform you of this 
situation. If you click OK then any other font saving options will be used, but no floppy disks 
will be made. 

V10 I am having problems writing stitch files to a floppy disk. 
First try another disk. If the problems are limited to one disk, try formatting it fully. If you still 
experience problems, dispose of it. 

V11 No disks have been written because the characters have so many stitches. 
Occasionally the characters may be so large that they will not even fit on three disks. In this 
case, no disks will be written. For a Designer I Disk, you should use VIP Disk Manager to 
copy individual characters. For a Tajima disk, you can us VIP Customizing to copy individual 
characters. 

V12 The kerning character < does not work for my Designer I font disk. 
Ensure you are using Designer I software version 1.41 or later, as this feature is not 
available in earlier versions. 

Fonts 

V01 "Error processing character X. Continue generating font?" 

This occurrs when a particular character, or part of a character, is very complex and the font 
conversion routine is unable to make an appropriate shape from the character. You have the 
option to Continue or Cancel. If you continue then the character will not be converted. The 
other characters will be processed normally. 

V02 Error "Font is too thin, wouldn't do fill" 

This is specific to Fill and Fill + Satin Border. This error means that the font is so thin in 
places that the fill stitches would be too short for embroidering and could potentially damage 
your embroidery machine. In this case, font conversion is abandoned. You can work around 
this by selecting the bold version of the font, or alternatively use Satin, Satin Border or 
Appliqué. 

V06 I can't select a font that is on my computer in VIP QuickFont. 
VIP QuickFont is designed to work with Windows TrueType® and OpenType ® fonts. VIP 
QuickFont does not support Postscript Type 1 fonts. To check Font Properties: 
1. Click Start, Control Panel, Fonts. 
2. Click the desired font to select it. 



3. Right-click and select Properties from the menu that appears. 
4. Check Type of file. If it is PostScript Metrics it will not work with VIP QuickFont. 

V07 The letters appear larger in the preview boxes than when the font is 
generated. 

When characters are displayed a calculation is made so that the largest character can be 
displayed within the box with all the characters at the same scale. For the preview, only the 
characters ABab are calculated, but when the font is generated all the characters are used. 
Often there are characters with sections higher or lower than the uppercase A, therefore the 
scale used when the font is generated may be smaller. 

V08 The letters appear to be different sizes when I browse them with the VIP 
Customizing Design View dialog. 

This happens because the characters are different widths, and the Design View dialog 
zooms in on each character to make it fill its thumbnail box. Hence, the thumbnails of wider 
characters, such as W and M, may make the characters look smaller than they really are. 
Load the characters into VIP Customizing and you will see that they are the correct sizes. 

V09 I am having trouble with converting a symbol font to the desired size. 
The sizes of the shapes in a symbol font often vary in size within a single font. The size of 
converted fonts is set by specifying the height of the uppercase letter A, or whichever symbol 
or character occupies its position in the font (ASCII character 65). This may affect your 
converted symbols if the symbol at ASCII 65 is a lot smaller or larger than other symbols in 
the font. If your symbols convert to unexpectedly small or large sizes, compare the symbols 
by selecting the font in a word processor and typing on your keyboard. Type in A and some 
other letters to see how the corresponding shapes differ in size from the shape for A. 
Alternatively, type in some letters in a normal font then select the letters and change them to 
the required symbol font. 
There is a free word processor called WordPad supplied with all versions of Windows® from 
Windows® 95 onwards. Use WordPad to check a symbol font when you have no other word 
processing facilities. 

V13 Error "<i>stitch type</i> requires an output size of between "<i>xx</i> and 
"<i>yy</i> mm" 

This message will appear when you try to set the Output Size too low or too high for the 
chosen Stitch Type. Change the Output Size accordingly. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 



1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

Miscellaneous 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

Quick 3DStitch View 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 

Saving Designs 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

Screen Appearance 

M05 I wish to change the background color for Quick 3DStitch™ View 

Use VIP Configure to alter the background color for Quick 3DStitch™ View. This program 
may also be used to turn the texture on or off. 



Stitch Files 

L12 Error: "Design too large for export format" when saving a file in .pes format 
The Pes5 format allows for any design size up to 260mm x 160mm. Download MulCType.dll 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#pes
5] version 1.0.3.3, or later, to allow designs up to this size to be saved in .pes format. 

3D Organizer 
Listed versions: VIP, version 6.0 

Browsing Files 

L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

X04 "Warning. 5,000 files have been found. Program performance may be 
affected. Do you wish to continue?" 

This message appears if 5,000 files are found by a Search or in a single folder. Click Yes to 
continue listing more files. Click No to stop and only show the 5,000 files found so far. Click 
Cancel to stop and clear the Thumbnail Pane so that no files are shown. 

X05 Error: "15,000 files have been found. No more files will be displayed. To see 
other files, move to a different folder or change the search criteria." 

This message appears if 15,000 files are found by a Search or in a single folder. VIP 3D 
Organizer will stop displaying additional files. If you have been making a search, change the 
Look in: folder or add more information to refine the search criteria. If you are browsing a 
folder, copy some files to another location. 

X20 Thumbnails are taking a long time to appear on my computer. 
In VIP 3D Organizer, you can increase the speed for showing thumbnails by displaying 2D 
thumbnails. Go to Thumbnail Preferences and make sure that 3D Thumbnails is not 
checked. If desired, you may also turn off the textured background in VIP Configure for faster 
browsing. 

X21 I cannot select a Zip file to see its contents. 



This happens in VIP 3D Organizer when a Zip file is stored within another Zip file. VIP 3D 
Organizer will not browse the contents of a Zip file if it is stored within another Zip file. Use 
Copy, Copy To Folder or Move To Folder to place the Zip file in a location where you will be 
able to browse its contents. 

X22 I can’t see some of my embroidery files in the Thumbnail Pane, even 
though I can see them listed in the folder in Windows® Explorer. 

Embroidery files that are corrupt or invalid will be ignored by VIP 3D Organizer. For instance, 
a text file that has been renamed so it has a .vip extension is not a valid embroidery file so it 
will be ignored. 
Try using View, Refresh to see files that have been added to the current folder. 
The file type may have been deselected from the File Types tab in Preferences. Try the 
following: 
1. Open VIP 3D Organizer. 
2. Browse to the folder containing the files. 
3. Click on the Preferences icon on the Edit toolbar. 
4. Click on the File Types tab. 
5. Click on the "Select All Embroidery" button. 
6. Click OK to close the Preferences dialog. All valid embroidery files will be shown. 
The embroidery file may not be included by the settings on your Filter tab of Preferences. Try 
the following: 
1. Open VIP 3D Organizer. 
2. Browse to the folder containing the files. 
3. Click on the Preferences icon on the Edit toolbar. 
4. Click on the Filter tab. 
5. Ensure that the Maximum Hoop size setting is set to None and that both checkboxes are 

unticked. 
6. Click OK. This will clear all filters on the showing of embroideries. 
If the embroidery is still not shown, use the Search facility to try to find the embroidery file. It 
may be possible that you may have unknowingly moved the embroidery file from its original 
location. 
If you are still not able to see the required embroidery, use Windows Explorer to ensure that 
the files that you expected are still in this location. Also check the Recycle Bin. 

X23 The other folders collapse when I click a folder to browse its contents. 
In the Folder Pane in VIP 3D Organizer, you can use the + signs to expand the folders 
without selecting them to browse their contents. However, when you click a folder to browse 
it, all other expanded folders are collapsed automatically. If desired, you can use the + signs 
to expand them again. 

X26 I can’t see some of my picture files in the Thumbnail Pane, even though I 
can see them listed in the folder in Windows® Explorer. 

Picture files that are corrupt or invalid will be ignored by VIP 3D Organizer. For instance, a 
text file that has been renamed so it has a .jpg extension is not a valid JPEG picture file so it 
will be ignored. 
Try using View, Refresh to see files that have been added to the current folder. 
The file type may have been deselected from the File Types tab in Preferences. Try the 
following: 



1. Open VIP 3D Organizer. 
2. Browse to the folder containing the files. 
3. Click on the Preferences icon on the Edit toolbar. 
4. Click on the File Types tab. 
5. Click on the "Select All Pictures" button. 
6. Click OK to close the Preferences dialog. All valid picture files will be shown. 
If the picture is still not shown, use the Search facility to try to find the picture file. It may be 
possible that you may have unknowingly moved the picture file from its original location. 
If you are still not able to see the required picture, use Windows Explorer to ensure that the 
files that you expected are still in this location. Also check the Recycle Bin. 

Converting Files 

B50 Error: "Design too large for export format" 

Certain formats are limited to the number of stitches they can save or the size of hoop used 
on their specific embroidery machine, for example .sew. If you attempt to save a file in this 
format that is bigger than the largest available hoop size or has more stitches than are 
allowed, this message would appear. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

X06 "Conversion is not possible for the selected file format." 

This message appears if you attempt to convert a picture or Zip file to an embroidery file 
format, or to convert a Zip file to a picture. Use only embroidery files for conversion to 
embroidery file formats. 

X07 Error: "Unable to open file." 

This message appears when converting files if a file you are attempting to convert is no 
longer available. For example, if the file was on a floppy disk and the floppy disk has been 
removed. In this situation, replace the floppy disk. 

X08 Error: "Unable to create file." 

This message appears when converting files if there is a problem with the target location for 
a file. For example, when saving converted files to removable media (such as a floppy disk 
or CD) and the media is removed part way through the conversion process, or if a target file 
is read-only so it may not be overwritten. Make sure the target location is accessible. 

X09 Error: "Unable to create folder." 



When converting files, you can type in a folder name to create one new folder and you will be 
prompted to create the new folder. This message will then appear if the folder name contains 
characters that may not be used for folder names (such as quotes, other punctuation marks, 
etc.), more than one new folder would be created or you have attempted to create a folder in 
a location that may not be used (such as an empty floppy drive). Ensure the folder name and 
location are correct. 

Desktop Background 

X25 Nothing happens when I use any of the Set As Desktop Background 
options. 

This happens when you have Internet Explorer 5.0 or 5.5 installed and you have the View As 
Active Desktop options selected on the Web tab of Display Properties. Right-click anywhere 
on your Desktop Background, select Properties, click the Web tab, click View As Active 
Desktop so it is unchecked and click OK. You will now be able to use the Set As Desktop 
Background options. 

Dongle 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 



5. The display should look similar to the picture to the right, with the Rainbow USB 
SuperPro device listed. 

If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Editing 

X24 When I use Cut or Copy on the Edit Menu, I am not sure if I will copy the 
folder or thumbnail selection. 

The item that is Cut or Copied will depend on whether the Folder Pane or Thumbnail Pane is 
selected, as indicated by which item is highlighted. 

Error Messages 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 



 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

B50 Error: "Design too large for export format" 

Certain formats are limited to the number of stitches they can save or the size of hoop used 
on their specific embroidery machine, for example .sew. If you attempt to save a file in this 
format that is bigger than the largest available hoop size or has more stitches than are 
allowed, this message would appear. 



L19 Error "Unrecognized file format." 

This message appears if the file you are attempting to load is corrupt. For example, it might 
have the extension .vip, yet not be a proper Husqvarna Viking / Pfaff stitch file. 

L20 Error: "Stitch file is corrupt" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L21 Error "Stitch file XY coordinates incorrect" 

The stitch file is corrupt and cannot be loaded. Refer to source of this file for a solution. 

L24 Error "Not enough memory to perform operation." 

This message will appear when trying to save files if system resources are low. Close other 
programs and try again. If this does not work, try restarting your computer. 

L26 Error "Cannot save file." 

The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again. 

L27 Error "Design too large for export format." 

Certain formats are limited to the size of hoop used on their specific embroidery machine, for 
example .pcs and .sew. If you attempt to save a file in this format that is bigger than the 
largest available hoop size this message would appear. 

X03 Error: "VIP 3D Organizer requires a color palette of High Color (16 bit) or 
higher." 

This message appears when attempting to open VIP 3D Organizer if your computer is set to 
a display of 256 colors or less. Reset the display as follows. 
1. Right-click on the desktop and a shortcut menu appears. 
2. Click on Properties and a dialog box appears. 
3. Click the Settings tab. 
4. Change Color quality to High Color (16 bit) or higher using the drop-down menu. 
5. Click Apply, and allow your computer to restart if required. 

X04 "Warning. 5,000 files have been found. Program performance may be 
affected. Do you wish to continue?" 

This message appears if 5,000 files are found by a Search or in a single folder. Click Yes to 
continue listing more files. Click No to stop and only show the 5,000 files found so far. Click 
Cancel to stop and clear the Thumbnail Pane so that no files are shown. 

X05 Error: "15,000 files have been found. No more files will be displayed. To see 
other files, move to a different folder or change the search criteria." 

This message appears if 15,000 files are found by a Search or in a single folder. VIP 3D 
Organizer will stop displaying additional files. If you have been making a search, change the 



Look in: folder or add more information to refine the search criteria. If you are browsing a 
folder, copy some files to another location. 

X06 "Conversion is not possible for the selected file format." 

This message appears if you attempt to convert a picture or Zip file to an embroidery file 
format, or to convert a Zip file to a picture. Use only embroidery files for conversion to 
embroidery file formats. 

X07 Error: "Unable to open file." 

This message appears when converting files if a file you are attempting to convert is no 
longer available. For example, if the file was on a floppy disk and the floppy disk has been 
removed. In this situation, replace the floppy disk. 

X08 Error: "Unable to create file." 

This message appears when converting files if there is a problem with the target location for 
a file. For example, when saving converted files to removable media (such as a floppy disk 
or CD) and the media is removed part way through the conversion process, or if a target file 
is read-only so it may not be overwritten. Make sure the target location is accessible. 

X09 Error: "Unable to create folder." 

When converting files, you can type in a folder name to create one new folder and you will be 
prompted to create the new folder. This message will then appear if the folder name contains 
characters that may not be used for folder names (such as quotes, other punctuation marks, 
etc.), more than one new folder would be created or you have attempted to create a folder in 
a location that may not be used (such as an empty floppy drive). Ensure the folder name and 
location are correct. 

X10 "The specified folder does not exist. Please adjust." 

This message will appear when you try to Search if you entered a folder in the Look in box 
that does not exist. Edit the folder name and try again. 

X11 "Minimum Stitch Count is greater than Maximum Stitch Count. Please 
adjust." 

This message may appear if you are using Minimum and Maximum Stitch Counts in 
Preferences or Search in VIP 3D Organizer. If the Minimum Stitch Count is greater than 
Maximum Stitch Count then no files will be displayed or found. Change the Minimum Stitch 
Count to be less than the Maximum Stitch Count. Alternatively, deselect one checkbox. 

X12 "Date From is later than Date To. Please adjust." 

This message may appear if you are using the date range in Search in VIP 3D Organizer. If 
the Date From is later than Date To then no files will be found by the Search. You will not be 
able to Search until you adjust the dates appropriately. 

X13 "Folder not found. Search Results." 



This message appears if you attempt to select and Go to the Search Results folder from the 
Address Bar in VIP 3D Organizer. After a Search, the Search Results folder will be shown in 
the drop-down list of previous Addresses. However, the Address Bar may not be used to 
return to the Search Results. Click the Search Results folder at the bottom of the folder list in 
the Folder Pane instead. 

X14 Error: "Unable to create folder." 

This message will appear if you try to create a new folder in VIP 3D Organizer and it would 
be a duplicate folder name, if there is not enough room on the chosen drive or if the drive is 
write-protected, for example a CD or floppy disk. Ensure the folder name and location are 
correct. 

X15 "No embroidery available to print." 

This message will appear if you attempt to Print or Print Preview in VIP 3D Organizer when 
you have no embroidery files selected. Select an embroidery file type, then try again. 

X16 The HTML Wizard is busy. Please wait until processing is finished, then try 
again. 

If you have selected some embroidery files in VIP 3D Organizer, then started to Create 
HTML, then selected more files and selected Create HTML again, this message will appear. 
Once the first set of files have been processed, you will be able to continue. 

HTML Wizard 

X28 How do I publish the HTML pages I made with the HTML Wizard on the 
home page for my personal website? 

Before you can begin, you will need instructions from your Internet Service Provider (ISP) on 
how you should upload files to your personal website. We are unable to provide instructions 
on uploading because the procedure is not the same for all ISPs. Your ISP will also tell you 
the home page address for your personal website. These instructions assume you are 
making a standalone website using only the files generated by the HTML Wizard. 
The term uploadrefers to copying files from your computer upto another computer. This is 
the opposite of download, where you copy files from another computer downto your 
computer. 
If you already have a personal website, you may need to consider how to integrate the HTML 
pages into your website. Such information is beyond the scope of this FAQ. 
The files generated by the HTML Wizard are stored in C:\VipEmbroidery\Net\HTML (this 
assumes that you are using the default installation folder C:\VipEmbroidery). Within the 
HTML folder is a file called 'index.htm'. This is the entry point into the collections you have 
created with the HTML Wizard. Each collection is stored in a sub-folder of the HTML folder, 
named according to the collection names you have used. 
When you upload the HTML pages, you should transfer the 'index.htm' file and all the sub-
folders. Upload them so that they stay organized the same way. Do not upload the HTML 
folder itself. 
Once the files are uploaded, you can test the result by entering your personal website 
address into your browser. The file 'index.htm' is automatically detected and loaded by the 
browser and you will see your collections are now online for your friends and family to see. 



X29 Can I use the HTML Themes on my Windows® Desktop? 

The HTML Themes are only for use with the VIP 3D Organizer HTML Wizard. They provide 
a variety of different looks to the HTML pages you can create. They are not Windows® 
Desktop Themes. 

Installation and CD 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 
3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 



1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 
Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

X01 I am unable to obtain a Validation Code 

Firstly, you must fulfill the following criteria to be able to have a Validation Code: 
• You must have purchased the full Professional Plus software package on or after 1st 

August 2002. 
• You must have registered the software by sending in the registration card that is 

provided in the Professional Plus box. 
If you fulfill these criteria, click the Contact Internet Database button that appears when you 
are prompted for the Validation Code during installation. 



 
VIP 3D Org install validation code page 

 
When the web page appears, enter your details as prompted and click Go. The details you 
enter mustbe the same as the details you provided on your registration card. 
If your details are not recognized as correct, you can click Try Againto try entering your 
details again. If you have only recently returned your registration card, please contact 
software support to determine if your registration has been recorded on the system. 
Alternatively, it may be that you have not entered the same e-mail address that you supplied 
on your registration card. Click Change E-mail Addressto amend your e-mail details and 
then try again. 

Managing Files 

X14 Error: "Unable to create folder." 

This message will appear if you try to create a new folder in VIP 3D Organizer and it would 
be a duplicate folder name, if there is not enough room on the chosen drive or if the drive is 
write-protected, for example a CD or floppy disk. Ensure the folder name and location are 
correct. 

Miscellaneous 

A10 General difficulties with hardware and software 

If you are suffering from some odd difficulties with your embroidery system, it is always a 
good idea to shut down your computer, and restart it. If this doesn't fix the problem then you 
can try to determine the cause of the problem by rebooting the computer in safe mode. If it is 
then solved, you know that some clash of hardware and/or software such as device drivers is 
to blame. You can then obtain more help from your computer dealer to analyse the cause 
and reconfigure your computer if necessary. 
To reboot your computer in Safe Mode: 
1. Close down windows and restart your computer. 
2. As the computer reboots and goes through the system check, hold down the F8 key. 



3. At the end of the system check, a menu will be displayed. 
4. Choose 'Safe Mode' by entering the option number. 
Windows will now restart in Safe Mode. No device drivers, such as graphics or printers will 
be loaded, allowing you to test your system. 

A26 The program will not start and the message "No dongle attached. Cannot 
open program" is displayed. 

This message will appear when trying to open your VIP software if the program cannot 'see' 
the dongle (data protection device). 
If you are using a Parallel port dongle (Cream): 
Make sure that the dongle is connected to the computer. Disconnect any devices such as 
printers that may be attached and try again. 
If you are using a USB port dongle (Purple): 

 
USB System Properties 

Make sure that the dongle is connected to the computer. Check that the software driver has 
been installed correctly. This can be done as follows: 
1. Right click on My Computer on the Desktop. 
2. Select Properties. 
3. Select the Device Manager tab. 
4. Click on the plus sign next to the Universal Serial Bus controllers. 
5. The display should look similar to the picture to the right, with the Rainbow USB 

SuperPro device listed. 
If the device is listed, but has a yellow exclamation mark next to it, the device has not been 
correctly installed. In this case right click on the Rainbow USB SuperPro, and then select 
Delete, the driver has now been removed. The driver can now be reinstalled. On the 
Customizing Plus, Digitizing Plus or Professional Plus installation CD, run the following 
program \Technical\Dongle\setup2\Setup.exe. 
If this does not cure the problem, then you may require the latest version of the Dongle 
Device Driver 
[http://www.husqvarnavikingsoftware.com/web/downloads/html/updvipembsys_gen.htm#don
gle]. 
Other USB problems: 
If you still have a problem then plug the dongle directly into into your computer's USB port. If 
it is now OK, then the problem may be a damaged or poor quality device or cable. 



Some USB ports do not have enough power to drive the dongle. By using a USB hub which 
uses a power supply this can be overcome. Some later windows 95 computers have USB 
ports fitted to the Motherboard but are not available for use. 
The computer BIOS may not be configured to allow support of Legacy USB devices. Check 
that Legacy USB Support is set to 'Enabled' within the BIOS. 
General dongle problems: 
For more information use the FAQ Search Wizard for your dongle type. 

Printing 

X15 "No embroidery available to print." 

This message will appear if you attempt to Print or Print Preview in VIP 3D Organizer when 
you have no embroidery files selected. Select an embroidery file type, then try again. 

X27 When I print out my stitch files, the lettering for the design information 
does not print correctly. 

This may happen occasionally on Windows® 2000 and XP because of the way that 
information is sent to your printer. Use these instructions to change the printer settings to a 
standard method which is more reliable. 
1. Close all programs. 
2. Ensure you are logged in as a user with administrator rights. If necessary, log out and 

then log in as an administrator. 
3. In Windows XP, click Start then Printers and Faxes. 
4. In Windows 2000, click Start, Settings, Printers. 
5. In the Printers folder, right-click on the printer which gave the incorrect results and select 

Properties. 
6. In the Properties dialog, click the Advanced tab. 
7. Click the Print Processor... button and a Print Processor dialog will appear. 
8. Select WinPrintin the Print Processor: pane on the left. 
9. Select RAWin the Default data type: pane on the right. 
10. Click OK to close the Print Processor dialog, then click OK to close the Printer Properties 

dialog. 
11. Retry printing from the VIP 3D Organizer program. 

Screen Appearance 

X17 Some of the icons in the Toolbar are 'grayed out' when I open the program. 
Certain icons (for example, Cut, Copy and Paste) are only highlighted once a folder or file is 
selected on the VIP 3D Organizer screen. 

X18 I wish to change the background color for the thumbnails and Real Size 
(Quick 3DStitch™ View). 

Use VIP Configure to alter the background color for the thumbnails and Quick 3DStitch™ 
View. This program may also be used to turn the texture on or off. 

X19 I can't see some of the floating toolbars or icons when I open the program. 



First, check the Toolbar function in the View Menu to see whether the view function has been 
turned off. If all the View Toolbar functions are turned on and you still cannot locate a toolbar, 
it may have had all the icons removed. If you move icons around it is possible to delete them. 
To reset the icons 
1. Click View, Toolbar and the Customize dialog will appear. 
2. Click the Toolbars tab. 
3. Click the name of the missing toolbar to highlight it. 
4. Click Reset, and click Yes when prompted to return the toolbar to its original state. The 

toolbar will have its icons restored to the installation default. 

Searching 

X04 "Warning. 5,000 files have been found. Program performance may be 
affected. Do you wish to continue?" 

This message appears if 5,000 files are found by a Search or in a single folder. Click Yes to 
continue listing more files. Click No to stop and only show the 5,000 files found so far. Click 
Cancel to stop and clear the Thumbnail Pane so that no files are shown. 

X05 Error: "15,000 files have been found. No more files will be displayed. To see 
other files, move to a different folder or change the search criteria." 

This message appears if 15,000 files are found by a Search or in a single folder. VIP 3D 
Organizer will stop displaying additional files. If you have been making a search, change the 
Look in: folder or add more information to refine the search criteria. If you are browsing a 
folder, copy some files to another location. 

X10 "The specified folder does not exist. Please adjust." 

This message will appear when you try to Search if you entered a folder in the Look in box 
that does not exist. Edit the folder name and try again. 

X11 "Minimum Stitch Count is greater than Maximum Stitch Count. Please 
adjust." 

This message may appear if you are using Minimum and Maximum Stitch Counts in 
Preferences or Search in VIP 3D Organizer. If the Minimum Stitch Count is greater than 
Maximum Stitch Count then no files will be displayed or found. Change the Minimum Stitch 
Count to be less than the Maximum Stitch Count. Alternatively, deselect one checkbox. 

X12 "Date From is later than Date To. Please adjust." 

This message may appear if you are using the date range in Search in VIP 3D Organizer. If 
the Date From is later than Date To then no files will be found by the Search. You will not be 
able to Search until you adjust the dates appropriately. 

X13 "Folder not found. Search Results." 

This message appears if you attempt to select and Go to the Search Results folder from the 
Address Bar in VIP 3D Organizer. After a Search, the Search Results folder will be shown in 
the drop-down list of previous Addresses. However, the Address Bar may not be used to 



return to the Search Results. Click the Search Results folder at the bottom of the folder list in 
the Folder Pane instead. 

Tutorials 

L37 The window remains blank when I try to use the tutorials. 
You need the Macromedia Flash Player to view some of the tutorials. Visit the Macromedia 
[http://www.macromedia.com] website and download and install the latest version of the 
Flash Player. 
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